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Chapter 1: CFX-Solver Manager Basics
CFX-Solver Manager is a graphical user interface that enables you to set attributes for your CFD calcu-
lation, control the CFX-Solver interactively, and view information about the emerging solution. As an
alternative to using the CFX-Solver Manager interface, you can also operate CFX-Solver from the command
line, which is particularly useful for batch mode operations (see Starting the CFX-Solver from the Com-
mand Line (p. 157)).

This chapter describes:

1.1. Starting CFX-Solver Manager

1.2.The CFX-Solver Manager Interface

1.3. Customizing CFX-Solver Manager

1.1. Starting CFX-Solver Manager

You can start CFX-Solver Manager in different ways:

• Using Ansys Workbench. For details, see Ansys CFX in Ansys Workbench in the CFX Introduction.

• Using the Ansys CFX Launcher. For details, see Using the Ansys CFX Launcher in the CFX Introduction.

• If CFX-Pre is launched and a simulation is open, you can launch CFX-Solver Manager by writing a
solver file. For details, see Write Solver Input File Command in the CFX-Pre User's Guide.

1.2. The CFX-Solver Manager Interface

CFX-Solver Manager is an interface that displays a variety of results as outlined below. It is generally
used to view the plotted data during problem solving.

13
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Figure 1.1: CFX-Solver Manager Interface

By default, the convergence history plots appear to the left or the top. The text output window appears
to the right or the bottom. There is an adjustable split between the windows that is oriented either
horizontally or vertically, depending on the aspect ratio of the entire CFX-Solver Manager window (also
adjustable).

The following parts of the interface are described next:

• Defining Runs in CFX-Solver Manager (p. 15)

• Workspace Selector (p. 15)

• Convergence History Plots and User Point Plots (p. 15)

• Text Output Window (p. 18)

• Multi-Configuration Run History Page (p. 19)

• Operating Point Run History Page (p. 20)
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1.2.1. Defining Runs in CFX-Solver Manager

To define a run from the CFX-Solver Manager interface, you can click File > Define Run or Define a

new CFX Solver run . The Define Run dialog box will appear and the settings of the run can be
specified. For details, see Working with Solver Manager (p. 23).

1.2.2. Workspace Selector

A workspace contains the information relevant for a given run. The Workspace selector is a drop-
down list that shows the current run name and enables you to switch between runs.

1. Click the arrow  of the Workspace selector.

2. Select the run you want to view.

1.2.3. Convergence History Plots and User Point Plots

Convergence history plots and user point plots are shown on monitor tabs. Each monitor tab shows
at least one plot of a variable versus time step, where the variable can be an RMS or maximum residual,
or a user-defined variable. For example, the Momentum and Mass monitor tab shows plots of the
RMS/maximum residuals for pressure and the U, V, and W components of momentum. A legend appears
below each plot to show the variable associated with each plot line.

For simulations involving rigid body modeling, additional plots specific to rigid bodies are available.
For details, see Monitor Plots related to Rigid Bodies in the CFX-Solver Modeling Guide.

For Transient Blade Row simulations involving the Time Transformation method, the flow equations
produce results in "computational time", not "physical time". By default, when plots against Simulation
Time are produced, most variables are plotted against computational time, but variables that have a
corresponding physical time (for example, monitor points) are plotted against physical time. For details
on the Time Transformation method, see Time Transformation in the CFX-Solver Theory Guide.

You can control which plots are active from the Monitors menu.

Some other actions that you can perform:

• Configure/edit a monitor from the CFX-Solver Manager Monitor Properties Dialog Box (p. 147) dialog
box. To invoke that dialog box, you can do one of the following:

– Right-click in the plot area of the monitor tab and select Monitor Properties from the shortcut
menu.

– Select Workspace > Workspace Properties from the main menu, then select a monitor from

the Workspace Properties dialog box and click Edit .

• Click any of the plot lines to view the value at the nearest time step.

• Toggle between showing RMS or maximum values by right-clicking in the monitor tab and selecting
Switch Residual Mode from the shortcut menu.

15
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• Hide or show any monitor tab from the CFX-Solver Manager Monitors Menu (p. 143). Another way
to hide a monitor tab (other than the Out File monitor tab) is to right-click in the monitor tab and
select Hide Monitor from the shortcut menu.

• Delete a monitor tab by right-clicking in the monitor tab and selecting Delete Monitor from the
shortcut menu.

Other actions that can be performed using the shortcut menu on the monitor tab are described in
the following sections:

• Changing the Plot Type (p. 16)

• Printing an Image of the Convergence History (p. 16)

• Saving a Picture of the Convergence History (p. 16)

• Exporting Plot Variables and Coordinates (p. 17)

• Exporting Monitor Data from the Command Line (p. 18)

1.2.3.1. Changing the Plot Type

You can switch between XY, Cyclic XY, and Polar plots. The XY plot is a standard plot. Cyclic XY and
Polar plots are suitable for transient periodic flows, and are described in Chart Type Settings
Tab (p. 148).

1.2.3.2. Printing an Image of the Convergence History

You can print a picture of the convergence history plot:

1. Right-click in the convergence history plot and select Print.

The Print dialog box appears.

2. Configure the printer as required.

3. Click Print.

1.2.3.3. Saving a Picture of the Convergence History

You can save a picture of the convergence history plot:

1. Right-click in the convergence history plot and select Save Picture.

The Image File dialog box appears.

2. In the Image File dialog box, select a location to which to export the image.

3. Under File name, enter the name for the file.

4. Under File type, select the format to export.

5. Click Save.
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1.2.3.4. Exporting Plot Variables and Coordinates

Variables and coordinates from any plot monitor can be exported. Exported files are formatted with
comma-delimited entries. This data can be used as the basis for import to another application.

1. Right-click in the convergence history plot and select Export Plot Variables or Export Plot
Coordinates.

The Export dialog box appears.

Export Plot Variables exports the monitor data for the variables used in the plot. Export Plot
Coordinates exports the actual x/y coordinates used for the plots. These will be different for
plots that show coefficient loop data, Cyclic XY plots, and Polar plots.

2. Under File name, enter the name for the file to which to export the data.

3. Under Files of type, select the format to export.

Files are saved with a .csv extension by default, but this can be modified as required.

4. Under Export Options:

• Choose a Null Token to be written where a data value is not available (for example, a point
where the plot variable is not defined).

The options are NAN and (empty). The (empty) option means that nothing is written
where the data value would normally be output.

• If a single plot line is broken into multiple sections (for example, for each cycle of a cyclic
plot) then, when the values are exported, the data for each section can be separated. Set
Line Breaks to indicate what should be written to the file between the plot line sections.

The options are Null Tokens, Blank Line, No Break. The Null Tokens option
writes a line in the same form as the ordinary data values, but using the specified Null Token
instead of a numeric value, for all values.

If the data file is intended to be read into CFD-Post, set Null Token to NAN and Line Breaks
to Null Tokens.

If the data file is intended to be read into Microsoft Excel, set Null Token to (empty) and
Line Breaks to Blank Line.

5. Click Save.
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The data from each plotted variable is exported to the specified file.

Note:

Monitor data can also be exported using the command-line application cfx5mondata.

Note:

You can change which plot line variables are selected by using the Monitor Properties
dialog box (right-click in the plot area and select Monitor Properties from the shortcut
menu).

1.2.3.5. Exporting Monitor Data from the Command Line

The cfx5mondata application provides a command-line driven mechanism to query or extract
monitor data from the directory in which a solver run is executing, a CFX-Solver Results file, or a
monitor file. When extracted, monitor data are written in a comma-separated format that is similar
to the output generated by the Exporting Plot Data capability.

To obtain a complete list of available command line options for cfx5mondata type the following
command into a UNIX terminal or a suitable Windows command line and press Return or Enter:

cfx5mondata -help

1.2.4. Text Output Window

The text output window is a monitor tab that lists simulation information and the progress of a
solution, including information such as physical properties, boundary conditions, and various other
parameters used or calculated in creating the model. The source of the displayed information is a
CFX-Solver Output file. For details, see CFX-Solver Output File (p. 51).

You can hide or show the Out File monitor tab from the CFX-Solver Manager Monitors Menu (p. 143).

Right-click in the Out File monitor tab to access a shortcut menu with commands for finding text,
selecting text, copying text, saving the text to a file, managing bookmarks, editing the properties of
the Out File monitor tab, and deleting the Out File monitor tab.

The following sections explain some of these actions in more detail:

• Searching for Text (p. 18)

• Saving the Text to File (p. 19)

1.2.4.1. Searching for Text

The output window can be searched for specific text:

1. Right-click in the text output window and select Find.

2. In Find, enter words to find.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.18

CFX-Solver Manager Basics



3. Select or clear the Case Sensitive check box.

4. Click Previous or Next to search up or down from the current location. An icon will appear
to the left of the Find label if the text could not be found in the file when searching in the
selected direction from the current location.

1.2.4.2. Saving the Text to File

The text of the output window can be saved to file (even when a run is in progress):

1. Right-click in the text output window.

2. Select Save As.

3. Select a file location to save the text file.

4. Enter a filename for the text file.

5. Click Save.

1.2.5. Multi-Configuration Run History Page

A multi-configuration simulation has several workspaces:

• One workspace for each analysis. Each of these workspaces has a convergence history plot and a
text output window that resemble those of a single-analysis simulation.

• One workspace that shows an overview of the multi-configuration simulation. There is a run history

page that lists each simulation step (analysis) and its overall status (  = in progress,  = complete,

 = error), and a text output window that provides the status of each simulation step.

A sample run history page is shown below:
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In this case, there are two simulation steps: a steady-state analysis and a transient analysis. The steady-
state analysis (simulation step 1) is complete, and the transient analysis (simulation step 2) is in pro-
gress. Because the transient analysis is in progress, the overall simulation is marked as being in progress.
When the transient analysis completes, the overall simulation will be marked as being complete.

You can switch to the workspace for a simulation step by right-clicking the simulation step in the run
history page and selecting Open Workspace from the shortcut menu.

The shortcut menu commands on the run history page are:

• Open Workspace

This switches to the workspace view for the selected simulation step.

• Post Process Results

This command is available when running CFX-Solver Manager in stand-alone mode. It launches
CFD-Post with the results of the selected simulation step.

• Post Process Results and Shutdown

Same as Post Process Results, except CFX-Solver Manager closes after CFD-Post is launched.

• Stop Run

This command stops the CFX-Solver from computing the results for the selected simulation step.

• Display Termination Message

For a simulation step that has completed, this command displays a summary of the termination
status.

An alternative way to switch between the various workspaces is to choose a workspace from the
Workspace drop-down list:

In the drop-down list, the analyses of a multi-configuration simulation are listed below the name of
the run, and are indented to show that they belong to the run. Selecting the name of the run switches
to the run history page.

1.2.6. Operating Point Run History Page

An operating point case has workspaces similar to those of a multi-configuration run, described in
Multi-Configuration Run History Page (p. 19).

A sample run history page is shown below:
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You can export operating point data from the operating point parameter table in CFX-Solver Manager.
Simply right-click a table cell and select the type of file to export under the Export Table Data as
CSV submenu.

The available CSV types are:

• CSV — a basic .csv file that can be imported into Microsoft Excel. The file has a single header
followed by data.

• CFX Profile — a profile file (.csv) with CFX headers.

• Workbench Design Points — a Workbench design point .csv file with headers.
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You can also export operating point data from the operating point parameter table in CFD-Post. For
details, see CFD-Post Operating Points Viewer in the CFD-Post User's Guide.

Note:

For an operating point run that has been continued from a previous .mres file, the table
in the run history page will show the previous values for input and output parameters –
even if they have changed in the new run – until the operating point has been rerun. Ab-
sence of the run status for a given operating point means that the operating point has
not yet been rerun and its values could change if it is rerun.

For modeling information, see Operating Maps and Operating Point Cases in the CFX-Solver Modeling
Guide.

1.3. Customizing CFX-Solver Manager

The size and position of most windows in CFX-Solver Manager can be changed to customize the appear-
ance, function and placement of objects. Toolbars can also be moved as required; just click and drag
the left edge of a toolbar to a new position. (The toolbar orients itself vertically if places along the left
or right side of the application.)

Settings such as window sizes, selected plot variables, and other settings specific to the current view
can be saved as a layout file (*.mst). For example, you could select a plot variable and configure the
current view. You could then save the layout and restore it at a later time. For details, see CFX-Solver
Manager Workspace Menu (p. 123).
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Chapter 2: Working with Solver Manager
This chapter describes procedures for starting specific types of runs using CFX-Solver Manager. The
steps to take depend on whether an initial values file is required or not, and whether the CFX-Solver
input filename has already been passed to the CFX-Solver Manager.

This chapter describes:

2.1. Solver Run Overview

2.2.The Define Run Dialog Box

2.3. Run Output Results

2.4. Parallel Run

2.5. Restarting a Run

2.1. Solver Run Overview

To run a case, review the settings in the File > Define Run dialog box. The number of settings that you
need to change or specify depends on the case:

• In some cases, you need only to specify the name of a CFX-Solver input file (*.def or *.mdef). For
cases that require initialization from previous results, you also need to specify the name of a results
file (*.res or *.mres).

• You can choose to run in serial or parallel:

– Serial run is the default way of running a CFD case. During a serial run, all computation is done by
a single process running on one processor.

– Parallel run divides computation into more than one process and is done on more than one processor
in a single machine (local parallel processing) or on more than one machine (distributed parallel
processing).

• For simulations with multiple configurations, you can make global and configuration-specific settings.

When you have finished setting up the case, click Start Run.

Tip:

In Ansys Workbench you have the option of clicking Save Settings to save the settings of
the Define Run dialog box to the Solution cell (some of these settings are visible in the
Solution cell's Properties). By saving the settings in this way, you can configure the run from
CFX-Solver Manager, but start the run from Ansys Workbench (by updating the Solution cell).

Details of making these changes with the Define Run dialog box are described in the next section.
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2.2. The Define Run Dialog Box

You access the Define Run dialog box from CFX-Solver Manager by clicking File > Define Run.

Under Solver Input File, ensure that the name of a CFX-Solver input file (with extension .def or
.mdef) is specified.

The name will be set automatically if:

• You have started CFX-Solver Manager using the Define Run action in CFX-Pre.

• You have started CFX-Solver Manager from the command line using the -interactive and -def
or -mdef options. For details, see Starting the CFX-Solver from the Command Line in the CFX-Solver
Manager User's Guide (p. 157).

CFX-Solver input filenames must not contain spaces when run with an associated Ansys input file
(.inp). Note that in CFX-Solver Manager, when specifying or editing the Solver Input File by typing

from the keyboard, you must click Reload run settings from file  to have the changes take effect.

In CFX-Solver Manager, if a multi-configuration definition or results file (*.mdef or *.mres, respectively)
is selected as the CFX-Solver Input file, then the settings on the tabs described below can be made on
a simulation-wide or per-configuration basis. This is done by choosing either Global Settings or
a specific configuration name for the Edit Configuration option. Note that when global settings are
made, they are inherited by all configurations. You can then override any setting for a specific config-
uration, but it is important to note that in this situation the remainder of the settings for the configur-
ation will not be inherited from the global settings.

The tabs of the Define Run dialog box that can be configured are described in the following sections:

2.2.1. Run Definition Tab

2.2.2. Operating Points Tab

2.2.3. Initial Values Tab

2.2.4. Partitioner Tab

2.2.5. Solver Tab

2.2.6. Interpolator Tab

2.2.7. Configuring Memory for the CFX-Solver

2.2.1. Run Definition Tab

To configure the Run Definition tab:

• Set Type of Run to Full or Partitioner Only.

– Full runs the partitioner if applicable, and then runs the solver.

– Partitioner Only is used for parallel runs only and does not run the solver. This writes a
.par file.

• You can select or clear Double Precision. This setting will determine the default (single or double)
precision of the partitioner, solver, and interpolator executables. For details on the precision of the
executables, see Double-Precision Executables (p. 178). The precisions of the partitioner, solver, and
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interpolator executables can be optionally overridden individually on the Partitioner, Solver, and
Interpolator tabs.

• You can select or clear Large Problem. This setting will determine the default ("large problem" or
not) problem size capability of the partitioner, solver, and interpolator executables. For details on
the problem size capability of the executables, see Large Problem Executables (p. 178). The problem
size capability of the partitioner, solver, and interpolator executables can be optionally overridden
individually on the Partitioner, Solver, and Interpolator tabs.

• You can configure the Parallel Environment as required (see below).

• If required, you can set the working directory under Run Environment.

• If required, you can select Show Advanced Controls to display other tabs.

2.2.1.1. Parallel Environment

Under Parallel Environment, select a Run Mode option. The run mode determines whether the
run is serial (the default when defining a run in which a problem is solved as one process), or par-
allel (problem is split into partitions).

• A serial run (the default) requires no additional configuration.

• For a local parallel run, specify the number of partitions. This value is the number of separate
processes that will be executed.

• For a distributed parallel run, specify the number of partitions assigned to each host. If choosing
a specified partition weighting (under the Partitioner tab), click directly on the partition weight
number to edit it. There should be one weight entry per partition.

For more information on Parallel Processing, see Parallel Run in the CFX-Solver Manager User's
Guide (p. 40).

2.2.2. Operating Points Tab

If the specified Solver Input File is an mdef or mres file for an operating point run, the Operating
Points tab is available.

On this tab, you can specify the number of operating point jobs that can run concurrently.

The concurrency options are:

• Sequential – Operating point jobs are run one-at-a-time. The next job starts running after the
current job has finished running.

• Maximum Number of Concurrent Jobs – Set Max. Concurrent Jobs to the maximum
number of operating point jobs that may be run at any given moment.
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• Unlimited – All operating point jobs may be run concurrently.

Limitation:

For cases involving multi-configuration, the concurrency option must be set to Sequen
tial.

On the Operating Points tab, you can also optionally set the current operating point run to continue
from a previous operating point run, making use of results from the previous run to more quickly
obtain a complete set of output parameter values for all of the current run’s operating point jobs
(each job simulates a single operating point).

• To set up a continued run with an mdef file as the CFX-Solver Input file:

1. Select Run Continuation Specification.

2. Set Run Continuation Specification > File Name to the name of the mres file of another
operating point run.

Note that, if an operating point run is continued and the mesh has changed, all operating
point jobs are run. If available, results from the previous operating point run are used as initial
values to reduce the solution time.

3. Ensure that the Run Continuation Actions settings are configured appropriately.

• To set up a continued run with an mres file as the CFX-Solver Input file:

1. Clear Run Continuation Specification.

You cannot specify any Run Continuation Specification file when using an mres file as the
CFX-Solver Input file.

2. Ensure that the Run Continuation Actions settings are configured appropriately.

In both of these cases, the run will continue, inheriting output parameter values and/or using solution
results from some or all of the previous run’s jobs (from the specified mres file), in accordance with
the Run Continuation Actions settings (described below).

If you specify an mdef file as the CFX-Solver Input file, but do not specify an mres file under Run
Continuation Specification then the operating point run is a new run, not a continued run. For new
runs, there are no operating point job results available, so all of the specified jobs will be run regardless
of the Run Continuation Actions settings.

The Run Continuation Actions settings apply to continued operating point runs only. These settings
affect how output parameter values are obtained for the operating point jobs of the continued run.
For a given operating point job, there are three ways to obtain the output parameter values:

• Run, starting from initial conditions.

• Run, starting from the solution results of the corresponding job of the previous run.
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• Inherit output parameter values from the corresponding job of the previous run.

The Run Continuation Actions settings are:

• Simulation Changes

The Simulation Changes > Option setting applies when continuing a run with an mdef file as
the CFX-Solver Input file (and an mres file specified for Run Continuation Specification > File
Name). This setting determines whether or not all operating point jobs are automatically re-run
whenever, compared to the operating point run specified under Run Continuation Specification,
there has been any change to the generic simulation definition for an operating point, such as a
change to the physics, solver control, or output control specification.

– If there has been a simulation change and Option is set to Continue All, then all of the op-
erating point jobs are run, starting from the solution results of the corresponding jobs of the
previous run (regardless of the Run Continuation Actions > Operating Point Changes settings,
which are described below).

Note that the Continue All option behaves like the Run All option (described next) if the
run is not being restarted from a previous run.

– If there has been a simulation change and Option is set to Run All, then all of the operating
point jobs are run, starting from initial conditions (regardless of the Run Continuation Actions
> Operating Point Changes settings, which are described below).

– If Option is set to Ignore All Simulation Changes then some or all of the operating
point jobs are run, in accordance with the Run Continuation Actions > Operating Point Changes
settings, which are described below.

• Operating Point Changes

The Operating Point Changes settings can (but subject to override by the Run Continuation
Actions > Simulation Changes settings) determine which operating point jobs of the continued
run will make use of the output parameter values or solution results of the corresponding jobs of
the previous run, based on how operating point specifications have changed. The operating point
specification changes are determined in different ways, depending on how the current operating
point run is defined:

– For a (continued) run with an mdef file as the CFX-Solver Input file:

The operating point specifications of the mdef file (whether stored externally in a .csv file or
internally in the mdef file) are compared against the operating point specifications of the mres
file (which is specified under Run Continuation Specification).

– For a (continued) run with an mres file as the CFX-Solver Input file:

The operating point specifications used for the original run of the mres file are compared against
the operating points specifications for the new run. The operating point specifications for the
new run will be read from the referenced external file (if the operating point table data was
stored externally) or from the mres file (if the operating point table data was stored internally).
For operating point table data that is stored internally, operating point data changes can only
occur if the new data has been written to the mres file using cfx5dfile. You can enter
cfx5dfile -help to obtain more information.
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Operating point specification changes are handled as follows:

– The jobs for new points are run.

– The jobs for modified points (points that have the same index value and input parameters, but
different input parameter values) are run or not depending on the specified Modified Points
option:

→Run - The jobs for modified points are run, starting from initial conditions.

→Continue - The jobs for modified points are run, starting from the solution results of the
corresponding jobs of the previous run.

→Keep - The jobs for modified points are not run; output parameter values are inherited from
the corresponding jobs of the previous run.

– The jobs for unmodified points are run or not depending on the specified Unmodified Points
option:

→Continue - The jobs for unmodified points are conditionally run, starting from the solution
results of the corresponding jobs of the previous run.

A particular job is run if the corresponding job of the previous run stopped for any reason
other than meeting convergence criteria, for example manual interruption or reaching the
maximum number of iterations. Otherwise the job is not run and output parameter values are
inherited from the corresponding job of the previous run.

Limitation:

The Continue option takes effect (for a continued run) only if it was already set
during the previous run.

→Keep - The jobs for unmodified points are not run; output parameter values are inherited
from the corresponding jobs of the previous run.

Limitation:

For cases involving multi-configuration, the Unmodified Points option must be set
to Keep.

– The jobs for deleted points are not run. The output parameter values from the corresponding
jobs of the previous run are inherited or not depending on the specified Deleted Points option:

→Keep

The values are inherited.

→Remove From Table
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The values are not inherited. Table entries for deleted points are removed; after a restart, the
newly created results will not contain table entries for points that were deleted. Previous
solution results and case files remain unchanged.

For modeling information, see Operating Maps and Operating Point Cases in the CFX-Solver Modeling
Guide.

2.2.3. Initial Values Tab

When running in Workbench, the Initial Values tab in CFX-Solver Manager’s Define Run dialog box
has an Initialization Option setting that synchronizes interactively with changes in the Initialization
Option property of the Solution cell. The Solution cell properties are described at Properties Pane in
the CFX Introduction.

If either of the following is true:

• CFX-Solver Manager is run from Workbench, and the Initialization Option on the Initial Values
tab is set to Initial Conditions. (This is equivalent to the Solution cell Initialization Option
property being set to Update from initial conditions.)

• CFX-Solver Manager is run from stand-alone mode.

then:

• You can set initial values via results files in a variety of places as listed here (in order of precedence):

– In CFX-Solver Manager in the Define Run dialog box on the Initial Values tab.

– In CFX-Pre in the Configuration details view on the Initial Values tab.

– In CFX-Pre in the Execution Control details view on the Initial Values tab.

Note that for cases with multiple configurations, initial values cannot be set globally (that is, in
CFX-Solver Manager or in CFX-Pre in the Execution Control details view); they can only be set per
configuration in CFX-Pre in the Configuration details view.

• You may specify initial values via results files, depending on the Initial Values Specification check
box:

– If you do not specify initial values via results files (Initial Values Specification cleared), the
software will use initialization data from (in order of precedence):

→ In CFX-Pre on the Initialization tab in the Domain details view

→ In CFX-Pre on the Initialization tab in the Global Initialization details view

→ Automatically generated initial values

Note that automatically generated initial values may not be suitable for some steady-state
cases and are insufficient for all transient cases.

– If you specify initial values via results files (Initial Values Specification selected and settings
filled in), those values will override any initial values listed above (that is, from the Domain details
view, the Global Initialization details view, or automatically generated initial values), as applicable.
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• You can set initial values via results files as follows:

1. On the applicable Initial Values tab, select the Initial Values Specification check box to show
the initial values settings.

2. Click New  to create an initial values object.

3. Select an initial values object from the list.

4. Choose the source of initial values for the initial values object.

The following options are available, depending on the specified Solver Input file:

– (no option)

Specify the name of the results file from which initial values should be obtained.

– Results File

Specify the name of the results file from which initial values should be obtained.

– Configuration Results

Specify the name of the configuration from which initial values should be obtained.

Note that this option is available only in the context of multi-configuration simulations. It
allows the results (which become available at run time) of another configuration to be used
as initial values.

Additional information is provided in Initial Condition Modeling in the CFX-Solver Modeling
Guide.

5. Optionally specify Interpolation Mapping settings in order to select, position, and/or replicate
the data. For details, see Interpolation Mapping in the CFX-Solver Modeling Guide.

6. Select Continue History From if you want to continue the run history (convergence history,
monitor plots, time and time step counters, etc…) and use the smoothest restart possible from
the selected Initial Values File. When this option is selected, the run continues from the one
contained in the specified initial values object; the entire history is also copied into the current
results file. If this option is not selected, the run history is reset.

7. The Use Mesh From setting determines which file provides the mesh that is used for the
analysis: the Solver Input file or the Initial Values file. The mesh from the Initial Values file can
be used in a limited set of circumstances. See Using the Mesh from the Initial Values File in
the CFX-Solver Modeling Guide for details.

If CFX-Solver Manager is run from Workbench, and the Initialization Option on the Initial Values
tab is not set to Initial Conditions (equivalent to the Solution cell Initialization Option
property not being set to Update from initial conditions), then:

• Initialization is controlled by the Solution cell property.
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• The Initial Values tab (whether in CFX-Solver Manager in the Define Run dialog box, CFX-Pre in
the Execution Control details view, or CFX-Pre in the Configuration details view) may not be used
for specifying initial values via results files.

• Cases with multiple configurations are not supported.

Full details for Initial Values Files can be found in Reading the Initial Conditions from a File in the
CFX-Solver Modeling Guide.

Note:

• For cases involving System Coupling, and for cases involving multiple configurations,
the Initialization Option setting in CFX-Solver Manager (Define Run dialog box >
Initial Values tab) must be set to Initial Conditions.

2.2.4. Partitioner Tab

Use the Partitioner tab to configure mesh partitioning options for parallel runs. If this tab is not visible,
ensure that in the Run Definition tab, Show Advanced Controls is selected.

Note:

Once started, the run progresses through partitioning, and then into the solution of the
CFD problem. Extra information is stored in the CFX-Solver Output file for a parallel run.
For details, see Partitioning Information in the CFX-Solver Manager User's Guide (p. 72).

You can select a partition file to load by clicking Browse  beside Initial Partition File. The *.par
file is only available if a model has already been partitioned. The number of partitions in the partitioning
file must be the same as on the Run Definition tab.

Note:

An existing partition file cannot be used if the simulation involves either the Monte Carlo
or Discrete Transfer radiation model. Partitions may be viewed prior to running CFX-Solver.
For details, see CFX Partition File in the CFX-Solver Manager User's Guide (p. 91).

Run Priority may be set to Idle, Low, Standard or High (Standard is selected by default). For
a discussion of these priorities, see The cfx5control Application in the CFX-Solver Manager User's
Guide (p. 183).

2.2.4.1. Executable Settings

You can override the precision set on the Run Definition tab by selecting Override Default Preci-
sion and then setting the precision. For details on the precision of executables, see Double-Precision
Executables (p. 178).

You can override the problem size capability ("large problem" or not) set on the Run Definition
tab by selecting Override Default Large Problem Setting and then setting the problem size cap-
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ability (via the Large Problem check box). For details on the problem size capability of the execut-
ables, see Large Problem Executables (p. 178).

2.2.4.2. Partitioning Detail

Under Partitioning Detail, you can specify various partition method options.

2.2.4.2.1. Partition Type

Configure the base partition method. Available Partition Type selections include:

• Multilevel Graph Partitioning Software - MeTiS in the CFX-Solver Modeling Guide. When first
running in parallel, it is recommended that Partition Type be set to MeTiS.

• Optimized Recursive Coordinate Bisection in the CFX-Solver Modeling Guide

• Recursive Coordinate Bisection in the CFX-Solver Modeling Guide

• Directional Recursive Coordinate Bisection in the CFX-Solver Modeling Guide

• User Specified Direction in the CFX-Solver Modeling Guide

• Radial in the CFX-Solver Modeling Guide

• Circumferential in the CFX-Solver Modeling Guide

• Simple Assignment in the CFX-Solver Modeling Guide

2.2.4.2.2. Partition Weighting

Configure how partitions are weighted between machines. Available Partition Weighting selec-
tions include:

• Automatic (default): Calculates partition sizes based on the Relative Speed entry specified
for each machine in the hostinfo.ccl file. Machines with a faster relative speed than others
are assigned proportionally larger partition sizes.

Note:

The entry of relative speed values is usually carried out during the CFX installation
process. Parallel performance can be optimized by setting accurate entries for relative
speed.

• Uniform: Assigns equal-sized partitions to each process.

Note:

Both Uniform and Automatic give the same results for local parallel runs; it is
only for distributed runs that they differ.
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• Specified: Assigns custom-sized partitions to each process. This option requires that partition
weights are specified on the Run Definition tab in the table under Parallel Environment in
the Partition Weights column.

Note:

When more than one partition is assigned to any machine, the number of partition
weight entries must equal the number of partitions. The partition weight entries
should be entered as a comma-separated list. Consider the following sample distrib-
uted run:

Partition Weights# of PartitionsHost

21Sys01

2, 1.52Sys02

11Sys03

Sys01 has a single partition with weight 2. Sys02 has two partitions and they are
individually weighted at 2 and 1.5. Sys03 has a single partition with weight 1.

If partition weight factors are used, the ratio of partition weights assigned to each
partition controls the partition size.

2.2.4.2.3. Multidomain Option

Configure how domains are partitioned. Available Multidomain Option selections include:

• Automatic (default): If the case does not involve particle transport, this is the same as the
Coupled Partitioning option; otherwise it is the same as the Independent Parti
tioning option.

• Independent Partitioning: Each domain is partitioned independently into the specified
number of partitions.

• Coupled Partitioning: All connected domains are partitioned together, provided they
are the same type (that is, solid domains are still partitioned separately from fluid/porous do-
mains). For details, see Optimizing Mesh Partitioning in the CFX-Solver Modeling Guide.

Note:

Coupled partitioning is often more scalable, more robust and less memory expensive
than independent partitioning because fewer partition boundaries are created.
However, coupled partitioning may worsen the performance of particle transport
calculations.

2.2.4.2.4. Multipass Partitioning

When Coupled Partitioning is activated, you can further choose to set the Multipass
Partitioning option. The Transient Rotor Stator option is relevant only for simulations
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having transient rotor stator interfaces. It uses a special multipass algorithm to further optimize
the partition boundaries. This approach generates circumferentially-banded partitions adjacent
to each transient rotor stator interface, which ensures that interface nodes remain in the same
partition as the two domains slide relative to each other. Away from the interface, the partitioning
is handled using whichever method is specified for the Partition Type.

2.2.4.3. Partition Smoothing

Partition smoothing attempts to minimize the surface area of partition boundaries by swapping
vertices between partitions. Partition smoothing reduces communication overhead and improves
solver robustness. Smoothing is enabled by default, but may be disabled by changing Partition
Smoothing > Option.

If smoothing is enabled, the algorithm will, by default, perform a maximum of 100 sweeps. The
maximum number of smoothing sweeps can be specified by changing the value of Partition
Smoothing > Max. Smooth. Sweeps. The smoothing algorithm will stop before this value is reached
if it finds no improvement between successive sweeps.

For further details on partition smoothing, see Optimizing Mesh Partitioning in the CFX-Solver
Modeling Guide.

2.2.4.4. Mesh Precoarsening

This option automatically creates a coarse version of the mesh before partitioning that into the
desired number of partitions using the specified Partition Type. The coarsening process is then re-
versed to give the partitioning of the original mesh. This additional precoarsening step uses the
same AMG technology as the solver, and allows the partitioning to be more 'aware' of the solution
process. The method can be used to prevent partition boundaries from passing through areas of
high aspect ratio cells, and can resolve convergence difficulties that this can cause, particularly with
diffusion-only type equations.

There are two sub-options:

• Target Nodes per Block - default (1000)

This defines how much coarsening is used before partitioning takes place. Reducing this number
will reduce the coarsening.

• Aspect Ratio Filter - default (off)

This option introduces a filter such that elements with aspect ratio below a certain criterion value
will not be included in the coarsening process. This restricts the process to the areas where it is
likely to be most effective, and can also lead to smoother partition boundaries.

The Mesh Precoarsening option is compatible with all the basic partitioning methods, such
as MeTiS, and Optimised Recursive Coordinate Bisection, but will have most impact on methods
that are not purely geometrical and involve a connectivity graph. Note that the option carries sig-
nificant overhead at partition-time, in terms of both memory and CPU usage.
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2.2.4.5. Partitioner Memory

If required, you can adjust the memory configuration under Partitioner Memory. For details, see
Configuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide (p. 38).

2.2.5. Solver Tab

Select the Solver tab to configure solver settings. If this tab is not visible, ensure that in the Run
Definition tab, Show Advanced Controls is selected.

• Under Run Priority, you can select Idle, Low, Standard or High. For a discussion of these pri-
orities as well as how you can change them after the execution of the solver has started, see The
cfx5control Application in the CFX-Solver Manager User's Guide (p. 183).

• You can override the precision set on the Run Definition tab by selecting Override Default Preci-
sion and then setting the precision. For details on the precision of executables, see Double-Precision
Executables (p. 178).

• You can override the problem size capability ("large problem" or not) set on the Run Definition
tab by selecting Override Default Large Problem Setting and then setting the problem size
capability (via the Large Problem check box). For details on the problem size capability of the ex-
ecutables, see Large Problem Executables (p. 178).

• If required, you can adjust the memory configuration under Solver Memory. For details, see Con-
figuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide (p. 38).

• If your case has user locations that are generated in CFX-Pre and stored in the CFX-Solver input
file (see User Locations in the CFX-Pre User's Guide), select User Location Regeneration to control
whether or not these user locations are regenerated (recalculated) as part of the solver run. The
options are:

– Automatic

This is the default. If the stored user location data is out-of-date, this option runs CFX-Pre tem-
porarily in the background to regenerate the data at the start of the solver run. A user location
is considered to be out-of-date if the settings for the user location have changed since the CFX-
Solver input file was written (for example, if the command language in the CFX-Solver input file
was edited) or if the user location depends on expressions and there has been any change to
the definition of any CEL expression, including the index for an operating point input parameter
table.

– Validate

Stops the run if and when there is any change to the definition of any user location, in which
case the user location data is out-of-date. If the user location depends on a CEL expression, and
any expression has changed, the run continues but with a warning written to the CFX-Solver
Output file.

– None

No user locations are updated during the run; the run proceeds using the user location data
stored in the CFX-Solver input file regardless of whether there is any change to the definitions
of the user locations or expressions. This option can be used to suppress user location updates
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if, for example, a user location depends on expressions, and an expression has been changed,
but it is known that the expression change will not affect the user location data.

– All

All user locations are forced to be recalculated at the start of the run regardless of whether there
is any change to the definitions of the user locations or expressions.

Note:

This option (All) is effectively selected, regardless of which option is actually selected,
when running a design points study in Ansys Workbench.

– Selected Locations

The selected user locations are forced to be recalculated at the start of the run regardless of
whether there is any change to the definitions of the user locations or expressions. Any other
user locations will not be recalculated.

• You can optionally choose a custom solver executable. Under Custom Solver Options, click Browse

 to select a Custom Executable.

• Command line arguments that must be supplied to the program can be entered under Solver Ar-
guments.

Note:

Note that the CFX-Solver’s -ccl command line argument can be used to alter the physics
CCL but cannot be used to modify the way that the mesh is defined or the way that the
physics CCL relates to the topology of the mesh that is stored in the solver input file. The
changes that cannot be made using the -ccl command line argument include:

• Changing the underlying geometry

• Recreating the mesh with different parameters, mesh controls, or inflated boundaries

• Adding a new physics location or removing an existing physics location such as a domain
(DOMAIN), subdomain (SUBDOMAIN), boundary condition (BOUNDARY), or domain inter-
face (DOMAIN INTERFACE)

• Changing the name of any subdomain or boundary condition, including the default
boundary condition

• Changing the locations of the physics, for example, by modifying the locations of domains,
subdomains, boundaries, or domain interfaces

In order to make such changes, you must rewrite the solver input file using CFX-Pre.
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Note that changing the type of boundary condition is possible with the -ccl command
line argument.

Note:

The Custom Executable and Solver Arguments settings are only available in the CFX-
Solver Manager in stand-alone mode.

2.2.6. Interpolator Tab

Select the Interpolator tab. If this tab is not visible, ensure that in the Run Definition tab, Show
Advanced Controls is selected.

• Under Run Priority, you can select Idle, Low, Standard or High. For a discussion of these pri-
orities, see The cfx5control Application in the CFX-Solver Manager User's Guide (p. 183).

• You can override the precision set on the Run Definition tab by selecting Override Default Preci-
sion and then setting the precision. For details on the precision of executables, see Double-Precision
Executables (p. 178).

• You can override the problem size capability ("large problem" or not) set on the Run Definition
tab by selecting Override Default Large Problem Setting and then setting the problem size
capability (via the Large Problem check box). For details on the problem size capability of the ex-
ecutables, see Large Problem Executables (p. 178).

• If required, under Interpolator Memory, you can adjust the memory configuration. For details, see
Configuring Memory for the CFX-Solver in the CFX-Solver Manager User's Guide (p. 38).

• You can select Domain Search Control to access the Bounding Box Tolerance setting (see below).

• You can select Interpolation Model Control to access the Enforce Strict Name Mapping for
Phases (only available in CFX-Solver Manager), Particle Relocalization Tolerance (only available
in CFX-Solver Manager), and Mesh Deformation Option settings (see below).

The Bounding Box Tolerance and Particle Relocalization Tolerance settings are described in Ad-
justing the Bounding Box Tolerance in the CFX-Solver Modeling Guide.

The Enforce Strict Name Mapping for Phases setting controls how fluids are mapped between the
Initial Values files and the Solver Input File. By default, when interpolating from multiple Initial Values
files onto a single Solver Input File, if each Initial Values file contains just one fluid, then the CFX-In-
terpolator regards all of these fluids as being the same fluid, regardless of the Fluid Definition name.
You can change this default behavior by turning on the Enforce Strict Name Mapping for Phases
setting. This forces the CFX-Interpolator to use the Fluid Definition names to match each fluid from
each Initial Values file with the appropriate fluid in the Solver Input File.

The Mesh Deformation Option setting controls which mesh in the Initial Values File is used to check
the mesh displacements: the initial mesh or the final mesh. The options are Automatic, Use
Latest Mesh, and Use Initial Mesh. When the Automatic option is selected, the initial
mesh will be used if the Continue History From check box is selected, and the latest mesh will be
used if the Continue History From check box is cleared.
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2.2.7. Configuring Memory for the CFX-Solver

There may be instances when the CFX-Solver fails due to insufficient memory. You can determine
that the CFX-Solver failed in this way as well as which of the interpolator, partitioner, or flow solver
steps failed by reviewing the CFX-Solver Output file. In this case you will be required to adjust the
memory configuration of the appropriate CFX-Solver step. The methods available for adjusting memory
are:

• Memory Allocation Factor: Use this method to modify the memory allocation for the CFX-Solver
step as a whole. For example, a value of 1.05 for Memory Allocation Factor increases memory al-
location by 5% and a value of 1.1 increases memory allocation by 10%.

• Detailed Memory Overrides: Use this method to adjust Real Memory, Integer Memory, Character
Memory, Double Memory and Logical Memory as required.

• The number of words of memory can be specified, or a memory multiplier can be used. Use a unit
of M for mega-words, K for kilo-words, or X for a memory multiplier. For example, 2 X doubles the
memory allocation and 15 M means 15 million words of memory. If a value is not specified for a
particular type of memory, the value calculated by the Solver is used. If a value is entered, it overrides
the automatic estimate made by the Solver.

• Catalogue Size Override: If the solver fails with a CFX-Solver Output file containing the error
message *** INSUFFICIENT CATALOGUE SIZE ***, increase the Catalogue Size Override
setting to a value above 1 until the solver runs. This parameter has the same syntax as the Detailed
Memory Overrides above. For example, you can scale the default size by using a scale factor
greater than 1, such as 1.05 X. For details, see Starting the CFX-Solver from the Command
Line (p. 157).

2.3. Run Output Results

Once the run definition is complete and the run is started, a new workspace is created and the Work-
space drop-down list will contain an entry based on the name of the Solver Input File. For example,
using the Solver Input File named case.def, the workspace entry will be similar to Run case 001.
Note that the integer index is identical to the index used for the CFX-Solver Output and results files for
the run. For multi-configuration simulations, one additional workspace is created as each new configur-
ation is executed. The Workspace drop-down list will contain entries based on the names of the con-
figurations.

Most workspaces contain a mixture of plot and text output monitors that are updated by the CFX-
Solver as the simulation progresses. By default, appropriate monitors are automatically created in the
workspace for the particular type of simulation you are running. These include:

• Plot monitors showing the normalized residuals (which should decrease as the solution progresses)
for each equation being solved, plus any user-defined monitor values.

• A text monitor showing the contents of the CFX-Solver Output file. For details, see CFX-Solver
Output File (p. 51).

No plot monitors are generated for the simulation-level workspace (named according to the Solver
Input File) created for multi-configuration simulations. This workspace includes one text monitor,
showing the contents of the Multi-Configuration CFX-Solver Output File. For details, see Multi-Configur-
ation CFX-Solver Output File (p. 92).
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When the CFX-Solver stops running, a dialog box is displayed that indicates whether the run completed
normally or not, and additional information regarding the reasons for terminating the run are presented
in the text output window.

The following dialog boxes may appear:

• Solver Run Finished Normally

• Solver Run Stopped By User

• Solver Run Terminated With Errors

To close the dialog box without postprocessing the results, click OK.

On the Solver Run Finished Normally and Solver Run Stopped By User dialog boxes, you can choose
from the following options:

Post-Process Results

Opens CFD-Post with the specified CFX-Solver Results file loaded.

Multi-Configuration Load Options

If this option is available, you can use it to control how the results of a multi-configuration run are
loaded, or to load just the last case of such a run.

Select a multi-configuration load option to control how you load a multi-configuration (.mres) file
or a results file (.res) that contains a run history (that is, a file that was produced from a definition
file that had its initial values specified from a results file from a previous run and saved to the results
file that you are loading). Choose:

• Single Case to load all configurations of a multi-configuration run as a single case, or all of the
results history from a results file that contains a run history. In either case, only one set of results
will appear in the viewer, but you can use the timestep selector to move between results. This
option is not fully supported.

• Separate Cases to load all configurations from a multi-configuration run into separate cases. If
a results file with run history is loaded, CFD-Post loads the results from this file and the results
for any results file in its run history as separate cases. Each result appears as a separate entry in
the tree.

• Last Case to load only the last configuration of a multi-configuration results file, or only the last
results from a results file that contains a run history.

Shut down CFX-Solver Manager

Shuts down CFX-Solver Manager before CFD-Post is launched. This minimizes the number of licenses
you use concurrently.

To post-process the results, make the desired settings on the dialog box and click OK.

After a run has finished you can use CFX-Solver Manager to:

• Define a new run by following the earlier procedure. For details, see Define Run Command (p. 115).
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• Calculate more timesteps for the original run. For details, see Restarting a Run (p. 43).

• View results in CFD-Post (provided that the CFX-Solver produced a results file and did not fail). For
details, see Overview of CFD-Post in the CFD-Post User's Guide.

• Print residual plots in the convergence history plots. For details, see Printing an Image of the Conver-
gence History (p. 16).

• Add comments to the saved version of the text in the text output window. For details, see Starting
the CFX-Solver from the Command Line (p. 157).

• Export results in a format suitable for post-processors other than CFD-Post. For details, see File Export
Utility (p. 185).

• Quit CFX-Solver Manager by selecting File > Quit. This does not stop the CFX-Solver calculation.
Additionally, CFX-Solver Manager can be reopened at any time. For details, see CFX-Solver Manager
File Menu (p. 115).

The CFX Tutorials describe how to use the CFX-Solver Manager step-by-step for several different cases.
If you are a new user, you should try at least the first few tutorials.

2.4. Parallel Run

Note:

CFX-Solver can be run in parallel only if an appropriate license has been purchased.

Information on a parallel run is explained in more detail:

• Overview (p. 40)

• General Procedure (p. 40)

• Configuring a Parallel Run (p. 41)

2.4.1. Overview

MPI (Message Passing Interface) is the primary parallel run mode used by CFX. MPI is a library that
enables flow solver processes to communicate with each other. Proprietary, vendor specific versions
of MPI are available on 64-bit Linux and support a wide array of high-speed network devices, as well
as Shared Memory communication.

General information on setting up a parallel run and advice on obtaining optimal parallel performance
is available in Using the Solver in Parallel in the CFX-Solver Modeling Guide.

Individual machines may need to be configured to run in parallel.

2.4.2. General Procedure

To run CFX-Solver in parallel, the following procedure must be followed:
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1. Partition the mesh into the appropriate number of partitions.

2. Run CFX-Solver on the partitioned problem.

These two jobs can be done either as one composite run, or as two separate jobs.

2.4.3. Configuring a Parallel Run

Under Run Mode, select a parallel method:

• Local Parallel Setup (p. 41)

• Distributed Parallel Setup (p. 41)

2.4.3.1. Local Parallel Setup

Select a local parallel run if running a problem with two or more processors on the local machine.

Any number of partitions between 2 and 16384 can be selected. When running the job in the CFX-
Solver, the computation is divided into this number of processes. For details, see Partitioner
Tab (p. 31). The solver enables further changes. For details, see Solver Tab (p. 35).

1. Select one of the local parallel run modes (for example, Intel MPI Local Parallel).
Which parallel run modes you can select depends on the hardware and operating system on
which you are running.

2. Click Add Partition  or Remove Partition  to increase or decrease the number of partitions.

Partitions may need to be configured based on partition weighting. For details, see Partitioner
Tab (p. 31).

2.4.3.2. Distributed Parallel Setup

Select a distributed parallel option to run a problem on two or more computers.

2.4.3.2.1. Overview

To configure a distributed parallel run, a file named hostinfo.ccl must exist in the <CFX-
ROOT>/config/ CFX directory on the leader node and be readable by all users of the software.
This file is a database containing information about available nodes and where Ansys CFX is in-
stalled on each of them. See Ansys CFX Hosts Specification in the Ansys, Inc. Installation Guides
for more details.

Note:

• Including hosts in the hostinfo.ccl file is optional. If you want to use a host
that is not present in either the hostinfo.ccl file in the <CFXROOT>/config/
directory or your own version of this file, then you can add this host to the list that
is used for a particular run by using the CFX-Solver Manager as described in Selecting
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Parallel Hosts (p. 42). However, you would have to do this each time you start a
run.

• Linux users should see Ansys CFX Linux Parallel Setup in the Ansys, Inc. Installation
Guides for more information.

• Most distributed parallel methods have restrictions on which machines can be
combined in a single distributed run. For details, see Using the Solver in Parallel in
the CFX-Solver Modeling Guide.

2.4.3.2.2. Selecting Parallel Hosts

You must specify a list of host machines to use for your distributed parallel run.

You can add a host from a predefined list of available hosts (which is populated by data from

the hostinfo.ccl file) by clicking Insert Host .

Once you have added a host, you can configure its properties as required by clicking Create/Edit

Host .

If you want to add a host that is not listed in the predefined list of available hosts, you can add

a host by clicking Create/Edit Host , then entering the properties. The properties that can be
set are the same as those that can be set in the hostinfo.ccl file and are described in Ansys
CFX Hosts Specification in the Ansys, Inc. Installation Guides. If you have a host selected when you
click this icon, then the properties for that host will be displayed; however changing the Host
Name causes CFX-Solver Manager to create a new entry.

Ensure that the name of the current machine is included in the list of host machines to use for
your distributed parallel run.

2.4.3.2.3. Configuring a Host

Each parallel host can be configured independently as follows:

1. In Parallel Environment, under Host Name, select the host to configure.

2. Click Create/Edit Host  to review or change the properties for the host.

3. Click Add Partition  or Remove Partition  to increase or decrease the number of parti-
tions.

Partitions may need to be configured based on partition weighting. For details, see Partitioner
Tab (p. 31).

Any changes you make affect the current solver run only.
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2.5. Restarting a Run

A CFX-Solver run that has stopped may be restarted for the following reasons:

• The CFX-Solver stopped prematurely, at your request, and now needs to continue running.

• More timesteps are needed to extend the duration of a transient analysis, or more iterations are
needed to reach a required level of convergence for a steady-state analysis.

• You have added operating points to an operating point run.

Such restarts are particularly useful because they continue the analysis from where it left off, which is
often much more efficient than rerunning the analysis from the original CFX-Solver Input file. For each
restart, a new workspace is created and the previously saved solver manager state is loaded.

The following discussions describe restarting simulations from CFX-Solver Results files using the same
or modified settings:

• Restart Procedure (p. 43)

• Restart Details (p. 43)

2.5.1. Restart Procedure

1. Select File > Define Run.

2. Select, under CFX-Solver Input File, the CFX-Solver Results file of the previous run.

3. Configure the Define Run dialog box as required.

4. Click Start Run.

Tip:

You may also select Workspace > Restart Run to restart the analysis presented in
the active workspace. For details, see CFX-Solver Manager File Menu (p. 115).

2.5.2. Restart Details

Restarting a run should have little effect on the convergence history and no effect on the final results.
Additional information regarding several types of restarts is presented below.

• Runs Using Mesh Adaption (p. 44)

• Runs After Physical Model or Solver Parameter Changes (p. 44)

• Runs After Topology or Mesh Changes (p. 44)

• Multi-Configuration Simulations (p. 45)
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2.5.2.1. Runs Using Mesh Adaption

Restarting a run that uses mesh adaption has no effect on the final results. If the maximum number
of adaption steps has been specified, then CFX-Solver determines how many adaption steps were
completed in the initial run when determining how many adaption steps remain.

2.5.2.2. Runs After Physical Model or Solver Parameter Changes

You may change CCL settings before continuing from a previously generated CFX-Solver Results
file. This is, however, not handled as a restart. For this case, the previously generated results file is
first read into CFX-Pre, settings are modified, and a new CFX-Solver Input file is written. Note that
this file contains the updated CCL as well as the final mesh and mesh adaption parameters from
the previous run. A new run is then defined using:

• The newly generated file as the Solver Input File,

• The previously generated results file in an Initial Values definition.

Tip:

On the details view of Initialization in CFX-Pre, set the initial conditions for the variables
contained in the old results file to Automatic. This will ensure that they will be restarted.

Changing the fundamental physics of an analysis, such as the fluids and/or materials involved, is
not recommended. Do not change the reference pressure.

Note:

If a run that requires the wall scale to be calculated is restarted, and a wall scale-related
setting was changed (for example, a free slip wall changed to a no-slip wall), the wall
scale will not automatically be recalculated if its calculation was terminated in a previous
run. To force it to be recalculated, set the expert parameter ignore solve flag
on restart to true. For details on expert parameters, see CFX-Solver Expert Control
Parameters in the CFX-Solver Modeling Guide.

Additional information on initial conditions is available in Initialization in the CFX-Pre User's Guide
and Reading the Initial Conditions from a File in the CFX-Solver Modeling Guide.

2.5.2.3. Runs After Topology or Mesh Changes

If you make changes that affect the way that the mesh is defined, or that affect the way that the
physics CCL relates to the topology of the mesh that is stored in the solver input file, such as:

• Changing the underlying geometry

• Recreating the mesh with different parameters, mesh controls, or inflated boundaries

• Adding a new physics location or removing an existing physics location such as a domain (DO-
MAIN), subdomain (SUBDOMAIN), boundary condition (BOUNDARY), or domain interface (DOMAIN
INTERFACE)
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• Changing the name of any subdomain or boundary condition, including the default boundary
condition

• Changing the locations of the physics, for example, by modifying the locations of domains, sub-
domains, boundaries, or domain interfaces

...then you can continue the run as described in Runs After Physical Model or Solver Parameter
Changes (p. 44). Note that such changes cannot be made at the time the run is started, by using
the CFX-Solver’s -ccl command line argument. Instead, such changes must be incorporated into
a solver input file using CFX-Pre, and you must set, on the Initial Values tab, Use Mesh From to
Solver Input File.

Note that changing the type of boundary condition is possible with the -ccl command line argu-
ment.

2.5.2.4. Multi-Configuration Simulations

Multi-configuration simulations may only be restarted from a multi-configuration results (.mres)
file. The simulation will continue from the final simulation step contained in the specified results
file as follows:

• If all active configurations in that simulation step completed successfully, then the new run will
begin with the next simulation step.

• If all active configurations in that simulation step failed to complete successfully, then the new
run will attempt to complete the final simulation step and execute the configurations that are
still active. This occurs if the simulation is stopped prematurely.

Care is required when CCL changes are made before continuing a multi-configuration simulation.
This is because CCL is propagated (that is re-used) from the multi-configuration results (*.mres)
and most recently created configuration results (*.res) files. In particular:

• Global CCL changes (for instance, LIBRARY, SIMULATION CONTROL contents including EXE
CUTION CONTROL, etc…) must be applied to the multi-configuration results file.

• Configuration specific CCL changes (such as FLOW contents) must be applied to the most recently
generated configuration results files.

Important:

Previously created configuration results (*.res) files are required for accurate CCL
propagation (as noted above) and to resolve configuration dependent initial values, as
defined in Run Definition Tab in the CFX-Pre User's Guide. Paths to these results files are
stored and re-used when restarting multi-configuration simulations, and these paths are
relative to the working directory. For example, the stored path for the first run of the
configuration name Configuration1 corresponding to the multi-configuration results
file named mySim_001.mres is: mySim_001/configuration1_001.res.

Use of relative paths enables the directories (and files) for a multi-configuration simulation
to be transferred to another working directory (for example, on another file system) to
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perform a restart. Restarts are not possible if the required directories (and files) have not
been transferred to the desired working directory.

Note:

If a restart is performed using a specific configuration’s result file (for example, config-
uration1_001.res), then only that configuration will continue execution, but the
multi-configuration simulation will not continue.

If you use results that were generated by a multi-configuration run as the initial values
for another run, then CFX-Solver Manager may use the original multi-configuration
workspace name and state for the new run and show the new run as part of the original
multi-configuration run if the original is also being monitored.

2.5.2.5. Operating Point Cases

Restarts are governed by settings on the Operating Points tab. For details, see Operating Points
Tab (p. 25) and Operating Points Tab in the CFX-Pre User's Guide.
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Chapter 3: CFX-Solver Files
This chapter describes the file types used and generated by CFX-Solver. The CFX-Solver is run using an
input file that is usually the CFX-Solver Input file (.def or .mdef) created by CFX-Pre. For most simu-
lations, the CFX-Solver generates CFX-Solver Output (.out) and CFX-Solver Results (.res, .trn, .bak,
.mres) files. Other files are also generated depending on the physical models used in the simulation,
and how the simulation is run (that is, in serial or parallel).

Detailed descriptions of these files and how they are used are presented in the following sections:

3.1. Files Used by the CFX-Solver

3.2. Files Generated by the CFX-Solver

3.1. Files Used by the CFX-Solver

The CFX-Solver input file usually contains all the information that is required by the CFX-Solver to run
a CFD simulation. This information includes:

• Physical models and fluid property settings

• Boundary conditions

• Initial conditions

• The mesh

• CFX-Solver parameter settings.

However, there are circumstances when the file specified in the Solver Input File option (referred to
hereafter as the Solver Input File) requires additional solution values to initialize the run. These addi-
tional initial solution values are introduced by defining one or more Initial Values objects, each of
which refers to either a previously created results file or a configuration for which a results file has not
yet been created. In all cases, these results files merely supplement the run with solution values that
are not available in the input file; simulation specifications in the Solver Input File are not overridden.

When starting a run using results from Initial Values objects, the mesh from the Solver Input File is
used by default and solution values are either copied or interpolated from the initial values mesh(es)
onto the Solver Input File mesh. Additionally, when initial values files are used, the run history (that
is, monitor and convergence data, simulation, time and timestep counters) is continued by default. You
may also choose to not continue the run history.

The following tables describe the behavior resulting from different combinations of Solver Input File
and Initial Values objects for single-configuration and multi-configuration simulations.
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Single-Configuration Simulations

DescriptionInitial Values SpecificationSolver Input File

New simulation (that is, no run
history) starting from iteration or
time step # 1.

CFX-Solver Input file

(.def)

Continue simulation (solution
values and run history), starting

CFX-Solver Results

(.res) from the iteration or time step that
follows last completed in the

previous run[a].

Supplement initial conditions in
the Solver Input File with solution

Initial Values object(s) using
the Results File option that

CFX-Solver Input

(.def) values contained in the results filereferences a CFX-Solver
referenced by the Initial Values
object(s).

Results file (.res, .trn,
.bak).

If you explicitly select a solver results file that was generated by a multi-configuration run
to be the solver input file, the name of the new monitor workspace in CFX-Solver Manager
is inherited from the state stored in the configuration results.

[a]

Multi-Configuration Simulations

DescriptionConfiguration-Specific
Initial Values
Specification

Solver Input File

New simulation (that is, no run
history) with all configuration

CFX-Solver Input file

(.mdef) analyses starting from iteration or
time step # 1.

Supplement initial conditions in
configuration definitions with those

Initial Values object(s)
using the Results File

CFX-Solver Input file

(.mdef) contained in the results file(s)option that references a
referenced by the Initial Values
object(s).

CFX-Solver Results file (.res,
.trn, .bak).

Supplement initial conditions in
configuration definitions with

Initial Values object(s)
using the Configuration

CFX-Solver Input file

(.mdef) solution values contained in theResults option that
references a configuration. latest results file corresponding to

the configuration(s) referenced by
the Initial Values object(s).

Continue simulation (solution values
and run history), starting from

CFX-Solver Results file

(.mres) configuration that follows the one
last completed in the previous run.
The simulation will proceed to
complete the last configuration being
executed in the previous run if the
simulation was stopped prematurely
(for example, via the cfx5stop
command). Note that this is the only
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Multi-Configuration Simulations

DescriptionConfiguration-Specific
Initial Values
Specification

Solver Input File

way to continue a multi-configuration

simulation[a].

It is important to note that for multi-configuration simulations:

• Global (or simulation) level Initial Values specifications are not valid

• A configuration level Solver Input File is implied in the multi-configuration setup (that is, it is
not required).

Other important considerations to note are:

• Setting the Initial Values Specification > Use Mesh From option to Solver Input File will activate
the CFX-Interpolator to either copy or interpolate solution values from the mesh in the Initial Values
object(s) to the Solver Input File. See Using the CFX-Interpolator in the CFX-Solver Modeling Guide
for details.

• Setting the Initial Values Specification > Use Mesh From option to Initial Values will use the mesh
from the Initial Values File and de-activate the CFX-Interpolator. See Using the Mesh from the Initial
Values File in the CFX-Solver Modeling Guide for details.

• Unsetting (that is, deselecting) the Initial Values Specification > Continue History From option
will reset the run history and use the Initial Values File to provide a basic initial guess for the new
run. See Continuing the History in the CFX-Solver Modeling Guide for details.

• Setting the Initial Values Specification > Continue History From option will continue the run history
from the results file referenced by the specified Initial Values object, and produce the cleanest restart
possible from the Initial Values File. The first iteration or timestep executed follows the last one
completed in the referenced results file. See Continuing the History in the CFX-Solver Modeling Guide
for details.

The following table describes the behavior resulting from different combinations of Solver Input File
and Initial Values objects for operating point simulations.

Operating Point Simulations

DescriptionInitial Values
Specification

Solver Input File

Each operating point job that needs
to be run starts from iteration or time
step # 1.

CFX-Solver Input file
or CFX-Solver Results
file

(.mdef or .mres)

Each operating point job that needs
to be run supplements initial

Initial Values object(s)
using the Results File

CFX-Solver Input file
or CFX-Solver Results
file conditions in the Solver Input Fileoption that references a

(.mdef or .mres)
with solution values contained in the
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Operating Point Simulations

DescriptionInitial Values
Specification

Solver Input File

results file referenced by the Initial
Values object(s).

CFX-Solver Results file (.res,
.trn, .bak).

Note:

Partial results for operating point jobs cannot be continued. However, an operating point
run (which involves running one or more operating point jobs) can be continued, retaining
some or all results of completed operating point jobs. For details, see Running an Operating
Point Case in the CFX-Solver Modeling Guide.

3.2. Files Generated by the CFX-Solver

The CFX-Solver typically generates two files for each run: the CFX-Solver Output file and the CFX-Solver
Results file. These are discussed in the following sections:

• CFX-Solver Output File (p. 51)

• CFX-Solver Output File (Transient Runs) (p. 68)

• CFX-Solver Output File (Interpolation Runs) (p. 71)

• CFX-Solver Output File (Parallel Runs) (p. 72)

• CFX-Solver Output File (Mesh Adaption Runs) (p. 75)

• CFX-Solver Output File (Remeshing Runs) (p. 76)

• CFX-Solver Output File (Conjugate Heat Transfer Runs) (p. 76)

• CFX-Solver Output File (GGI Runs) (p. 77)

• CFX-Solver Output File (Combustion Runs) (p. 79)

• CFX-Solver Output File (Particle Runs) (p. 81)

• CFX-Solver Output File (Radiation Runs) (p. 85)

• CFX-Solver Output File (Rigid Body Runs) (p. 87)

• CFX-Solver Results File (p. 87)

Additional files are generated for the run as follows:

• For runs that involve the use of the Discrete Transfer or Monte Carlo radiation models, an additional
file containing radiation data can also be generated. See CFX Radiation File (p. 89).

• For parallel runs of the CFX-Solver, an additional CFX partition file can also be generated. See CFX
Partition File (p. 91).
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For multi-configuration simulations, the CFX-Solver generates two additional simulation level CFX-
Solver Output and results files in addition to the CFX-Solver Output and results files generated per
configuration. These files are discussed in the sections:

• Multi-Configuration CFX-Solver Output File (p. 92)

• Multi-Configuration CFX-Solver Results File (p. 96)

3.2.1. CFX-Solver Output File

The CFX-Solver Output file is a formatted text file generated by the CFX-Solver and contains inform-
ation about your CFX model setup, the state of the solution during execution of the CFX-Solver, and
analysis statistics for the particular run. This is the same information written to the text output window
of the CFX-Solver Manager. For details, see Text Output Window (p. 18).

The file is formatted and divided into sections to enable quick and easy interpretation. The sections
that are present for any calculation may depend upon which physical models are being used (that
is, whether the model is transient or steady-state) and whether the CFX-Solver is being run as several
parallel processes or as a single process.

The CFX-Solver will generate a CFX-Solver Output file with a name based on the CFX-Solver Input
file. For example, running the CFX-Solver using the input file named file.def in a clean working
directory will generate a CFX-Solver Output file named file_001.out.

3.2.1.1. Header

The header is written at the start of every CFX-Solver Output file and contains information regarding
the command that started the job. This information is used to check which files were used to start
the run.

3.2.1.2. CFX Command Language for the Run

The CFX Command Language section describes the problem definition, including domain specific-
ation, boundary conditions, meshing parameters and solver control.

The section for the command file looks similar to the following:

 +--------------------------------------------------------------------+
 |                                                                    |
 |                    CFX Command Language for Run                    |
 |                                                                    |
 +--------------------------------------------------------------------+

 LIBRARY:
   MATERIAL: Water
     Material Description = Water (liquid)
     Material Group = Water Data, Constant Property Liquids
     Option = Pure Substance
     Thermodynamic State = Liquid
     PROPERTIES:
       Option = General Material
       EQUATION OF STATE:
         Density = 997.0 [kg m^-3]
         Molar Mass = 18.02 [kg kmol^-1]
         Option = Value
       END
       SPECIFIC HEAT CAPACITY:
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         Option = Value
         Specific Heat Capacity = 4181.7 [J kg^-1 K^-1]
         Specific Heat Type = Constant Pressure
       END
       REFERENCE STATE:
         Option = Specified Point
         Reference Pressure = 1 [atm]
         Reference Specific Enthalpy = 0.0 [J/kg]
         Reference Specific Entropy = 0.0 [J/kg/K]
         Reference Temperature = 25 [C]
       END
       DYNAMIC VISCOSITY:
         Dynamic Viscosity = 8.899E-4 [kg m^-1 s^-1]
         Option = Value
       END
       THERMAL CONDUCTIVITY:
         Option = Value
         Thermal Conductivity = 0.6069 [W m^-1 K^-1]
       END
       ABSORPTION COEFFICIENT:
         Absorption Coefficient = 1.0 [m^-1]
         Option = Value
       END
       SCATTERING COEFFICIENT:
         Option = Value
         Scattering Coefficient = 0.0 [m^-1]
       END
       REFRACTIVE INDEX:
         Option = Value
         Refractive Index = 1.0 [m m^-1]
       END
       THERMAL EXPANSIVITY:
         Option = Value
         Thermal Expansivity = 2.57E-04 [K^-1]
       END
     END
   END
 END
 FLOW: Flow Analysis 1
   SOLUTION UNITS:
     Angle Units = [rad]
     Length Units = [m]
     Mass Units = [kg]
     Solid Angle Units = [sr]
     Temperature Units = [K]
     Time Units = [s]
   END
   ANALYSIS TYPE:
     Option = Steady State
     EXTERNAL SOLVER COUPLING:
       Option = None
     END
   END
   DOMAIN: Default Domain
     Coord Frame = Coord 0
     Domain Type = Fluid
     Location = B1.P3
     BOUNDARY: Default Domain Default
       Boundary Type = WALL
       Location = F1.B1.P3,F2.B1.P3,F4.B1.P3,F5.B1.P3,F6.B1.P3,F8.B1.P3
       BOUNDARY CONDITIONS:
         HEAT TRANSFER:
           Option = Adiabatic
         END
         MASS AND MOMENTUM:
           Option = No Slip Wall
         END
         WALL ROUGHNESS:
           Option = Smooth Wall
         END
       END
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     END
     BOUNDARY: in1
       Boundary Type = INLET
       Location = in1
       BOUNDARY CONDITIONS:
         FLOW REGIME:
           Option = Subsonic
         END
         HEAT TRANSFER:
           Option = Static Temperature
           Static Temperature = 315 [K]
         END
         MASS AND MOMENTUM:
           Normal Speed = 2 [m s^-1]
           Option = Normal Speed
         END
         TURBULENCE:
           Option = Medium Intensity and Eddy Viscosity Ratio
         END
       END
     END
     BOUNDARY: in2
       Boundary Type = INLET
       Location = in2
       BOUNDARY CONDITIONS:
         FLOW REGIME:
           Option = Subsonic
         END
         HEAT TRANSFER:
           Option = Static Temperature
           Static Temperature = 285 [K]
         END
         MASS AND MOMENTUM:
           Normal Speed = 2 [m s^-1]
           Option = Normal Speed
         END
         TURBULENCE:
           Option = Medium Intensity and Eddy Viscosity Ratio
         END
       END
     END
     BOUNDARY: out
       Boundary Type = OUTLET
       Location = out
       BOUNDARY CONDITIONS:
         FLOW REGIME:
           Option = Subsonic
         END
         MASS AND MOMENTUM:
           Option = Average Static Pressure
           Pressure Profile Blend = 0.05
           Relative Pressure = 0 [Pa]
         END
         PRESSURE AVERAGING:
           Option = Average Over Whole Outlet
         END
       END
     END
     DOMAIN MODELS:
       BUOYANCY MODEL:
         Option = Non Buoyant
       END
       DOMAIN MOTION:
         Option = Stationary
       END
       MESH DEFORMATION:
         Option = None
       END
       REFERENCE PRESSURE:
         Reference Pressure = 1 [atm]
       END

53
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Files Generated by the CFX-Solver



     END
     FLUID DEFINITION: Water
       Material = Water
       Option = Material Library
       MORPHOLOGY:
         Option = Continuous Fluid
       END
     END
     FLUID MODELS:
       COMBUSTION MODEL:
         Option = None
       END
       HEAT TRANSFER MODEL:
         Option = Thermal Energy
       END
       THERMAL RADIATION MODEL:
         Option = None
       END
       TURBULENCE MODEL:
         Option = k epsilon
       END
       TURBULENT WALL FUNCTIONS:
         Option = Scalable
       END
     END
   END
   OUTPUT CONTROL:
     RESULTS:
       File Compression Level = Default
       Option = Standard
     END
   END
   SOLVER CONTROL:
     Turbulence Numerics = First Order
     ADVECTION SCHEME:
       Option = Upwind
     END
     CONVERGENCE CONTROL:
       Maximum Number of Iterations = 100
       Minimum Number of Iterations = 1
       Physical Timescale = 2 [s]
       Timescale Control = Physical Timescale
     END
     CONVERGENCE CRITERIA:
       Residual Target = 1.E-4
       Residual Type = RMS
     END
     DYNAMIC MODEL CONTROL:
       Global Dynamic Model Control = On
     END
   END
 END
 COMMAND FILE:
   Version = 12.0.1
   Results Version = 12.0
 END
 SIMULATION CONTROL:
   EXECUTION CONTROL:
     INTERPOLATOR STEP CONTROL:
       Runtime Priority = Standard
       EXECUTABLE SELECTION:
         Double Precision = Off
       END
     END
     PARALLEL HOST LIBRARY:
       HOST DEFINITION: computer123
         Host Architecture String = winnt-amd64
         Installation Root = D:\Program Files\ANSYS Inc\v%v\CFX
       END
     END
     PARTITIONER STEP CONTROL:
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       Multidomain Option = Independent Partitioning
       Runtime Priority = Standard
       EXECUTABLE SELECTION:
         Use Large Problem Partitioner = Off
       END
       PARTITIONING TYPE:
         MeTiS Type = k-way
         Option = MeTiS
         Partition Size Rule = Automatic
       END
     END
     RUN DEFINITION:
       Run Mode = Full
       Solver Input File = \
         D:\examples\StaticMixer.def
     END
     SOLVER STEP CONTROL:
       Runtime Priority = Standard
       EXECUTABLE SELECTION:
         Double Precision = Off
       END
       PARALLEL ENVIRONMENT:
         Number of Processes = 1
         Start Method = Serial
       END
     END
   END
 END

3.2.1.3. Job Information at Start of Run

This section describes the job characteristics in terms of the Run mode (sequential or parallel), the
machine on which the job was started, and the time and date of the start of the run.

The section for job information for a serial run looks similar to the following:

 +--------------------------------------------------------------------+
 |                  Job Information at Start of Run                   |
 +--------------------------------------------------------------------+

 Run mode:       serial run

 Host computer:  host1 (PID:29363)

 Job started:    Fri Nov 29 17:01:29 2013

3.2.1.4. Memory Allocated for the Run

Note:

The amount of memory required might be more or less than the initial memory allocation
amount reported near the start of the run. 1 word is usually 4 bytes, 1 Mword = 1000000
words, and 1 Mbyte = 1048576 bytes.

The section for memory usage looks similar to the following:

 +--------------------------------------------------------------------+
 |         Initial Memory Allocation  (Actual usage may vary)         |
 +--------------------------------------------------------------------+
 |         | Real       | Integer    | Character |  Logical | Double  |
 ----------+------------+------------+-----------+----------+----------
 | Mwords  | 8.69       | 2.05       | 7.87      | 0.12     | 0.09    |

55
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Files Generated by the CFX-Solver



 | Mbytes  | 33.15      | 7.82       | 7.51      | 0.46     | 0.69    |
 ----------+------------+------------+-----------+----------+----------
 +--------------------------------------------------------------------+
 |            Host Memory Information (Mbytes): Solver                |
 +--------------------------------------------------------------------+
 |          Host           |     System     |   Allocated    |   %    |
 +-------------------------+----------------+----------------+--------+
 | fastcomputer1           |     65293.18   |        49.62   |   0.08 |
 +-------------------------+----------------+----------------+--------+

The peak memory usage over the lifetime of the run is reported near the end of the run. For example:

 +--------------------------------------------------------------------+
 |            Host Memory Information (Mbytes): Solver                |
 +--------------------------------------------------------------------+
 |          Host           |     System     |      Peak      |   %    |
 +-------------------------+----------------+----------------+--------+
 | fastcomputer1           |     65293.18   |        65.72   |   0.10 |
 +-------------------------+----------------+----------------+--------+

3.2.1.5. Mesh Statistics

Mesh statistics summarize the following domain-specific and global (across all domains) items:

• Mesh quality diagnostics

• The total number of nodes, elements and boundary faces in the mesh

• The area fractions of mesh interfaces that were unmapped.

Mesh quality diagnostics include measures of mesh orthogonality, expansion and aspect ratio (see
Mesh Issues). For each measure, there are value ranges that are considered good, acceptable, and
poor (the latter indicating potential accuracy or convergence problems). These ranges are annotated
with OK, ok, and !, respectively, in the mesh diagnostics summary. The relevant minimum or max-
imum value is presented for each measure, plus a summary of the percent of the mesh with values
in each of the good, acceptable, and poor ranges. Note that these percentages are rounded to the
nearest integer value. In the sample output presented below, the worst expansion factor is 37,
which is considered poor (that is, annotated with !). While slightly more than 1% of the impeller
mesh exhibits similarly poor values, less than 1% of the global mesh is considered poor and "<1"
is written in the summary.

The section for mesh statistics looks similar to the following:

 +--------------------------------------------------------------------+
 |                          Mesh Statistics                           |
 +--------------------------------------------------------------------+
 | Domain Name          | Orthog. Angle | Exp. Factor  | Aspect Ratio |
 +----------------------+---------------+--------------+--------------+
 |                      | Minimum [deg] |   Maximum    |    Maximum   |
 +----------------------+---------------+--------------+--------------+
 | impeller             |       34.7 ok |        37  ! |        13 OK |
 | tank                 |       61.4 OK |        11 ok |       303 OK |
 | Global               |       34.7 ok |        37  ! |       303 OK |
 +----------------------+---------------+--------------+--------------+
 |                      |  %!  %ok  %OK | %!  %ok  %OK | %!  %ok  %OK |
 +----------------------+---------------+--------------+--------------+
 | impe                 |   0   11   89 |  1   32   67 |  0    0  100 |
 | tank                 |   0    0  100 |  0    2   98 |  0    3   97 |
 | Global               |   0    3   97 | <1   11   89 |  0    2   98 |
 +----------------------+---------------+--------------+--------------+
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 Domain Name : impeller

     Total Number of Nodes                                =        1710

     Total Number of Elements                             =        7554
         Total Number of Tetrahedrons                     =        7206
         Total Number of Prisms                           =         238
         Total Number of Pyramids                         =         110

     Total Number of Faces                                =        1494

 Domain Name : tank

     Total Number of Nodes                                =        4558

     Total Number of Elements                             =        3610
         Total Number of Hexahedrons                      =        3610

     Total Number of Faces                                =        2212

 Global Statistics :

     Global Number of Nodes                               =        6268

     Global Number of Elements                            =       11164
         Total Number of Tetrahedrons                     =        7206
         Total Number of Prisms                           =         238
         Total Number of Hexahedrons                      =        3610
         Total Number of Pyramids                         =         110

     Global Number of Faces                               =        3706

 Domain Interface Name : ImpellerPeriodic

     Non-overlap area fraction on side 1                  =    0.00E+00
     Non-overlap area fraction on side 2                  =    0.00E+00

 Domain Interface Name : TankPeriodic1 TankPeriodic2

     Non-overlap area fraction on side 1                  =    0.00E+00
     Non-overlap area fraction on side 2                  =    0.00E+00

The mesh quality thresholds that define the OK (good), ok (acceptable), and ! (poor) status in the
mesh statistics section of the CFX-Solver Output file are as follows:

<10000.0OKMaximum aspect ratio (double precision)

10000.0 < 100000.0ok

> 100000.0!

< 100.0OKMaximum aspect ratio (single precision)

100.0 < 1000.0ok

> 1000.0!

< 5.0OKMaximum mesh expansion factor

5.0 < 20.0ok

> 20.0!

> 50°OKMinimum orthogonal angle

50° > 20°ok
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< 20°!

Note:

Negative orthogonality angles are possible and indicate the presence of very poor mesh
elements that can adversely affect solution quality. It is recommended that meshes not
contain any negative orthogonality angles.

3.2.1.6. Initial Average Scales

These are average scales based on the initial flow field. If the initial velocity field is zero, then the
initial average velocity scale will also be zero.

The section for initial average scales looks similar to the following:

+--------------------------------------------------------------------+
|                      Average Scale Information                     |
+--------------------------------------------------------------------+
Domain Name : StaticMixer  
     Global Length                                       =  3.2113E+00
     Density                                             =  9.9800E+02
     Dynamic Viscosity                                   =  1.0000E-03
     Velocity                                            =  0.0000E+00
     Thermal Conductivity                                =  5.9100E-01
     Specific Heat Capacity at Constant Pressure         =  4.1900E+03
     Prandtl Number                                      =  7.0897E+00

3.2.1.7. Checking for Isolated Fluid Regions

For serial runs, the solver checks to see if any fluid domain contains volumetric regions that are
isolated pockets. This check cannot be performed for parallel solver runs.

3.2.1.8. Solved Equations

This section lists the dependent variables solved and the equations to which they relate as well as
the estimated physical timestep if calculated automatically.

Equations are given two labels: the individual name and a combined name used for combining
residuals together. Residuals for multi-domain problems are combined provided the domains are
connected together and have the same domain type (solid or fluid/porous). If there are multiple
groups of the same domain type, then the group residual is identified by the name of the first domain
in the connected group.

The section for solved equations looks similar to the following:

 +--------------------------------------------------------------------+
 |              The Equations Solved in This Calculation              |
 +--------------------------------------------------------------------+
 Subsystem : Momentum and Mass
   U-Mom
   V-Mom
   W-Mom
   P-Mass
 Subsystem : Thermal Radiation
   I-Radiation
 Subsystem : Heat Transfer
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   H-Energy
 Subsystem : Temperature Variance
   T-Variance
 Subsystem : TurbKE and Diss.K
   K-TurbKE
   E-Diss.K
 Subsystem : Mixture Fraction
   Z-Mean
   Z-Variance
 Subsystem : Mass Fractions
   NO-Mass Fraction

3.2.1.9. Convergence History

The convergence history section details the state of the solution as it progresses. Equation residual
information at specified locations enables you to monitor the convergence. Convergence difficulties
can often be pinpointed to a particular part of the solution (for example, the momentum equation),
and/or a particular location.

The tables shown in the convergence history have the following columns:

• Rate

The rate is defined as seen in Equation 3.1 (p. 59) where  is the residual at iteration , and
 is the residual at an earlier iteration. Rates less than 1.0 indicate convergence.

(3.1)

• RMS Res

The value of the root mean square normalized residual taken over the whole domain.

• Max Res

The value of the maximum normalized residual in the domain.

• Linear Solution

The three columns in this section refer to the performance of the linear (inner) solvers. The first
column is the average number of iterations the linear solvers attempted to obtain the specified
linear equation convergence criteria (within a specified number of iterations). The second column
gives the normalized residuals for the solutions to the linear equation. The last column can have
one of four entries:

– * indicates that there was a numerical floating point exception and this resulted in the failure
of the linear solvers.

– F indicates that the linear solvers did not reduce the residuals (that is, the solution was diver-
ging), but the linear solvers may carry on if the divergence is not catastrophic.

– ok indicates that the residuals were reduced, but that the degree of reduction did not meet
the specified criteria.

– OK indicates that the specified convergence criteria for the reduction of residuals was achieved.
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After the convergence criteria has been achieved, or the specified number of timesteps has been
reached, CFX-Solver appends additional information, calculated from the solution, to the CFX-
Solver Output file.

The convergence history for a steady state analysis looks similar to the following:

+--------------------------------------------------------------------+
|                       Convergence History                          |
+--------------------------------------------------------------------+
======================================================================
OUTER LOOP ITERATION =    1                     CPU SECONDS = 2.68E+00
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
| U - Mom              | 0.00 | 1.5E-10 | 5.4E-09 |       1.5E+10  ok|
| V - Mom              | 0.00 | 1.6E-04 | 3.2E-03 |       6.4E+01  ok|
| W - Mom              | 0.00 | 2.5E-10 | 6.4E-09 |       1.1E+10  ok|
| P - Mass             | 0.00 | 2.2E-03 | 3.0E-02 | 12.0  9.5E-02  OK|
+----------------------+------+---------+---------+------------------+
| H-Energy             | 0.00 | 3.6E-03 | 3.6E-02 |  5.4  8.0E-03  OK|
+----------------------+------+---------+---------+------------------+
======================================================================
OUTER LOOP ITERATION =    2                     CPU SECONDS = 1.24E+01
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
| U - Mom              |99.99 | 5.2E-03 | 7.5E-02 |       4.8E-02  OK|
| V - Mom              |99.76 | 1.6E-02 | 1.6E-01 |       1.4E-02  OK|
| W - Mom              |99.99 | 8.4E-03 | 1.2E-01 |       7.9E-02  OK|
| P - Mass             | 4.26 | 9.3E-03 | 1.3E-01 |  8.3  8.4E-02  OK|
+----------------------+------+---------+---------+------------------+
| H-Energy             | 0.35 | 1.3E-03 | 8.8E-03 |  9.4  2.9E-03  OK|
+----------------------+------+---------+---------+------------------+
................
................
======================================================================
OUTER LOOP ITERATION =   29                     CPU SECONDS = 2.44E+02
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
| U - Mom              | 0.86 | 7.7E-05 | 3.1E-04 |       5.1E-02  OK|
| V - Mom              | 0.86 | 9.1E-05 | 3.7E-04 |       4.8E-02  OK|
| W - Mom              | 0.86 | 1.9E-05 | 1.6E-04 |       5.0E-02  OK|
| P - Mass             | 0.87 | 3.7E-05 | 1.7E-04 |  8.3  3.0E-02  OK|
+----------------------+------+---------+---------+------------------+
| H-Energy             | 0.86 | 5.7E-06 | 5.5E-05 |  9.5  9.8E-03  OK|
+----------------------+------+---------+---------+------------------+
CFD Solver finished: Wed Oct 25 16:01:48 2000
CFD Solver wall clock seconds: 1.0000E+00

If a steady state analysis is continued, then the outer loop iterations and CPU seconds for the current
run are enclosed in parenthesis, as shown below. Values not enclosed in parenthesis are the totals
for the overall analysis.

======================================================================
OUTER LOOP ITERATION =   30 (    1) CPU SECONDS = 2.48E+02 ( 3.38E+00)
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
| U - Mom              | 0.00 | 1.5E-04 | 1.2E-03 |       4.6E-02  OK|
| V - Mom              | 0.00 | 2.1E-04 | 1.2E-03 |       3.8E-02  OK|
| W - Mom              | 0.00 | 1.5E-04 | 2.1E-03 |       1.3E-02  OK|
| P - Mass             | 0.00 | 3.2E-05 | 1.5E-04 |  8.3  3.4E-02  OK|
+----------------------+------+---------+---------+------------------+
| H-Energy             | 0.00 | 7.7E-06 | 8.5E-05 |  9.5  9.1E-03  OK|
+----------------------+------+---------+---------+------------------+
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3.2.1.10. Computed Model Constants

If the Zero Equation model is used to model turbulence, the overall turbulence viscosity is provided.

The section for computed model constants looks similar to the following:

+--------------------------------------------------------------------+
|                      Computed Model Constants                      |
+--------------------------------------------------------------------+
Turbulence viscosity for Turbulence Model 1   = 3.3667E+00

3.2.1.11. Termination and Interrupt Condition Summary

After executing each coefficient iteration and time step (or outer iteration), the solver evaluates all
internal termination conditions and user-defined interrupt control conditions. In the event of a
termination or interrupt, any of these conditions that are true are reported in the CFX-Solver Output
file as outlined below.

 ======================================================================
               Termination and Interrupt Condition Summary  
 ======================================================================
CFD Solver: <internal termination condition description> 
User: <interrupt condition object name> 

3.2.1.12. Global Conservation Statistics

Global conservation statistics are generated for all transport equations with the exception of turbu-
lence equations, which have special wall treatment. These are good checks for the convergence of
a solution. Small values of global imbalance indicate that conservation has essentially been achieved.

The percentage imbalance of a quantity is calculated as:

where " " is taken to be the largest contribution in all connected domains for the
specific group of equations. The grouping of equations for the purpose of normalization can be
different depending on the case.

For single-phase calculations, each equation imbalance is normalized using the largest contribution
for that equation subsystem. The exception is the hydrodynamic subsystem, where each momentum
equation imbalance is normalized using the largest contribution from all momentum equations,
and the continuity equation imbalance is normalized using the largest contribution in all continuity
equations.

For Eulerian multiphase cases, the imbalance normalization can be across all phases or within a
single phase for any equation, depending on the physics and whether coupled volume fractions
are employed. A summary table of how each equation normalization is performed is given below:

NormalizationEquation

Coupled VFsSegregated VFs

All PhasesAll PhasesMomentum
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NormalizationEquation

All PhasesAll PhasesEnergy

All PhasesEach PhaseMass

All PhasesEach PhaseMass [a]

Each PhaseEach PhaseComponents

All PhasesAll PhasesComponents [b]

Each PhaseEach PhaseAdditional
Variables

All PhasesAll PhasesAdditional

Variables [c]

Physics includes interphase mass transfer.[a]

Physics includes interphase component transfer.[b]

Physics includes interphase Additional Variable transfer.[c]

The section for global conservation statistics looks similar to the following:

 ======================================================================
              Boundary Flow and Total Source Term Summary
 ======================================================================

 +--------------------------------------------------------------------+
 |                               U-Mom                                |
 +--------------------------------------------------------------------+
 Boundary         : CatConv Default                        -9.4754E-01
 Boundary         : Inlet                                   1.6971E+00
 Boundary         : InletSide Side 1                        1.3262E-05
 Boundary         : Outlet                                 -1.0523E+00
 Boundary         : OutletSide Side 1                      -1.7085E-07
 Sub-Domain       : catalyst                                2.6129E-01
 Neg Accumulation : CatConv                                 4.1436E-02
 Domain Interface : InletSide (Side 1)                     -1.1166E-02
 Domain Interface : InletSide (Side 2)                      1.1166E-02
 Domain Interface : OutletSide (Side 1)                    -1.4308E-05
 Domain Interface : OutletSide (Side 2)                     1.4308E-05
                                                           -----------
 Domain Imbalance :                                        -3.6059E-05

 +--------------------------------------------------------------------+
 |                               V-Mom                                |
 +--------------------------------------------------------------------+
 Boundary         : CatConv Default                        -3.3355E-02
 Boundary         : Inlet                                   1.1009E-07
 Boundary         : InletSide Side 1                        7.2564E-06
 Boundary         : Outlet                                 -4.7561E-04
 Boundary         : OutletSide Side 1                       1.9734E-08
 Sub-Domain       : catalyst                                3.4056E-02
 Neg Accumulation : CatConv                                -2.4319E-04
 Domain Interface : InletSide (Side 1)                     -4.7260E-04
 Domain Interface : InletSide (Side 2)                      4.7262E-04
 Domain Interface : OutletSide (Side 1)                     7.5672E-06
 Domain Interface : OutletSide (Side 2)                    -7.5672E-06
                                                           -----------
 Domain Imbalance :                                        -1.0275E-05

 +--------------------------------------------------------------------+
 |                               W-Mom                                |
 +--------------------------------------------------------------------+
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 Boundary         : CatConv Default                        -1.1450E+01
 Boundary         : Inlet                                  -1.6971E+00
 Boundary         : InletSide Side 1                        1.3180E-01
 Boundary         : Outlet                                  1.0628E+00
 Boundary         : OutletSide Side 1                      -6.8369E-02
 Sub-Domain       : catalyst                                1.2137E+01
 Neg Accumulation : CatConv                                -1.8195E-01
 Domain Interface : InletSide (Side 1)                      2.2715E+01
 Domain Interface : InletSide (Side 2)                     -2.2592E+01
 Domain Interface : OutletSide (Side 1)                    -1.0548E+01
 Domain Interface : OutletSide (Side 2)                     1.0493E+01
                                                           -----------
 Domain Imbalance :                                         1.4353E-03

 +--------------------------------------------------------------------+
 |                               P-Mass                               |
 +--------------------------------------------------------------------+
 Boundary         : Inlet                                   2.8382E-02
 Boundary         : Outlet                                 -5.6938E-02
 Neg Accumulation : CatConv                                 2.8576E-02
 Domain Interface : InletSide (Side 1)                     -3.0665E-02
 Domain Interface : InletSide (Side 2)                      3.0665E-02
 Domain Interface : OutletSide (Side 1)                     5.6543E-02
 Domain Interface : OutletSide (Side 2)                    -5.6543E-02
                                                           -----------
 Domain Imbalance :                                         2.0828E-05

 +--------------------------------------------------------------------+
 |                            I-Radiation                             |
 +--------------------------------------------------------------------+
 Boundary         : CatConv Default                        -1.4392E+01
 Boundary         : Inlet                                   1.9442E+01
 Boundary         : InletSide Side 1                        3.8307E-01
 Boundary         : Outlet                                 -6.1793E+00
 Boundary         : OutletSide Side 1                      -1.7803E-01
 Domain Src (Neg) : CatConv                                -2.9646E-01
 Domain Src (Pos) : CatConv                                 3.0447E-01
 Domain Interface : InletSide (Side 1)                     -4.6702E+02
 Domain Interface : InletSide (Side 2)                      4.6702E+02
 Domain Interface : OutletSide (Side 1)                    -7.4487E+01
 Domain Interface : OutletSide (Side 2)                     7.4490E+01
                                                           -----------
 Domain Imbalance :                                        -9.0640E-01

 +--------------------------------------------------------------------+
 |                              H-Energy                              |
 +--------------------------------------------------------------------+
 Boundary         : CatConv Default                         1.4284E+01
 Boundary         : Inlet                                   8.6049E+03
 Boundary         : InletSide Side 1                       -3.8344E-01
 Boundary         : Outlet                                 -2.3960E+02
 Boundary         : OutletSide Side 1                       1.7809E-01
 Domain Src (Neg) : CatConv                                -3.0461E-01
 Domain Src (Pos) : CatConv                                 2.9616E-01
 Neg Accumulation : CatConv                                -8.3717E+03
 Domain Interface : InletSide (Side 1)                     -7.6620E+03
 Domain Interface : InletSide (Side 2)                      7.6620E+03
 Domain Interface : OutletSide (Side 1)                     1.3624E+02
 Domain Interface : OutletSide (Side 2)                    -1.3624E+02
                                                           -----------
 Domain Imbalance :                                         7.6699E+00

An example section that shows how the imbalance for each transport equation is normalized:
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+--------------------------------------------------------------------+
|                     Normalised Imbalance Summary                   |
+--------------------------------------------------------------------+
|       Equation       |      Maximum Flow     |     Imbalance (%)   |
+--------------------------------------------------------------------+
| U-Mom-Fluid 2        |       6.0270E+02      |       15.9327       |
| V-Mom-Fluid 2        |       6.0270E+02      |        0.0000       |
| W-Mom-Fluid 2        |       6.0270E+02      |        0.0004       |
| U-Mom-Fluid 1        |       6.0270E+02      |      -16.6732       |
| V-Mom-Fluid 1        |       6.0270E+02      |        0.0001       |
| W-Mom-Fluid 1        |       6.0270E+02      |        0.0004       |
| Mass-Fluid 2         |       5.9820E+02      |       16.2942       |
| Mass-Fluid 1         |       5.9820E+02      |      -16.2929       |
+----------------------+-----------------------+---------------------+
+----------------------+-----------------------+---------------------+
| H-Energy-Fluid 2     |       3.7642E+07      |     -136.9703       |
| H-Energy-Fluid 1     |       3.7642E+07      |      -76.2664       |
+----------------------+-----------------------+---------------------+

For more details, see Monitoring and Obtaining Convergence in the CFX-Solver Modeling Guide.

3.2.1.13. Calculated Wall Forces and Moments

The CFX-Solver calculates the pressure and viscous components of forces on all boundaries specified
as walls. The drag force on any wall can be calculated from these values as follows:

Lift is the net force on the body in the direction perpendicular to the direction of flow. In the above
diagram, the lift is the sum of the forces on the wall in the vertical direction, that is, the sum of the
pressure force and the viscous force components in the y direction.

Drag is the net force on the body in the direction of the flow. In the above diagram, the drag is
the sum of the forces on the wall in the horizontal direction, that is, the sum of the pressure force
and the viscous force components in the x direction.

It is apparent from this that viscous force is not a pure shear force because it also has a small
component in the normal direction, arising in part from a normal component in the laminar flow
shear stress.

The pressure and viscous moments are related to the pressure and viscous forces calculated at the
wall. The pressure moment is the vector product of the pressure force vector  and the position
vector . The viscous moment is the vector product of the viscous force vector  and the position
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vector . As an example, review Equation 3.2 (p. 65) where  and  are the pressure and viscous
moments respectively.

(3.2)

These are summed over all the surface elements in the wall.

It is important to note that forces are evaluated in the local reference frame and that they do not
include reference pressure effects. The pressure force is calculated as the integral of the relative
pressure over the wall area and not as the integral of the sum of the reference and relative pressures.
You can include reference pressure effects in the force calculation by setting the expert parameter
include pref in forces = t.

It is also important to note that for rotating domains in a transient run, forces are evaluated in the
reference frame fixed to the initial domain orientation. These quantities are not influenced by any
rotation that might occur during a transient run or when a rotational offset is specified. However,
results for rotating domains in a transient run may be in the rotated position (depending on the
setting of Options in CFD-Post) when they are subsequently loaded into CFD-Post for post-pro-
cessing.

The sections for calculated wall forces and moments look similar to the following:

 ======================================================================
                     Wall Force and Moment Summary
 ======================================================================

 Notes:
 1. Pressure integrals exclude the reference pressure.  To include
    it, set the expert parameter 'include pref in forces = t'.

 +--------------------------------------------------------------------+
 |                      Pressure Force On Walls                       |
 +--------------------------------------------------------------------+
                                    X-Comp.      Y-Comp.      Z-Comp.

 Domain Group: Bottom Box

 Copy of Walls                    7.5841E+01   8.4350E+01  -5.2096E+02
 Top Box Default                 -5.4841E+01   0.0000E+00   0.0000E+00
 Walls                            4.8468E+01   1.2755E+02   5.0230E+02
                                  -----------  -----------  -----------
 Domain Group Totals :            6.9468E+01   2.1190E+02  -1.8659E+01

 +--------------------------------------------------------------------+
 |                       Viscous Force On Walls                       |
 +--------------------------------------------------------------------+
                                    X-Comp.      Y-Comp.      Z-Comp.

 Domain Group: Bottom Box

 Copy of Walls                   -3.4280E-04  -1.8638E-03  -5.7310E-04
 Top Box Default                 -4.7982E-05   5.5391E-06  -2.2129E-05
 Walls                            2.9180E-04  -4.3111E-05  -6.2137E-04
                                  -----------  -----------  -----------
 Domain Group Totals :           -9.8980E-05  -1.9014E-03  -1.2166E-03
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3.2.1.14. Maximum Residual Statistics

The locations of the maximum residuals are very important when identifying and/or quantifying
the root cause of solution convergence difficulties. If there is trouble converging to a steady-state
solution and the maximum residuals are large, take the following steps:

1. In the CFX-Solver Output file, identify the equation that has the largest maximum (not RMS)
residuals in the diagnostics section for the final iteration (see Convergence History (p. 59)).
Specifically, look at the momentum, mass, and energy equations’ maximum residuals.

2. Find the Locations of Maximum Residuals table near the bottom of the CFX-Solver
Output file, and identify the domain and node number for the equation with the largest max-
imum residual.

3. Create a point locator in CFD-Post using the domain and node number identified above by
setting Geometry > Method to Node Number. For details, see Point: Geometry Tab in the
CFD-Post User's Guide.

The sections for maximum residual statistics look similar to the following:

 +--------------------------------------------------------------------+
 |               Locations of Maximum Residuals                       |
 +--------------------------------------------------------------------+
 |       Equation       |      Domain Name      |     Node Number     |
 +--------------------------------------------------------------------+
 | U-Mom                | Domain 1              |              34     |
 | V-Mom                | Domain 1              |               4     |
 | W-Mom                | Domain 2              |              61     |
 | P-Mass               | Domain 1              |              61     |
 +----------------------+-----------------------+---------------------+
 | H-Energy             | Domain 2              |              61     |
 +----------------------+-----------------------+---------------------+
 | H2O-Mass Fraction    | Domain 1              |              57     |
 | C2H6O-Mass Fraction  | Domain 1              |               1     |
 | C10H22-Mass Fraction | Domain 2              |              61     |
 +----------------------+-----------------------+---------------------+

The presence of regions of low mesh quality is the most common cause of stalled convergence. A
common cause of stalled convergence within steady-state simulations is the presence of recirculating
flow or local flow separation. Try to correlate the cause of stalled convergence to the location of
the maximum residual in CFD-Post. Check for poor mesh quality, separating flow, reattaching flow,
etc. in this location to determine whether the lack of tight convergence is caused by a problem
that can be solved (for example, by improving the mesh in this region), or caused by a tolerable
oscillation (for example, if some transient flow phenomena is being resolved in an otherwise steady-
state flow simulation).

3.2.1.15. False Transient Information

This is only applicable to steady-state simulations (serial and parallel). The information is equation
based, that is there is one line per equation solved. For each equation, the type of timestepping
used is displayed as Auto, Physical or Local.

Both Auto and Physical run as false transients. This means that although the simulation is steady
state, a transient term with an associated timestep is used to relax the equations during convergence.
In this case, the total elapsed pseudo-time is also printed.
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The section for false transient information looks similar to the following:

+--------------------------------------------------------------------+
|                   False Transient Information                      |
+--------------------------------------------------------------------+
|       Equation       |       Type        |   Elapsed Pseudo-Time   |
+--------------------------------------------------------------------+
| U - Mom              | Physical          |      5.80000E+01        |
| V - Mom              | Physical          |      5.80000E+01        |
| W - Mom              | Physical          |      5.80000E+01        |
| P - Mass             | Physical          |      5.80000E+01        |
| H-Energy             | Physical          |      5.80000E+01        |
+--------------------------------------------------------------------+

3.2.1.16. Final Average Scales

These are average scales for the final flow field.

The section for final average scales looks similar to the following:

+--------------------------------------------------------------------+
|                     Average Scale Information                      |
+--------------------------------------------------------------------+
Domain Name : StaticMixer
 Global Length                                       =  3.2113E+00
 Density                                             =  9.9800E+02
 Dynamic Viscosity                                   =  1.0000E-03
 Velocity                                            =  1.4534E+00
 Advection Time                                      =  2.2095E+00
 Reynolds Number                                     =  4.6581E+06
 Thermal Conductivity                                =  5.9100E-01
 Specific Heat Capacity at Constant Pressure         =  4.1900E+03
 Prandtl Number                                      =  7.0897E+00
 Temperature Range                                   =  3.0008E+01

3.2.1.17. Variable Range Information

These are the maximum and minimum values for each variable in the flow field.

The section for variable range information looks similar to the following:

+--------------------------------------------------------------------+
|                     Variable Range Information                     |
+--------------------------------------------------------------------+
Domain Name : StaticMixer
+--------------------------------------------------------------------+
|      Variable Name                         |    min    |    max    |
+--------------------------------------------------------------------+
| Velocity u                                 | -1.65E+00 |  1.61E+00 |
| Velocity v                                 | -2.26E+00 |  2.25E+00 |
| Velocity w                                 | -4.13E+00 |  2.58E-01 |
| Pressure                                   | -6.71E+02 |  1.38E+04 |
| Density                                    |  9.98E+02 |  9.98E+02 |
| Dynamic Viscosity                          |  1.00E-03 |  1.00E-03 |
| Specific Heat Capacity at Constant Pressure|  4.19E+03 |  4.19E+03 |
| Thermal Conductivity                       |  5.91E-01 |  5.91E-01 |
| Thermal Expansivity                        |  2.10E-04 |  2.10E-04 |
| Eddy Viscosity                             |  1.89E+01 |  1.89E+01 |
| Temperature                                |  2.85E+02 |  3.15E+02 |
| Static Enthalpy                            |  1.19E+06 |  1.32E+06 |
+--------------------------------------------------------------------+
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3.2.1.18. CPU Requirements

The section for CPU requirements looks similar to the following:

 +--------------------------------------------------------------------+
 |           CPU Requirements of Numerical Solution - Total           |
 +--------------------------------------------------------------------+

 Subsystem Name                  Discretization       Linear Solution
                                (secs.   %total)     (secs.   %total) 
 ----------------------------------------------------------------------
 Momentum and Mass              2.50E-01  10.5 %     7.81E-02   3.3 %
                                -------- -------     --------  ------
 Subsystem Summary              2.50E-01  10.5 %     7.81E-02   3.3 %

 Variable Updates               1.25E-01   5.3 %
 File Reading                   1.41E-01   5.9 %
 File Writing                   6.25E-02   2.6 %
 Miscellaneous                  1.72E+00  72.4 %
                                --------
 Total                          2.38E+00

3.2.1.19. Job Information at End of Run

The section for job information looks similar to the following:

 +--------------------------------------------------------------------+
 |                   Job Information at End of Run                    |
 +--------------------------------------------------------------------+
 Job finished:   Wed Jul 29 11:28:47 2020
 Total wall clock time: 8.810E+00 seconds
             or: (          0:         0:         0:     8.810 )
                 (       Days:     Hours:   Minutes:   Seconds )

3.2.2. CFX-Solver Output File (Transient Runs)

For transient runs, the CFX-Solver outputs convergence information for each coefficient iteration.

At the completion of each timestep iteration, the following information is also written to the CFX-
Solver Output file:

• Global conservation statistics

• Calculated wall forces and moments

• Maximum residual statistics

• Average scale information

3.2.2.1. Convergence History

The convergence history for a transient analysis looks similar to the following:

 ======================================================================
 TIME STEP =   2   SIMULATION TIME = 5.00E-01    CPU SECONDS = 2.14E+01
 ----------------------------------------------------------------------
 COEFFICIENT LOOP ITERATION =   1
 ----------------------------------------------------------------------
 |       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
 +----------------------+------+---------+---------+------------------+
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 | U - Mom              |99.99 | 9.6E-01 | 7.7E+00 |       5.8E-04  OK|
 | V - Mom              |99.99 | 2.2E-01 | 2.9E+00 |       2.7E-03  OK|
 | W - Mom              |99.99 | 4.2E-01 | 4.4E+00 |       5.4E-04  OK|
 | P - Mass             |  .12 | 3.0E-03 | 4.0E-02 | 12.0  4.6E-02  OK|
 +----------------------+------+---------+---------+------------------+
 | Smoke                |  .89 | 6.4E-02 | 7.3E-01 |  5.4  5.4E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | K-TurbKE             |  .53 | 2.1E-01 | 5.0E-01 |  5.4  3.9E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | E-Diss.K             |  .73 | 5.2E-01 | 9.5E-01 |  5.4  2.4E-05  OK|
 +----------------------+------+---------+---------+------------------+
 ----------------------------------------------------------------------
 COEFFICIENT LOOP ITERATION =   2                CPU SECONDS = 2.83E+01
 ----------------------------------------------------------------------
 |       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
 +----------------------+------+---------+---------+------------------+
 | U - Mom              |  .14 | 1.4E-01 | 1.3E+00 |       2.0E-03  OK|
 | V - Mom              |  .16 | 3.5E-02 | 4.9E-01 |       8.3E-03  OK|
 | W - Mom              |  .14 | 5.8E-02 | 1.0E+00 |       1.6E-03  OK|
 | P - Mass             |  .65 | 1.9E-03 | 3.7E-02 |  8.3  5.3E-02  OK|
 +----------------------+------+---------+---------+------------------+
 | Smoke                |  .29 | 1.9E-02 | 2.6E-01 |  5.4  5.6E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | K-TurbKE             |  .17 | 3.6E-02 | 2.2E-01 |  5.4  8.2E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | E-Diss.K             |  .16 | 8.3E-02 | 2.4E-01 |  5.4  6.4E-05  OK|
 +----------------------+------+---------+---------+------------------+
 ----------------------------------------------------------------------
 COEFFICIENT LOOP ITERATION =   3                CPU SECONDS = 3.50E+01
 ----------------------------------------------------------------------
 |       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
 +----------------------+------+---------+---------+------------------+
 | U - Mom              |  .24 | 3.3E-02 | 2.8E-01 |       3.8E-03  OK|
 | V - Mom              |  .23 | 8.0E-03 | 1.1E-01 |       1.4E-02  OK|
 | W - Mom              |  .25 | 1.4E-02 | 2.5E-01 |       3.3E-03  OK|
 | P - Mass             |  .68 | 1.3E-03 | 2.0E-02 |  8.3  3.6E-02  OK|
 +----------------------+------+---------+---------+------------------+
 | Smoke                |  .36 | 6.8E-03 | 1.1E-01 |  5.4  6.1E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | K-TurbKE             |  .38 | 1.4E-02 | 1.2E-01 |  5.4  8.7E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | E-Diss.K             |  .39 | 3.3E-02 | 1.2E-01 |  5.4  8.4E-05  OK|
 +----------------------+------+---------+---------+------------------+

If a transient analysis is continued, then the time step counter, simulation time, and CPU seconds
for the current run are enclosed in parenthesis below the totals for the overall analysis, as shown
below.

=======================================================================
 TIME STEP =     3 SIMULATION TIME = 7.50E-01    CPU SECONDS = 2.84E+01
 (THIS RUN:      1                   2.50E-01                  7.00+00)
 ----------------------------------------------------------------------
 COEFFICIENT LOOP ITERATION =   1
 ----------------------------------------------------------------------
 |       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
 +----------------------+------+---------+---------+------------------+
 | U - Mom              |99.99 | 9.6E-01 | 7.7E+00 |       5.8E-04  OK|
 | V - Mom              |99.99 | 2.2E-01 | 2.9E+00 |       2.7E-03  OK|
 | W - Mom              |99.99 | 4.2E-01 | 4.4E+00 |       5.4E-04  OK|
 | P - Mass             |  .12 | 3.0E-03 | 4.0E-02 | 12.0  4.6E-02  OK|
 +----------------------+------+---------+---------+------------------+
 | Smoke                |  .89 | 6.4E-02 | 7.3E-01 |  5.4  5.4E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | K-TurbKE             |  .53 | 2.1E-01 | 5.0E-01 |  5.4  3.9E-05  OK|
 +----------------------+------+---------+---------+------------------+
 | E-Diss.K             |  .73 | 5.2E-01 | 9.5E-01 |  5.4  2.4E-05  OK|
 +----------------------+------+---------+---------+------------------+
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3.2.3. CFX-Solver Output File (Transient Blade Row Runs)

The following sections describe some output that occurs in transient blade row simulations:

3.2.3.1. Post-processing Information

3.2.3.2. Fourier Transformation Information

3.2.3.3. Stability Information (Time Transformation Runs)

3.2.3.1. Post-processing Information

There is a table that indicates, for each domain, the starting and ending time steps for the data
compression algorithm, as well as the fundamental period.

An example of this table follows:

======================================================================
 |          Transient Blade Row Post-processing Information           |
 +--------------------------------------------------------------------+
 |                      |              | Fourier coefficient          |
 | Domain Name:         |  Disturbance | accumulation time step range |
 |                      |  period      |------------------------------+
 |                      |              |     Start    |      End      |
 +----------------------+--------------+--------------+---------------+
 |     R1               |  4.7619E-04  |    6120      |     6179      |
 +--------------------------------------------------------------------+
 |     S2               |  4.0816E-04  |    6120      |     6179      |
 +--------------------------------------------------------------------+

A description of the items in this table follows:

• Domain Name: The name of a domain that accumulates transient blade row data.

• Disturbance period: The fundamental periods (and their harmonics) used for the data compression
algorithm. The period is given in time units as specified by the solution units. For details on
solution units, see Setting the Solution Units in the CFX-Pre User's Guide.

• Start: The time step at which the data compression algorithm starts for the applicable domain.

• End : The time step at which the data compression algorithm ends for the applicable domain.

Note:

If the solver run is stopped before the data compression algorithm finishes for all the
listed domains, no data will be visible in the post-processor.

3.2.3.2. Fourier Transformation Information

For Fourier transformation cases, there is a table that lists information about time steps and coeffi-
cient loops.

An example of this table follows:

 ======================================================================
 |                 Fourier Transformation Information                 |
 ======================================================================
 |                                                                    |
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 +--------------------------------------------------------------------+
 |                             | Max.    |     Time Step Range        |
 |                             | Coeff.  |----------------------------+
 |                             | Loops   |   Start     |      End     |
 |-----------------------------+---------+-------------+--------------+
 | Initialisation Period       |    3    |      41     |      160     |
 ----------------------------------------------------------------------
 | Startup Period              |    3    |     161     |      220     |
 ----------------------------------------------------------------------
 | Full Fourier Transformation |   10    |     221     |      640     |
 ======================================================================

3.2.3.3. Stability Information (Time Transformation Runs)

For time transformation cases, there is a table that lists the acceptable range of pitch ratio for a
stable run.

This pitch ratio is computed as follows:

• For inlet disturbance cases with a stationary passage and a moving signal, the pitch ratio is
computed as the passage pitch divided by the signal pitch.

• For inlet disturbance cases with a moving passage and a stationary signal, the pitch ratio is
computed as the signal pitch divided by the passage pitch.

• For rotor-stator cases, the pitch ratio is computed as the pitch of the stator divided by the pitch
of the rotor.

An example of this table follows:

 ======================================================================
 |                  Time Transformation stability limits              |
 | Pitch ratio computed using stationary/rotating component pitches   |
 +--------------------------------------------------------------------+
 |                                   |           Pitch ratio          |
 | Disturbance name                  |--------------------------------|
 |                                   | Minimum | Maximum |   Current  |
 +--------------------------------------------------------------------+
 | Time Transformation 1             |   0.60  |   1.40  |  1.33 Poor |
 +--------------------------------------------------------------------+
 | Poor: The pitch ratio is close to one of the stability limits.     |
 |       If the solution becomes unstable please do one of the        |
 |       following:                                                   |
 | (1) Modify the number of passages per components to obtain a       |
 |     pitch ratio within the stability limits.                       |
 | (2) For further information on Time Transformation stability       |
 |     limits please consult the Transient Blade Row guide.           |
 +--------------------------------------------------------------------+

3.2.4. CFX-Solver Output File (Interpolation Runs)

This section outlines the additional information that is written to the CFX-Solver Output file for CFX-
Solver jobs that require interpolation.

 ======================================================================
                 Interpolating Onto Domain "Bottom Box"
 ======================================================================

 Total Number of Nodes in the Target Domain              =          343
 Bounding Box Volume of the Target Mesh                  =  2.70000E+01
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 Checking all source domains from the source file:
   Target mesh is different from domain "Top Box".

 Searching for Candidate Source Domains:

 Warning: The target mesh does not intersect with any source meshes 
          that have the same domain type and motion. 
          Skip the interpolation. 

 ======================================================================
                  Interpolating Onto Domain "Top Box"
 ======================================================================

 Total Number of Nodes in the Target Domain              =          343
 Bounding Box Volume of the Target Mesh                  =  2.70000E+01

 Checking all source domains from the source file:
   Target mesh is the same as domain "Top Box".

 Start direct copying of variables from domain "Top Box".

 +--------------------------------------------------------------------+
 |                     Variable Range Information                     |
 +--------------------------------------------------------------------+
 +--------------------------------------------------------------------+
 |      Variable Name                         |    min    |    max    |
 +--------------------------------------------------------------------+
 | Thermal Conductivity                       |  2.61E-02 |  2.61E-02 |
 | Courant Number                             |  9.86E-02 |  4.52E+00 |
 | Density                                    |  1.18E+00 |  1.18E+00 |
 | Static Entropy                             |  0.00E+00 |  0.00E+00 |
 | Pressure                                   |  1.59E+01 |  6.01E+01 |
 | Specific Heat Capacity at Constant Pressure|  1.00E+03 |  1.00E+03 |
 | Specific Heat Capacity at Constant Volume  |  1.00E+03 |  1.00E+03 |
 | Temperature                                |  2.98E+02 |  2.98E+02 |
 | Velocity                                   |  2.02E-01 |  8.09E+00 |
 | Dynamic Viscosity                          |  1.83E-05 |  1.83E-05 |
 +--------------------------------------------------------------------+

3.2.5. CFX-Solver Output File (Parallel Runs)

This section outlines the additional information that is written to the CFX-Solver Output file for CFX-
Solver jobs submitted in parallel.

3.2.5.1. Partitioning Information

If the partitioning step is run, partitioning information pertaining to the current job is displayed.
This includes how the mesh is divided, and CPU requirements for the partitioning process.

The section for partitioning information looks similar to the following:

 +--------------------------------------------------------------------+
 |                     Vertex Based Partitioning                      |
 +--------------------------------------------------------------------+

 Partitioning of domain: Default Domain

 - Partitioning tool:       MeTiS multilevel k-way algorithm
 - Number of partitions:             8
 - Number of graph-nodes:      5232026
 - Number of graph-edges:     56867380
 +--------------------------------------------------------------------+
 |                      Partitioning Information                      |
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 +--------------------------------------------------------------------+

 Partitioning information for domain: Default Domain

        +------------------+------------------------+-----------------+
        |     Elements     |        Vertices        |     Faces       |
 +------+------------------+------------------------+-----------------+
 | Part |   Number     %   |   Number     %   %Ovlp |  Number     %   |
 +------+------------------+------------------------+-----------------+
 | Full |  20584862        |   5232026              |   235752        |
 +------+------------------+------------------------+-----------------+
 |    1 |   2592908   12.5 |    675743   12.6   2.9 |    27947   11.7 |
 |    2 |   2581847   12.4 |    672141   12.5   2.5 |    28030   11.8 |
 |    3 |   2752840   13.2 |    666862   12.4   1.3 |    31200   13.1 |
 |    4 |   2600679   12.5 |    663980   12.4   2.5 |    27997   11.8 |
 |    5 |   2829665   13.6 |    678465   12.7   3.3 |    21784    9.2 |
 |    6 |   2027720    9.7 |    666910   12.5   2.6 |    43374   18.2 |
 |    7 |   2696854   13.0 |    670512   12.5   2.3 |    25832   10.9 |
 |    8 |   2721802   13.1 |    661733   12.4   1.2 |    31858   13.4 |
 +------+------------------+------------------------+-----------------+
 | Min  |   2027720    9.7 |    661733   12.4   1.2 |    21784    9.2 |
 |(part)|           (    6)|           (    8     8)|          (    5)|
 +------+------------------+------------------------+-----------------+
 | Max  |   2829665   13.6 |    678465   12.7   3.3 |    43374   18.2 |
 |(part)|           (    5)|           (    5     5)|          (    6)|
 +------+------------------+------------------------+-----------------+
 | Ave  |   2600539   12.5 |    669543   12.5   2.3 |    29753   12.5 |
 +------+------------------+------------------------+-----------------+
 | Sum  |  20804315  100.0 |   5356346  100.0   2.3 |   238022  100.0 |
 +------+------------------+------------------------+-----------------+

 +--------------------------------------------------------------------+
 |                 Partitioning CPU-Time Requirements                 |
 +--------------------------------------------------------------------+

 - Preparations                                       1.643E+01 seconds
 - Low-level mesh partitioning                        5.711E+00 seconds
 - Global partitioning information                    5.219E-01 seconds
 - Element and face partitioning information          1.142E+00 seconds
 - Vertex partitioning information                    3.639E-01 seconds
 - Partitioning information compression               5.499E-02 seconds
 - Summed CPU-time for mesh partitioning              2.471E+01 seconds

3.2.5.2. Job Information at Start of Run

This section describes the job characteristics in terms of the parallel run mode and the time and
date of the start of the run.

The section for job information for a parallel run looks similar to the following:

 +--------------------------------------------------------------------+
 |                  Job Information at Start of Run                   |
 +--------------------------------------------------------------------+

 Run mode:       parallel run (MPI)

 Job started:    Tue Dec  6 11:23:46 2016

Note:

Occasionally, follower processes may continue to run after the leader process has termin-
ated. More detailed job information, including the host names, process IDs, start time,
finish time and CPU time for each partition, is written to a temporary file named "pids",

73
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Files Generated by the CFX-Solver



which exists during the lifetime of the run. If the run terminates successfully, this inform-
ation is written to the results file and may be read using the command "cfx5dfile
-read-parinfo".

Note:

The above format is the default output format. A more verbose format, as used in earlier
releases of Ansys CFX, is available. For details, see Command-Line Options and Keywords
for cfx5solve (p. 158).

3.2.5.3. Host Memory Information

The initial memory allocated on each host is reported near the start of the run, similar to the fol-
lowing:

 +--------------------------------------------------------------------+
 |                  Host Memory Information (Mbytes): Solver          |
 +--------------------------------------------------------------------+
 |           Host         | Npart |   System    |  Allocated  |   %   |
 +------------------------+-------+-------------+-------------+-------+
 | fastcomputer1          |   32  |    32307.24 |     9280.91 | 28.73 |
 | fastcomputer2          |   32  |    32307.24 |     9195.09 | 28.46 |
 | fastcomputer3          |   32  |    32307.24 |     9713.21 | 30.07 |
 | fastcomputer4          |   32  |    32307.24 |     9409.84 | 29.13 |
 +------------------------+-------+-------------+-------------+-------+
 | Total                  |  128  |   129228.97 |    37599.05 | 29.09 |
 +------------------------+-------+-------------+-------------+-------+

Similarly, the peak memory usage for each host over the lifetime of the run is reported near the
end of the run. For example:

 +--------------------------------------------------------------------+
 |            Host Memory Information (Mbytes): Solver                |
 +--------------------------------------------------------------------+
 |           Host         | Npart |   System    |    Peak     |   %   |
 +------------------------+-------+-------------+-------------+-------+
 | fastcomputer1          |   32  |    32307.24 |    10673.05 | 33.04 |
 | fastcomputer2          |   32  |    32307.24 |    10574.35 | 32.73 |
 | fastcomputer3          |   32  |    32307.24 |    11170.19 | 34.57 |
 | fastcomputer4          |   32  |    32307.24 |    10821.32 | 33.50 |
 +------------------------+-------+-------------+-------------+-------+
 | Total                  |  128  |   129228.97 |    43238.91 | 33.46 |
 +------------------------+-------+-------------+-------------+-------+

3.2.5.4. Memory Usage Information

The default output format produces a section for memory usage information that looks similar to
the following:

 +--------------------------------------------------------------------+ 
 |         Initial Memory Allocation  (Actual usage may vary)         | 
 +--------------------------------------------------------------------+ 
 Allocated storage in:   Mwords
                         Mbytes 
 Partition | Real       | Integer    | Character | Logical  | Double 
 ----------+------------+------------+-----------+----------+----------
   Minimum |       8.88 |       1.74 |      3.70 |     0.12 |     0.09 
  (     4) |      33.86 |       6.65 |      3.53 |     0.11 |     0.69 
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 ----------+------------+------------+-----------+----------+---------- 
   Maximum |       8.90 |       1.75 |      3.70 |     0.12 |     0.09 
  (     1) |      33.96 |       6.68 |      3.53 |     0.11 |     0.69
 ----------+------------+------------+-----------+----------+---------- 
   Average |       8.89 |       1.75 |      3.70 |     0.12 |     0.09 
           |      33.89 |       6.66 |      3.53 |     0.11 |     0.69 
 ----------+------------+------------+-----------+----------+---------- 
     Total |      35.54 |       6.99 |     14.81 |     0.48 |     0.36 
           |     135.58 |      26.65 |     14.12 |     0.46 |     2.76
 ----------+------------+------------+-----------+----------+----------

3.2.5.5. Job Information at End of Run

The section for completed job information looks similar to the following:

 +--------------------------------------------------------------------+
 |                   Job Information at End of Run                    |
 +--------------------------------------------------------------------+

 Job finished:   Tue Dec  3 11:23:56 2013

 Total wall clock time: 9.630E+00 seconds
             or: (          0:         0:         0:     9.630 )
                 (       Days:     Hours:   Minutes:   Seconds )

--> Final synchronization point reached by all partitions.
End of solution stage.

+--------------------------------------------------------------------+
| The results from this run of the CFX-Solver have been written      |
| to z:\temp\BluntBody_001.res                                       |
+--------------------------------------------------------------------+

Note:

The above format is the default output format. A more verbose format, as used in earlier
releases of Ansys CFX is available. For details, see Command-Line Options and Keywords
for cfx5solve (p. 158).

3.2.6. CFX-Solver Output File (Mesh Adaption Runs)

When a mesh adaption step is complete, the CFX-Solver Manager reports the new meshing information,
including the total number of vertices, elements and faces. The CFX-Solver then continues to determine
a solution, using the adapted mesh.

The section for mesh refinement looks similar to the following:

+--------------------------------------------------------------------+
|                                                                    |
|                         Mesh Refinement                            |
|                                                                    |
+--------------------------------------------------------------------+
Adaption step 2 of 3.
Number of elements initially marked for refinement:         480
Number of elements removed because:
 They already meet the minimum length criteria:               0
 They are in regions not marked for refinement:               0
 They are already in the deepest refinement level:            0
 There are not enough nodes available to refine them:      -425
                                                     ----------
                                                             55
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                                                     ----------
Target number of nodes at end of step:                     1512
Number of vertices in the final mesh:                      1999
Number of elements in the final mesh:                      1560
+--------------------------------------------------------------------+
|         Total number of Vertices, Elements, and Faces              |
+--------------------------------------------------------------------+
Domain Name      : nozzle vmi
     Total Number of Nodes                  =       1999
     Total Number of Elements               =       1560
         Total Number of Tetrahedrons       =        146
         Total Number of Hexahedrons        =        818
         Total Number of Pyramids           =        596
     Total number of Faces                  =       1702

3.2.7. CFX-Solver Output File (Remeshing Runs)

Each time a run is terminated or interrupted, all remeshing definitions associated with that run are
considered for activation. If any definitions are active, then output similar to the following is generated:

 +--------------------------------------------------------------------+
 |                                                                    |
 |                             Remeshing                              |
 |                                                                    |
 +--------------------------------------------------------------------+

 Remesh Object: Remesh
   Activated by condition: Number of TimeSteps

   Executing remesh command:
      C:\Program Files\ANSYS
      Inc\v110\icemcfd\win64_amd\bin\icemcfd.bat -batch -script
      d:\builds\v120\CFX\etc\Remeshing\icemcfd_Remesh.rpl

 CFX Solver Results generated before remeshing have been written to:
   d:\ICEMRemesh\ballvalve1_001\5_oldmesh.res

 Text output generated during remeshing has been written to:
   d:\ICEMRemesh\ballvalve1_001\5_remesh.out

Each active remesh object is listed, along with the name of the solver interrupt condition(s) that ac-
tivated it, and the command used to generate the new mesh. Any output generated during remeshing
is redirected into a text file, which, along with the CFX-Solver Results file from the previous run, is
placed into the final results directory for the run. The locations of these files is listed in the output.

Once the updated meshes have been generated, CFX-Pre loads the CFX-Solver Results file from the
previous run, replaces the old meshes with the updated ones, and writes a new CFX-Solver Input file.

A CFX-Solver run is then started with the new CFX-Solver Input file, using the CFX-Solver Results file
from the previous run for initial values. Partitioning is also performed for parallel run modes.

3.2.8. CFX-Solver Output File (Conjugate Heat Transfer Runs)

3.2.8.1. Thermal Energy Flow Through a Solid Boundary

When a solid domain is included, CFX-Solver Manager reports the thermal energy that flows into
and out of the solid, across existing boundaries. If the solid has a source term, the total thermal
energy added is included in the CFX-Solver Output file.
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The section for thermal energy at a solid boundary looks similar to the following:

+--------------------------------------------------------------------+
|         Boundary T-Energy - 2 Flow and Total Source Term Summary   |
+--------------------------------------------------------------------+
Boundary   : Default Solid               0.0000E+00
Boundary   : Default Fluid Solid2       -3.0742E+06
Subdomain  : heater                      3.0685E+06
                                         -----------
Global T-Energy - 2 Balance:            -5.6725E+03

3.2.8.2.Thermal Energy Flow Between the Fluid and Solid within a Porous Domain

When a solid in a porous domain is included, CFX-Solver Manager reports the thermal energy that
flows between the fluid and the solid (Domain Src (Neg) in the sample below), and from the
solid into and out of existing boundaries (Boundary in the sample below). If the solid has a source
term, the total thermal energy (Sub-Domain in the sample below) that is added is included in the
CFX-Solver Output file.

The section for thermal energy for a solid in a porous domain looks similar to the following:

+--------------------------------------------------------------------+
|         Boundary T-Energy - 2 Flow and Total Source Term Summary   |
+--------------------------------------------------------------------+
Boundary         : Default Solid                          -4.9569E+00
Boundary         : Default Fluid Solid2                   -3.4767E+00
Domain Src (Neg) : Porous                                 -1.3999E+00
Domain Src (Pos) : Porous                                  5.8335E+00
Sub-Domain       : Porous Subdomain 1                      4.0001E+00
                                                          -----------
Domain Imbalance :                                         5.1498E-05

3.2.9. CFX-Solver Output File (GGI Runs)

Running the CFX Flow Solver for cases that include GGI interfaces is similar to cases without GGI
connections. The following differences, however, will be observed:

• At the start of the simulation, all GGI connection conditions are processed. This may require the
computational effort of the order of a single iteration or timestep of the flow simulation. If a GGI
connection condition is found to contain non-overlapping portions, the percentage of the area of
each side that is non-overlapping is reported. This is a useful diagnostic, and should be reviewed
to confirm that the expected amount of non-overlapping area has been detected.

+--------------------------------------------------------------------+
|             Total Number of Nodes, Elements, and Faces             |
+--------------------------------------------------------------------+
Domain Name : rotor
     Total Number of Nodes                                =       38360
     Total Number of Elements                             =       33202
         Total Number of Hexahedrons                      =       33202
     Total Number of Faces                                =        9970
 Domain Name : stator
     Total Number of Nodes                                =       33320
     Total Number of Elements                             =      106660
         Total Number of Tetrahedrons                     =       75265
         Total Number of Prisms                           =       31395
     Total Number of Faces                                =       17871
 Domain Interface Name : Rotor Periodic
     Non-overlap area fraction on side 1                  =       0.0 %
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     Non-overlap area fraction on side 2                  =       0.0 %
 Domain Interface Name : Stator Periodic
     Non-overlap area fraction on side 1                  =       0.0 %
     Non-overlap area fraction on side 2                  =       0.0 %

• Residual diagnostics will be reported for each set of connected domains having the same physical
type. For example, the mass and momentum equation residuals will be reported independently
for each flow passage.

======================================================================
OUTER LOOP ITERATION =   35                     CPU SECONDS = 4.64E+03
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
| U-Mom-rotor          | 0.92 | 2.2E-05 | 3.6E-04 |                  |
| V-Mom-rotor          | 0.90 | 3.6E-05 | 1.0E-03 |                  |
| W-Mom-rotor          | 0.91 | 4.1E-05 | 9.1E-04 |                  |
| P-Mass-rotor         | 0.94 | 1.2E-05 | 4.7E-04 |                  |
| U-Mom-stator         | 0.89 | 2.1E-05 | 1.1E-03 |       1.3E-02  OK|
| V-Mom-stator         | 0.84 | 9.9E-05 | 3.1E-03 |       3.1E-02  OK|
| W-Mom-stator         | 0.86 | 7.4E-05 | 3.8E-03 |       2.6E-02  OK|
| P-Mass-stator        | 0.89 | 1.4E-05 | 3.8E-04 | 10.0  6.6E-02  OK|
+----------------------+------+---------+---------+------------------+
| H-Energy-rotor       | 0.92 | 7.7E-06 | 2.5E-04 |                  |
| H-Energy-stator      | 0.88 | 5.4E-06 | 1.7E-04 |  6.1  5.4E-02  OK|
+----------------------+------+---------+---------+------------------+
| K-TurbKE-rotor       | 1.62 | 1.2E-04 | 5.7E-03 |                  |
| K-TurbKE-stator      | 0.86 | 1.1E-04 | 3.5E-03 |  6.1  9.7E-02  OK|
+----------------------+------+---------+---------+------------------+
| E-Diss.K-rotor       | 2.52 | 4.0E-04 | 1.6E-02 |                  |
| E-Diss.K-stator      | 0.87 | 1.8E-04 | 4.9E-03 |  7.5  1.5E-03  OK|
+----------------------+------+---------+---------+------------------

• Flows across GGI interfaces will be reported in flow summary diagnostics. Changes in GGI flows
will occur in various situations. For example, momentum flows change as they undergo rotation
at rotational periodic GGI connections. All transport equation flows, including the mass equation,
change for the case of pitch change at a frame change GGI connection, as well as the energy
equation flows as conservation changes from absolute frame to relative frame energy components.
Forces are also reported in the momentum flow balances at contiguous and periodic GGI connections,
for cases having non-overlapping portions of the interface.

• Various quantities such as ranges of dependent variables, locations of maximum residuals, and so
on, are reported at the end of the simulation on a per-domain basis.

+--------------------------------------------------------------------+
|                   Locations of Maximum Residuals                   |
+--------------------------------------------------------------------+
|       Equation       |  Node # |     X     |     Y     |     Z     |
+--------------------------------------------------------------------+
| U-Mom-rotor          |    5109 | 3.849E-01 | 4.761E-02 | 1.572E-01 |
| V-Mom-rotor          |    4501 | 3.846E-01 | 5.065E-02 | 1.176E-01 |
| W-Mom-rotor          |    3085 | 3.802E-01 | 5.029E-02 | 1.177E-01 |
| P-Mass-rotor         |    3642 | 3.799E-01 | 5.260E-02 | 1.572E-01 |
| U-Mom-stator         |   32356 | 4.535E-01 | 5.403E-02 | 5.000E-02 |
| V-Mom-stator         |     496 | 4.541E-01 | 5.343E-02 | 4.939E-02 |
| W-Mom-stator         |     496 | 4.541E-01 | 5.343E-02 | 4.939E-02 |
| P-Mass-stator        |    2275 | 4.536E-01 | 5.349E-02 | 4.949E-02 |
| H-Energy-rotor       |   18527 | 4.535E-01 | 5.694E-02 | 5.263E-02 |
| H-Energy-stator      |     498 | 4.541E-01 | 5.352E-02 | 4.961E-02 |
| K-TurbKE-rotor       |    8583 | 4.110E-01 | 4.671E-02 | 5.692E-02 |
| E-Diss.K-rotor       |    8598 | 4.109E-01 | 4.667E-02 | 5.719E-02 |
| K-TurbKE-stator      |    7264 | 4.540E-01 | 5.358E-02 | 4.959E-02 |
| E-Diss.K-stator      |    7264 | 4.540E-01 | 5.358E-02 | 4.959E-02 |
+--------------------------------------------------------------------+
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3.2.10. CFX-Solver Output File (Combustion Runs)

Running a combustion simulation in the CFX-Solver is similar to multicomponent fluid runs with the
extensions explained in the following.

3.2.10.1. Multicomponent Specific Enthalpy Diffusion (MCF)

This applies also to non-reacting multicomponent flow. For multicomponent fluids with heat
transfer, the diffusion term assembly modes are reported for the molecular and the turbulent diffu-
sion, respectively. The option for each part may be either generic assembly or unity Lewis number
assumption,

+--------------------------------------------------------------------+
|            Multi-Component Specific Enthalpy Diffusion             |
+--------------------------------------------------------------------+

Enthalpy equation assembly for secondary terms derived from multi-
component species transport.  Molecular and turbulent transport may
use either Unity Lewis Number (Le=1) assumption or generic assembly.

Domain Name : Default Domain
    Mixture                                   (Le_mol=gen, Le_trb=1  )

3.2.10.2. Single Step Reactions Heat Release

For single step reactions the heat release per chemical amount of reaction is reported. Numbers
are in solver units. Positive numbers indicate exothermic reactions (heat is released) and negative
numbers indicate endothermic reactions (energy required for the reaction to occur). The total heat
release in the domain resulting from a particular reaction can be computed by multiplying the re-
actions heat release by its molar reaction rate and integrating over the domain.

+--------------------------------------------------------------------+
|                 Single Step Reactions Heat Release                 |
+--------------------------------------------------------------------+
Enthalpy per [mol] of reaction at reference conditions
(Pressure= 1.01325E+05, Temperature= 2.98150E+02)
    HCO Oxygen                                           =  5.5799E+05
    HCN NO Destruction PDF                               =  1.8194E+05
    HCN NO Formation PDF                                 =  1.3458E+03
    Reburn NO Fuel Gas PDF                               =  2.7885E+05
    Prompt NO Fuel Gas PDF                               = -9.0298E+04
    Thermal NO PDF                                       = -1.8060E+05
    Fuel Gas Oxygen                                      =  5.1127E+05

3.2.10.3. Stoichiometric Mixture Fraction

The stoichiometric mixture fraction is reported when a Flamelet model or Burning Velocity
model is used. If the stoichiometric mixture fraction is not specified in the definition of the
Flamelet library reaction object, the stoichiometric value is reported as <unknown>.

+--------------------------------------------------------------------+
|                  Stoichiometric Mixture Fraction                   |
+--------------------------------------------------------------------+
Stoichiometric mixture fraction (Zst) for fluids with mixture
fraction combustion models.
Domain Name : run
    Mixture                                           Zst = 5.5000E-02
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3.2.10.4. Hydrocarbon Fuel Model: Proximate / Ultimate Analysis

For the hydrocarbon fuel model (the Hydrocarbon Fuel option for the Material setting) the
results of the proximate/ultimate analysis calculation are reported:

• The initial composition of the particles (component mass fractions). These values will be applied
when no user-specified initial particle composition is specified (default).

• Molar mass and reference specific enthalpy for the Volatiles material that is released to the
gas phase. The values reported here by default overrule the data specified in the corresponding
material object.

• For single step reactions the relative stoichiometric coefficients, which are derived from the fuel
analysis, are reported. These values are applied when the Fuel Analysis option is specified
in the reaction for the corresponding reactant or product.

• For multiphase reactions the relative mass coefficients, which are derived from the fuel analysis,
are reported. These values are applied when the Fuel Analysis option is specified in the
reaction for the corresponding reactant or product.

======================================================================
                  HC Fuel Proximate/Ultimate Analysis
======================================================================
Initial mass fractions for particle : HC Fuel
    Ash                                                  =  1.2580E-01
    Char                                                 =  0.0000E+00
    Raw Combustible                                      =  8.7420E-01
Volatiles material properties : Fuel Gas
    Molar Mass [kg/kmol]                                 =      18.234
    Ref. Spec. Enthalpy (p= 1.01325E+05, T= 2.98150E+02) = -7.1827E+06
+--------------------------------------------------------------------+
|              Autocomputed Stoichiometric Coefficients              |
+--------------------------------------------------------------------+
Reaction (volatiles oxidation) : Fuel Gas Oxygen
  Reactants:
    Fuel Gas                                             =  1.0000E+00
    O2                                                   =  1.3558E+00
  Products:
    CO2                                                  =  9.3953E-01
    H2O                                                  =  1.1267E+00
Reaction (NO reburn) : Reburn NO Fuel Gas PDF
  Reactants:
    Fuel Gas                                             =  3.6879E-01
    NO                                                   =  1.0000E+00
  Products:
    CO2                                                  =  3.4648E-01
    H2O                                                  =  4.1552E-01
    N2                                                   =  5.0000E-01
+--------------------------------------------------------------------+
|                   Autocomputed Mass Coefficients                   |
+--------------------------------------------------------------------+
Reaction (devolatilisation) : HC Fuel Devolat HCN
  Reactants:
    HC Fuel.Raw Combustible                              =  1.0000E+00
  Products:
    Gas Mixture HCN NO.Fuel Gas                          =  5.0003E-01
    Gas Mixture HCN NO.HCN                               =  1.1857E-02
    HC Fuel.Char                                         =  4.8812E-01
Reaction (char oxidation) : HC Fuel Char Gibb HCN
  Reactants:
    Gas Mixture HCN NO.O2                                =  2.6049E+00
    HC Fuel.Char                                         =  1.0000E+00
  Products:
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    Gas Mixture HCN NO.CO2                               =  3.5817E+00
    Gas Mixture HCN NO.HCN                               =  2.3164E-02

3.2.11. CFX-Solver Output File (Particle Runs)

3.2.11.1. Particle Transport Equations

This section lists the particle transport equations solved during the solver run for each independent
domain.

 +--------------------------------------------------------------------+
 |      Particle Transport Equations Solved in This Calculation       |
 +--------------------------------------------------------------------+
Domain Type : Default Domain
   x-Mom-Sand Fully Coupled
   y-Mom-Sand Fully Coupled
   z-Mom-Sand Fully Coupled
   x-Mom-Sand One Way Coupled
   y-Mom-Sand One Way Coupled
   z-Mom-Sand One Way Coupled

For additional information, see Solved Equations (p. 58).

3.2.11.2. Particle Fate Diagnostics

Within the particle transport model, each particle is tracked until one of the abort criteria is satisfied
or the particle escapes the domain. Particles may also be aborted if a tracking error is found. Because
each particle is tracked from its injection point until some abort criteria is met, it does not influence
other particles. Thus, a tracking error for one particle does not necessarily stop the execution of
the CFX-Solver run. However, if some fundamental problem is found during tracking, then the flow
calculations terminates after printing an error message.

At the end of each particle integration step, a diagnostic summary is generated that indicates the
fate of all injected particles as outlined below:

 +--------------------------------------------------------------------+
 |                      Particle Fate Diagnostics                     |
 +--------------------------------------------------------------------+
 | Particle type          | Fate type                       Particles |
 +--------------------------------------------------------------------+
 | Sand Fully Coupled     | Entered domain                :       200 |
 |                        | Left domain                   :       200 |
 +--------------------------------------------------------------------+

The following fate types may be encountered during particle tracking:

3.2.11.2.1. Absorbed by Porous Media

This message indicates the number of particle that have been absorbed by the porous media
and is determined by the Absorption Diameter setting. For details, see Particle Absorption in
the CFX-Pre User's Guide.

3.2.11.2.2. Continue from Last Time Step (Transient Only)

See Waiting for Next Time Step (Transient only) (p. 83).

81
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Files Generated by the CFX-Solver



3.2.11.2.3. Collected on Walls

This message indicates that particles are trapped at the wall because both the parallel and per-
pendicular restitution coefficients are zero. As a result, the particle tracking is terminated and the
remaining momentum of the particles is transferred to the wall as a force. For details, see Resti-
tution Coefficients for Particles in the CFX-Solver Modeling Guide.

3.2.11.2.4. Entered Domain

This message indicates the number of particles that were injected into the domain either at a
boundary or particle injection region.

3.2.11.2.5. Exceeded Distance Limit

This message indicates that these particles have exceeded the maximum tracking distance with
respect to the particle traveling distance. If a large number of particles show this fate, you may
need to increase the maximum tracking distance. For details, see Maximum Tracking Distance.
Any remaining mass, momentum, and energy that must be exchanged with the fluid to equilibrate
the aborted particle with the local fluid properties, is exchanged in the current control volume.

3.2.11.2.6. Exceeded Integration Limit

This message indicates that these particles have exceeded the maximum number of integration
steps with respect to the total number of particle integration steps. If a large number of particles
show this fate, you may need to increase the maximum number of integration steps. For details,
see Maximum Number of Integration Steps. Any remaining mass, momentum, and energy that
must be exchanged with the fluid to equilibrate the aborted particle with the local fluid properties,
is exchanged in the current control volume.

3.2.11.2.7. Exceeded Time Limit

This message indicates that these particles have exceeded the maximum tracking time with respect
to the particle traveling time. If a large number of particles show this fate, you may need to in-
crease the maximum tracking time. For details, see Maximum Tracking Time. Any remaining mass,
momentum, and energy that must be exchanged with the fluid to equilibrate the aborted particle
with the local fluid properties, is exchanged in the current control volume.

3.2.11.2.8. Fell Below Minimum Diameter

This message indicates that evaporating or reacting particles are not tracked below a diameter
of 1.0E-8 [m] because they are too small to have any effect. The minimum diameter can be con-
trolled by expert parameter pt minimum diameter, see Particle Tracking Parameters.

3.2.11.2.9. Integration Error

This message indicates that the tracking of these particles was terminated due to an unexpected
error in the particle tracking integration. If a small number of particles terminate in this way, it
is not generally a cause for concern. Any remaining mass, momentum, and energy of the particle
is neglected.
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3.2.11.2.10. Left Domain

This message indicates the number of particles that have escaped from the domain and are no
longer tracked. Any remaining particle mass, momentum and energy also escapes the domain
with particles. This is the normal abort criterion for particles traveling through inlets, openings,
and outlets.

3.2.11.2.11. Sliding along Walls

This message indicates that particles have stopped as they were hitting the wall below the min-
imum specified impact angle. For details, see Fluid Values for Walls in the CFX-Pre User's Guide.

3.2.11.2.12. Waiting for Next Time Step (Transient only)

All particles that are alive at the end of a fluid time step get the fate Waiting for Next
Time Step. When the next fluid time step is performed, then these particles are continued to
be tracked and their fate is changed to Continue from Last Time Step. So across two
time steps, both numbers should be the same.

3.2.11.3. Transient Particle Diagnostics

The transient particle diagnostics enable you to monitor various quantities, like total mass of particles
in the domain, penetration of particles from a given PIR (Particle Injection Region), or user-defined
location. For details, see Transient Particle Diagnostics in the CFX-Solver Modeling Guide. A typical
diagnostics output that is recorded in the CFX-Solver Output file is shown below:

 +--------------------------------------------------------------------+
 |                   Transient Particle Diagnostics                   |
 +--------------------------------------------------------------------+

 Water Droplets

  Total Particle Mass
     Total Particle Mass                       2.0000E-02
  Penetration from PIR
     Axial Penetration                         1.7655E-01
     Radial Penetration                        1.8561E-01
     Normal Penetration                        6.6197E-02
     Spray Angle                               1.9856E+01
  Penetration from Location
     Axial Penetration                         1.7655E-01
     Radial Penetration                        1.8561E-01
     Normal Penetration                        6.6197E-02
     Spray Angle                               4.1836E+01

3.2.11.4. Particle Convergence History

Coupled particles are solved several times during the simulation and each particle tracking step
leads to updated sources for the transport equations of the coupled continuous phase. A convergence
criterion for the particle solver is the relative change of the generated sources of two successive
particle tracking steps. Therefore, a table containing summary of all coupled particle equations,
separately listed for each particle type, is generated at the end of each particle tracking step. This
table contains the information on integrated sources as well as the source change rate as outlined
below.

 +--------------------------------------------------------------------+
 |   Particle Equation    |  Total source and source change rates     |
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 +--------------------------------------------------------------------+
 |                        | Equation            Source      Rate      |
 +--------------------------------------------------------------------+
 | Domain: PipeValve                                                  |
 +--------------------------------------------------------------------+
 | Sand Fully Coupled     | x-Mom               4.016E-02   0.0085    |
 |                        | y-Mom               7.765E-02   0.0062    |
 |                        | z-Mom               1.261E-01   0.0035    |
 +--------------------------------------------------------------------+

The Source column refers to the new particle source to the  equation, which is calculated as
the sum over all vertices of the absolute particle source values to that equation. For details, see
Particle Source Change Target and Particle Under-Relaxation Factors in the CFX-Solver Modeling
Guide.

The Rate column shows the fractional change in the source between the current and the previous
injection. The source change rate can also be graphically monitored in the CFX-Solver Manager.

For additional information, see Convergence Control for Particle Transport in the CFX-Solver Modeling
Guide.

3.2.11.5. Integrated Particle Flows

At the end of a run, the integrated particle mass, momentum and energy flows over all boundaries
and at all particle injection regions are printed to the CFX-Solver Output file. If the expert parameter
MONITOR TOTALS is set to T, the same information is printed at the end of each particle tracking
step. In a transient run, the time integrated total particle flows are also listed at the end of a run.

3.2.11.6. CPU Requirements of Numerical Solution

At the end of the run, a summary of the CPU time spent inside of the particle tracking routine is
given as outlined in the table below. This information may be used to determine the time spent
per particle.

+--------------------------------------------------------------------+
|               CPU Requirements of Numerical Solution               |
+--------------------------------------------------------------------+

 Subsystem Name                  Discretization       Linear Solution
                                (secs.   %total)     (secs.   %total) 
 ----------------------------------------------------------------------
 Momentum and Mass              1.00E+02  48.2 %     1.79E+01   8.6 %
 TurbKE and Diss.K              3.46E+01  16.6 %     2.17E+01  10.4 %
                                -------- -------     --------  ------
 Subsystem Summary              1.35E+02  64.9 %     3.96E+01  19.1 %

 Particle Tracking              2.18E+01   10.5 %
 Variable Updates               5.91E+00    2.8 %
 File Reading                   6.25E-02    0.0 %
 Miscellaneous                  5.72E+00    2.7 %
                                --------
 Total                          2.08E+02
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3.2.12. CFX-Solver Output File (Radiation Runs)

3.2.12.1. Convergence History

When the Thermal Radiation P1, Discrete Transfer, or Monte Carlo model has
been selected, a new variable, I-Radiation, is computed.

3.2.12.1.1. P1 Model

======================================================================
OUTER LOOP ITERATION =    1                     CPU SECONDS = 3.67E+01
----------------------------------------------------------------------
|       Equation       | Rate | RMS Res | Max Res |  Linear Solution |
+----------------------+------+---------+---------+------------------+
...
+----------------------+------+---------+---------+------------------+
| I-Radiation          | 0.00 | 3.6E-08 | 4.6E-07 |  5.2  3.5E-02  OK|
+----------------------+------+---------+---------+------------------+

3.2.12.1.2. Discrete Transfer Model

I-Radiation data is output every nth iteration, where n is specified by an Iteration In
terval parameter (which can be set in Solver Control > Advanced Options > Thermal Radi-
ation Control in CFX-Pre). The row containing this data has its own column headings, which
override the table headings just for the row. The column headings are:

• #Its is the number of iterations required to obtain a converged radiation solution to within
a specified tolerance. This number is usually 1 unless there are reflective boundaries (emissivity
less than 1). The default maximum number of iterations and tolerances are 10, and 0.01 respect-
ively. These values can be set in Solver Control > Advanced Options > Thermal Radiation
Control > Ray Tracing.

• Vol Chg is the maximum normalized change in volumetric absorbed radiation at convergence.

• Sur Chg is the maximum normalized change in surface absorbed radiation at convergence.

• %Lost is the percentage of ray traces lost due to tracking errors, or non-overlap boundaries
at domain interfaces. Values greater than 5% are an indication of a setup error.

• %Imbal is the percentage imbalance of radiative energy. This value should be 0 or a small
value. Otherwise, the results are not reliable.

+----------------------+------+---------+---------+------------------+
| I-Radiation          | #Its | Vol Chg | Sur Chg | %Lost  %Imbal    |
|   Gray               |    1 | 0.0E+00 | 0.0E+00 |  0.38    1.94    |
+----------------------+------+---------+---------+------------------+

This variable is also included in the Locations of Maximum Residuals and Peak Values
of Residuals tables that appear in the CFX-Solver Output file.

3.2.12.1.3. Monte Carlo Model

I-Radiation data is output every nth iteration, where n is specified by an Iteration In
terval parameter (which can be set in the Solver Control in CFX-Pre on the Advanced Options
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tab). The row containing this data has its own column headings, which override the table headings
just for the row. The column headings are:

• %SD Sur is the maximum normalized standard deviation of the irradiation flux at an element
face on a boundary (Wall Irradiation Flux.Normalized Std Deviation). The
presence of values greater than 30% indicates that the value of Number of Histories is too
small to resolve the radiation field. The presence of small isolated boundary regions with values
of Wall Irradiation Flux.Normalized Std Deviation larger than 30% is an in-
dication that the element faces in those regions were insufficiently sampled.

• %SD Vol is the maximum normalized standard deviation of the radiation intensity within a
finite element (Radiation Intensity.Normalized Std Deviation). Similar to %SD
Sur, the values of Radiation Intensity.Normalized Std Deviation are expected
to be less than 30%.

• %Lost is the percentage of histories lost due to tracking errors or non-overlap boundaries at
domain interfaces. Values greater than 5% are indication of a setup error.

• %Imbal is the percentage imbalance of radiative energy. This value should be 0 or a small
value. Otherwise, the results are not reliable.

+----------------------+------+---------+---------+------------------+
| I-Radiation          |      | %SD Sur | %SD Vol | %Lost  %Imbal    |
|   Full Spectrum      |      | 4.6E+01 | 1.0E+02 |  0.00    0.00    |
+----------------------+------+---------+---------+------------------+

The Variable Range Information table has the output variable Radiation Intensity
listed.

3.2.12.2. Summary Fluxes

• It should be noticed that for heat flux specified boundaries (adiabatic, for example) the specified
heat flux can verified by adding  to the boundary flow in the H-Energy flow summary.

(3.3)

• An I-Radiation section is included...

 +--------------------------------------------------------------------+
 |                            I-Radiation                             |
 +--------------------------------------------------------------------+
 Boundary         : Airin                                  -1.5659E+03
 Boundary         : Combustor Default                      -3.5729E+02
 Boundary         : Downcomer Wall                         -5.1864E+02
 Boundary         : Fuelin                                 -1.0076E+03
 Boundary         : Outlet                                  1.6636E+01
 Domain           : Combustor                               5.2454E+03
 Domain Interface : Domain Interface 1                      5.3004E-01
 Domain Interface : Domain Interface 2                     -5.2638E+00
 Domain Interface : LowerGGI                               -1.9895E-01
 Domain Interface : Periodic                                1.1727E+01
 Domain Interface : UpperGGI                                1.6994E-01
                                                           -----------
 Domain Imbalance :                                         1.8195E+03

The I-Radiation imbalances reported in the CFX-Solver Output file represent the global heat flow
imbalances due to radiation for all domains. Flows through domain interfaces are not included,
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therefore when radiation occurs in more than one connected domain the imbalance in any indi-
vidual domain will be non-zero in general. However, the final Global Imbalance reported in the
CFX-Solver Output file should be close to zero, indicating the convergence of a solution.

When plotting the domain-based I-Radiation imbalances for multi-domain radiation cases you
should expect a non-zero value in a converged solution as noted above. The plotted domain
imbalances are normalized by the magnitude of the largest flux in that domain, therefore it is
not valid to sum the normalized imbalances across domains to obtain the global value.

When the Rosseland model is selected:

• No additional equation is solved. Hence, no thermal radiation flow summary will be available.

• The total heat flux is reported by the H-Energy flow summary.

(3.4)

• The CPU Requirements of Numerical Solution table reports the amount of CPU time spent due
to the use of a thermal radiation model.

3.2.13. CFX-Solver Output File (Rigid Body Runs)

For runs involving Rigid Body modeling, the CFX-Solver outputs convergence information at regular
intervals according to the update frequency specified in the Solver Control details view on the Rigid
Body Control tab in CFX-Pre.

 ----------------------------------------------------------------------
 COEFFICIENT LOOP ITERATION =    5              CPU SECONDS = 1.461E+01
 ----------------------------------------------------------------------
 |                       Rigid Body Convergence                       |
 +--------------------------------------------------------------------+
 |                        | Quantity             Change       Rate    |
 +--------------------------------------------------------------------+
 | rigidBody1             | Motion              1.783E-01     0.26    |
 |                        | Force               7.343E-01     1.04    |
 +--------------------------------------------------------------------+

3.2.14. CFX-Solver Results File

The CFX-Solver results file is generated by the CFX-Solver and contains a full description of the flow
simulation including:

• Volume mesh

• Flow solution

The CFX-Solver will generate a results file with a name based on the CFX-Solver input file. For example,
running the CFX-Solver using the input file named file.mdef in a clean working directory will
generate a results file named file_001.res. Given a clean working directory, the CFX-Solver will
generate a results file with a name based on the CFX-Solver input file. This results file contains the
calculated solution values at each mesh node in addition to the original information contained in the
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CFX-Solver input file. The integer index is incremented each time subsequent simulations are executed
in the working directory from the same CFX-Solver input file.

Note:

CFX-Solver input files must not contain spaces when run with an associated Ansys input
file (inp).

In CFX, there are two additional types of files that may contain results: transient results and backup
files. All backup and transient files are placed in a subdirectory beneath the working directory that
is named according to the results file. For example, if the working directory contains the results file
file_001.res, then backup and transient results files are placed in the subdirectory named
file_001. Backup and transient files all have names with extension .bak and .trn, respectively.
For details on how to create these results files in CFX-Pre, see Backup Tab in the CFX-Pre User's Guide
and Transient Results Tab in the CFX-Pre User's Guide. For details on how to create backup results files
while the run is executing, see Backup Run Command (p. 131). Note that transient results files are only
created during transient simulations.

The naming convention for each backup and transient results file is outlined as follows:

• If a file has a name including _full, then it is a full results file that contains a complete set of
results and the mesh (for example, 32_full.trn or 32_full.bak). These files can be loaded
into CFD-Post directly if required, and can be to restart a simulation.

• If a file has a name that does not include _full, then it is not a full results file and may contain
only selected variables and no mesh (for example, 32.trn or 32.bak). Do not try to load one of
these files directly into CFD-Post; instead, load the Ansys CFX results file (named file_001.res
in the example described above) and use the transient selector to switch between the final results
and the results contained in these files.

• In general, transient and backup files contain results for the timestep corresponding to the integer
prefix in the file name. For example, 32_full.trn contains results from the 32nd timestep or
outer iteration.

• For simulations involving couplers with external solvers, files with a name including _CS (such as
3_CS.trn or 7_CS_full.bak) may be present. These backup or transient files are indexed by
the coupling step rather than the CFX timestep or outer iteration. For example, 3_CS.trn corres-
ponds to the results at the end of the 3rd coupling step, not necessarily the 3rd timestep (although
the two may be coincident). These files are created in the same way as standard transient and
backup files in CFX-Pre, but with a frequency of Every Coupling Step or Coupling Step
Interval.

3.2.14.1. CFD-Post

The CFX-Solver Results file may be used as input to CFD-Post in order to view the results and produce
hard copy output. It may also be used to produce files that are suitable for use with other post-
processors by using the CFX Export facility. For details, see File Export Utility (p. 185).
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3.2.14.2. CFX-Solver

The CFX-Solver Results file may also be used as input to the CFX-Solver. The solution is used as the
initial values field from which to start a further analysis. For details, see Files Used by the CFX-
Solver (p. 47).

3.2.15. CFX Radiation File

When using the Monte Carlo or Discrete Transfer radiation models, output information for radiation
is written to a results data file named results.<groupname>_<accumulated timestep>.dat
(steady state cases) or results.<groupname>_<accumulated timestep>_<accumulated
iteration number>.dat (transient cases), where <groupname>, <accumulated timestep>,
and <accumulated iteration number> are substituted with appropriate names/values.

A sample results.<groupname>_<accumulated timestep>.dat file is shown below:

Zone         Volume    Temperature Refr. B=1  Emiss Co.  Scat Co.   ...
Room$1       1.309E-02  2.951E+02  1.000E+00  1.000E-02  0.000E+00  ...
Room$2       1.104E-02  2.951E+02  1.000E+00  1.000E-02  0.000E+00  ...
.
.
.
Room$1551    2.172E-03  2.951E+02  1.000E+00  1.000E-02  0.000E+00  ...
Room$1552    5.090E-04  2.951E+02  1.000E+00  1.000E-02  0.000E+00  ...

Total heating and cooling   4.130E+02   3.873E+02

Total path length    1.834E+00

Surface data

Zone         Surface               Area     Temperature Rough   Emiss    ...

Room$1       Room Default$1        6.774E-02  2.991E+02 1.00  1.000E+00  ...
Room$1       VentOut$2             3.232E-02  2.951E+02 1.00  1.000E+00  ...
Room$2       VentOut$12            2.532E-02  2.951E+02 1.00  1.000E+00  ...
.
.
.
Room$1551    Room Default$10633    2.166E-02  2.991E+02 1.00  1.000E+00 ...
Room$1552    Room Default$10634    1.376E-02  2.991E+02 1.00  1.000E+00 ...

Total surface heating and cooling     2.211E+04   2.179E+04

Total non-thermal emission   3.464E+02

Net total absorbed power     3.624E+00    1.609E-06%

Total surface current and absorbed flux:-     9.818E-01   1.834E-02

PROCESS   1
***********

Number of histories      29423

 IWORK =     264568
 CPU time used     6.906
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3.2.15.1. CFX Radiation File Contents

A CFX Radiation file contains the volume information, surface information, and some miscellaneous
quantities such as the net total heating; parameters that measure the work needed and the CPU
time used. Finally, if radiometers have been included, the results for each radiometer will be printed
out. Note that the CPU time does not include the time required to compute the radiometer value.

3.2.15.2. Volume Information

The volume information is given in a table with the following columns:

• Zone is the radiation element’s internal name

• Volume is the volume of the radiation element

• Temperature is the temperature of the element

• Refr. B=1 is the refractive index of the element

• Emiss Co. is the emission coefficient (Units: per length)

• Scat Co. is the scattering opacity coefficient (Units: per length)

• Path len. is the average length when crossing a radiation element

• Heating is average volumetric absorbed radiation

• Emission is the volumetric emitted radiation

• (H-E)*VOL is the amount of radiative energy that shows up as a square term in the energy
equation

• Error % is the standard deviation of the path length.

For non-gray models the emission and scattering coefficients are the spectrum integrated coefficients.
In a gray model the absorption coefficient equals the emission coefficient, in a non-gray model it
can be obtained from the intensity and the heating.

The next five columns contain the results. The seventh is the total path length of photons in the
zone (Monte Carlo) or the mean radiation intensity (discrete transfer). The eighth is the heating per
unit volume, the ninth the cooling per unit volume, and the tenth the net total radiative heating
rate for the zone. The last column gives the statistical percentage error for Monte Carlo or the
number of samples (rays traced through the zone) used for the heating quadrature in the discrete
transfer case.

Finally comes the total heating and cooling rates for the entire volume and, for Monte Carlo, the
total mean path length of photons in the geometry. Non-gray models will also have the band by
band cooling.

3.2.15.3. Surface Information

In this output the first column is the zone name and the second the surface name. The third is the
surface temperature, the fourth the surface roughness and the fifth is the surface emissivity, spectrum
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integrated in the case of a non-gray model. Gray surfaces have an albedo equal to one minus the
emissivity, in the non-gray case the integrated albedo can be obtained from the surface heating
and the incident flux.

The next five columns contain the results. The sixth is the surface current (Monte Carlo) or average
incident radiation flux (discrete transfer). The seventh is the heating per unit area, the eighth the
cooling per unit area and the ninth the net total radiative heating. The last column is the statistical
error (Monte Carlo) or the number of surface nodes used for sampling (discrete transfer).

Finally comes the total heating and cooling rates for all the surfaces in the geometry. Non-gray
models will also show the band by band cooling.

After the above information, the overall net heating for the model is printed. This is a measure of
how good the calculation was because this figure should be zero. For a Monte Carlo calculation
the total surface current and absorbed photon flux is printed, these figures should sum to unity
and can therefore be used as another measure of the accuracy of the calculation. Next the number
of histories computed (Monte Carlo) or the number of angular ordinates (Discrete transfer) is printed.
The last numbers are the work estimator and the CPU time. The work estimator is defined in terms
of units of work where a unit of work is the computational effort to trace a photon (ray) to the next
event (surface) and process that event (update the recursion relation) for Monte Carlo (Discrete
transfer). If radiometers have been calculated, the angular calibration table that is used will be
printed; then for each radiometer location, the following will be written: location, direction, temper-
ature, flux.

3.2.16. CFX Partition File

The CFX partition file is generated by the CFX-Solver and used as input for a parallel run. The partition
file is used to store information about the partitioning of the mesh. The partition file can be used to
view mesh partitions before running the CFX-Solver. To do this, set the expert parameter write
partition number=t before partitioning, then combine the partition file with the CFX-Solver
input file that was used to produce the partition file.

On UNIX systems, type:

cat filename.def filename_001.par > newfilename.res

On Windows systems, type:

copy /b filename.def + filename_001.par newfilename.res

This creates a results file that can be loaded in CFD-Post and contains the variable Real partition
number.

Note:

A partition file generated in Ansys CFX 11.0 or earlier versions is not supported in Ansys
CFX 12.0. If such a file is used in Ansys CFX 12.0, then an error message is generated.
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3.2.17. Multi-Configuration CFX-Solver Output File

Multi-configuration simulations involve the sequential and sometimes repeated execution of defined
configurations. The CFX-Solver generates a multi-configuration CFX-Solver Output file to summarize
the global problem definition and execution of configurations.

The CFX-Solver will generate a multi-configuration CFX-Solver Output file with a name based on the
CFX-Solver Input file. For example, running the CFX-Solver using the input file named file.mdef
in a clean working directory will generate a multi-configuration CFX-Solver Output file named
file_001.out.

3.2.17.1. Header

The header is written at the start of every multi-configuration CFX-Solver Output file and contains
information regarding the command that started the simulation. This information is useful to check
which files were used to start the run.

3.2.17.2. CFX Command Language for the Run

The CFX Command Language section describes the global (that is, simulation level) problem, which
includes library definitions (such as materials, expressions, and so on) and simulation control spe-
cifications (such as configuration definitions).

The section for the command file looks similar to the following:

 +--------------------------------------------------------------------+
 |                                                                    |
 |                    CFX Command Language for Run                    |
 |                                                                    |
 +--------------------------------------------------------------------+

 LIBRARY:
   MATERIAL: Air at 25 C
     Material Description = Air at 25 C and 1 atm (dry)
     Material Group = Air Data, Constant Property Gases
     Option = Pure Substance
     Thermodynamic State = Gas
     PROPERTIES:
       Option = General Material
       EQUATION OF STATE:
         Density = 1.185 [kg m^-3]
         Molar Mass = 28.96 [kg kmol^-1]
         Option = Value
       END
       SPECIFIC HEAT CAPACITY:
         Option = Value
         Specific Heat Capacity = 1.0044E+03 [J kg^-1 K^-1]
         Specific Heat Type = Constant Pressure
       END
       REFERENCE STATE:
         Option = Specified Point
         Reference Pressure = 1 [atm]
         Reference Specific Enthalpy = 0. [J/kg]
         Reference Specific Entropy = 0. [J/kg/K]
         Reference Temperature = 25 [C]
       END
       DYNAMIC VISCOSITY:
         Dynamic Viscosity = 1.831E-05 [kg m^-1 s^-1]
         Option = Value
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       END
       THERMAL CONDUCTIVITY:
         Option = Value
         Thermal Conductivity = 2.61E-02 [W m^-1 K^-1]
       END
       ABSORPTION COEFFICIENT:
         Absorption Coefficient = 0.01 [m^-1]
         Option = Value
       END
       SCATTERING COEFFICIENT:
         Option = Value
         Scattering Coefficient = 0.0 [m^-1]
       END
       REFRACTIVE INDEX:
         Option = Value
         Refractive Index = 1.0 [m m^-1]
       END
       THERMAL EXPANSIVITY:
         Option = Value
         Thermal Expansivity = 0.003356 [K^-1]
       END
     END
   END
 END
 SIMULATION CONTROL:
   CONFIGURATION CONTROL:
     CONFIGURATION: Both Boxes Transient
       Flow Name = Copy of Both Domains
       ACTIVATION CONTROL:
         CONTROL CONDITION: After Top Box Steady State
           Configuration Name List = Top Box Steady Only
           Option = End of Configuration
         END
       END
       CONFIGURATION EXECUTION CONTROL:
         INITIAL VALUES SPECIFICATION:
           INITIAL VALUES CONTROL:
             Use Mesh From = Solver Input File
           END
           INITIAL VALUES: Initial Values 1
             Configuration Name = Top Box Steady Only
             Option = Configuration Results
           END
         END
         PARTITIONER STEP CONTROL:
           Multidomain Option = Independent Partitioning
           Runtime Priority = Standard
           EXECUTABLE SELECTION:
             Double Precision = No
           END
           PARTITIONING TYPE:
             MeTiS Type = k-way
             Option = MeTiS
             Partition Size Rule = Automatic
           END
         END
         SOLVER STEP CONTROL:
           Runtime Priority = Standard
           EXECUTABLE SELECTION:
             Double Precision = On
           END
           PARALLEL ENVIRONMENT:
             Start Method = Intel MPI Local Parallel
           END
         END
       END
     END
     CONFIGURATION: Top Box Steady Only
       Flow Name = Top Domain Steady State
       ACTIVATION CONTROL:
         CONTROL CONDITION: Cyclical Activation
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           Configuration Name List = Both Boxes Transient
           Option = End of Configuration
         END
         CONTROL CONDITION: Start of Sim
           Option = Start of Simulation
         END
       END
       CONFIGURATION EXECUTION CONTROL:
         INITIAL VALUES SPECIFICATION:
           INITIAL VALUES CONTROL:
             Continue History From = Initial Values 1
             Use Mesh From = Solver Input File
           END
           INITIAL VALUES: Initial Values 1
             Configuration Name = Both Boxes Transient
             Option = Configuration Results
           END
         END
         PARTITIONER STEP CONTROL:
           Multidomain Option = Independent Partitioning
           Runtime Priority = Standard
           EXECUTABLE SELECTION:
             Double Precision = No
           END
           PARTITIONING TYPE:
             MeTiS Type = k-way
             Option = MeTiS
             Partition Size Rule = Automatic
           END
         END
         SOLVER STEP CONTROL:
           Runtime Priority = Standard
           EXECUTABLE SELECTION:
             Double Precision = On
           END
           MEMORY CONTROL:
             Memory Allocation Factor = 2
           END
           PARALLEL ENVIRONMENT:
             Start Method = Intel MPI Local Parallel
           END
         END
       END
     END
   END
   TERMINATION CONTROL:
     CONTROL CONDITION: Control Condition 1
       Configuration Name = Top Box Steady Only
       Maximum Number of Configuration Steps = 2
       Option = Maximum Number of Configuration Steps
     END
   END
   EXECUTION CONTROL:
     RUN DEFINITION:
       Solver Input File = mcfg1.mdef
     END
   END
 END

3.2.17.3. Simulation Execution Summary

The body of the multi-configuration CFX-Solver Output file summarizes the configuration execution
sequence. The output is divided into simulation and configuration steps.

At each simulation step, the simulation step counter is incremented and the activation conditions
for all configurations are evaluated. All active configurations are executed, but in no particular order.
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Once all active configurations have finished their execution for the current simulation step, a new
step begins. Subsequent simulation steps are executed until any of the following occurs:

• There are no active configurations in a simulation step

• Any simulation termination control conditions are satisfied

• You stop the simulation while in progress by using Stop Current Run in the multi-configuration
simulation workspace, or by executing the cfx5stop command for the simulation run directory.

Additional details regarding configuration activation conditions and simulation termination controls
are provided in Configurations in the CFX-Pre User's Guide and Termination Control in the CFX-Pre
User's Guide, respectively.

A new configuration setup occurs, and the configuration step counter is incremented, each time a
given configuration is executed. Configuration step output includes the following information:

• The configuration step counter value

• The name of the configuration

• A listing of all configuration activation conditions that were satisfied

• The status at the end of the run (for example, whether it succeeded or failed, or whether you
stopped the run while it was in progress)

• Notes regarding any CFX Command Language (CCL) changes made using Edit Run In Progress
during the run.

A sample simulation execution summary is provided below. This summary presents the execution
of three simulation steps.

1. Only the Top Box Steady Only configuration was active and ran. This configuration was activ-
ated by the Start of Sim condition defined in Simulation Control > Configuration > General
Settings > Activation Condition(s) and ran successfully.

2. Only the Both Boxes Transient configuration was active and ran. This configuration was activ-
ated by the After Top Box Steady State condition, and ran successfully. During this run,
changes to both LIBRARY and FLOW CCL were made using Edit Run in Progress, and the
included notes indicate how these changes will be propagated to subsequent configuration
runs.

3. On the Top Box Steady Only configuration was active and ran. Notice that the configuration
step counter for this run indicates that this is the second time this configuration has been run,
and that the configuration was activated by the Cyclical Activation condition. This run also
completed successfully.

 +--------------------------------------------------------------------+
 |                                                                    |
 |                        Simulation Execution                        |
 |                                                                    |
 +--------------------------------------------------------------------+

 ======================================================================
 SIMULATION STEP =        1
 ----------------------------------------------------------------------
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 |  Config.  | Configuration Name                                     |
 |   Step    | * Execution Details                                    |
 +-----------+--------------------------------------------------------+
 |        1  | Top Box Steady Only                                    |
 |           | * Act. by : Start of Sim                               |
 |           | * Status  : Succeeded                                  |
 +-----------+--------------------------------------------------------+

 ======================================================================
 SIMULATION STEP =        2
 ----------------------------------------------------------------------
 |  Config.  | Configuration Name                                     |
 |   Step    | * Execution Details                                    |
 +-----------+--------------------------------------------------------+
 |        1  | Both Boxes Transient                                   |
 |           | * Act. by : After Top Box Steady State                 |
 |           | * Status  : Succeeded                                  |
 |           | * NOTE    : The LIBRARY definition changed during this |
 |           |             run.  These changes will be applied to all |
 |           |             remaining configuration runs.              |
 |           | * NOTE    : The FLOW definition changed during this    |
 |           |             run.  These changes will be applied to all |
 |           |             remaining runs of this configuration.      |
 +-----------+--------------------------------------------------------+

 ======================================================================
 SIMULATION STEP =        3
 ----------------------------------------------------------------------
 |  Config.  | Configuration Name                                     |
 |   Step    | * Execution Details                                    |
 +-----------+--------------------------------------------------------+
 |        2  | Top Box Steady Only                                    |
 |           | * Act. by : Cyclical Activation                        |
 |           | * Status  : Succeeded                                  |
 +-----------+--------------------------------------------------------+

3.2.17.4. Simulation Termination Condition Summary

This section of the multi-configuration CFX-Solver Output file identifies the reason(s) for terminating
the simulation. In the example provided below, the user defined condition named Control Condition
1 was satisfied. For information regarding how this condition was defined, refer to the discussion
in Termination Control in the CFX-Pre User's Guide.

 ======================================================================
 TERMINATION CONDITION SUMMARY
 ----------------------------------------------------------------------

   * User: Control Condition 1

3.2.18. Multi-Configuration CFX-Solver Results File

The CFX-Solver will generate a results file with a name based on the CFX-Solver Input file. For example,
running the CFX-Solver using the input file named file.mdef in a clean working directory will
generate the multi-configuration CFX-Solver Results file named file_001.mres.

For multi-configuration simulations, the CFX-Solver Input and CFX-Solver Results files are very similar;
both are small files that contain only high level information about the simulation. In particular, the
multi-configuration CFX-Solver Results file contains:

• Global information about the simulation’s overall definition (such as Library CCL, configuration
definitions and sequencing, etc…)
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• Information about the configuration files (*.cfg, which contain configuration specific settings
and meshes)

• Information about the CFX-Solver Results files (for details, see CFX-Solver Results File (p. 87)) gen-
erated for each configuration step.

CFX-Solver Output and CFX-Solver Results files for each configuration (and configuration step) executed
are contained within the multi-configuration simulation’s run directory. For example, running the
CFX-Solver using the input file named file.mdef in a clean working directory will generate a file
and directory structure similar to the following:

• file_001.mres

• file_001.out

• file_001/

– Configuration1_001

– Configuration1_001.out

– Configuration1_001.res

– Configuration1_002.out

– Configuration1_002.res

– Configuration2_001

– Configuration2_001.out

– Configuration2_001.res

In this case, the directories file_001/Configuration1_001 and file_001/Configura-
tion2_001 each contain the transient and backup files created during the respective configuration
runs.
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Chapter 4: Residual Plotting
CFX-Solver calculates solutions to various equations. However, many cases result in residual values. This
is due to an equation not being fully satisfied. Of course, if the solution is exact, then the residual is
zero. However, because equation results only approximate physics, the results in a solution do not always
match reality.

This chapter describes:

4.1. Equation Residual

4.2. Convergence Results and RMS

4.3.Transient Residual Plotting

4.1. Equation Residual

CFX-Solver calculates the solution to various equations, given the appropriate boundary conditions and
models for your particular CFD problem. For details, see Governing Equations in the CFX-Solver Theory
Guide.

At any stage of a calculation, each equation will not be satisfied exactly, and the "residual" of an equation
identifies how much the left-hand-side of the equation differs from the right-hand-side at any point in
space. If the solution is "exact," then the residual is zero. This means that each of the relevant finite
volume equations is satisfied precisely. However, because these equations only model the physics ap-
proximately, this does not mean that the solution exactly matches what happens in reality. If a solution
is converging, residuals should decrease with successive timesteps.

For example, assume that a given residual is 0.0005 kg s^-1. It is not obvious whether such a residual
is large or small. For instance, if the problem involves flows such that about 0.5 kg flows into (and out
of ) each mesh element every second, then a residual of 0.0005 kg s^-1 means the equation is satisfied
to within one part in a thousand, which is likely a reasonable solution. However, if the problem involves
flows of about 0.001 kg s^-1 into each mesh element, then the residual is nearly as large as the flow,
and the solution is not good.

To make the scales of the residuals meaningful, the solver normalizes values by dividing the appropriate
scales at each point. CFX-Solver Manager plots these normalized residuals using a log (base 10) scale.

The exact details of how the residuals are normalized are involved. For details, see Residual Normalization
Procedure in the CFX-Solver Theory Guide. However, it is useful to know that residuals are divided by
the solution range. If the linear solution diverges, this range may be very large and the normalized re-
siduals would be meaningless.

4.2. Convergence Results and RMS

A measure of how well the solution is converged can be obtained by plotting the residuals for each
equation at the end of each timestep. A reasonably converged solution requires a maximum residual
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level no higher than 5.0E-4. Typically, the RMS (Root Mean Square) residual will be an order of magnitude
lower than this.

The RMS residual is obtained by taking all of the residuals throughout the domain, squaring them,
taking the mean, and then taking the square root of the mean. This should present an idea of a typical
magnitude of the residuals.

The Maximum Residuals and/or the RMS Residuals can be displayed in the convergence history plots
by selecting a specific monitor in Monitor Settings. For details, see Monitors Tab (p. 124).

The increase of a residual after any particular timestep does not imply that the solution is diverging. It
is usual for residuals to occasionally get larger, especially at the beginning of a run.

Note that even though convergence is good, there are still places where the residuals become larger
temporarily.

It is also possible to have runs that do not converge at all, but simply deviate around the same values.

If the solution fails to converge, or convergence is happening very slowly, some tips on how to improve
the convergence are available. For details, see Monitoring and Obtaining Convergence in the CFX-Solver
Modeling Guide.

Tip:

If you want to obtain residual plots for old runs, select File > Monitor Finished Run and
select a file to view.

Note:

By default, the CFX-Solver Manager will combine residuals for multi-domain problems provided
the domains are connected together and have the same domain type (solid or fluid/porous).
If there are multiple groups of the same domain type, then the group residual is identified
by the name of the first domain in the connected group.

4.3. Transient Residual Plotting

When monitoring a transient run with the plotting of coefficient loop data selected, CFX-Solver Manager
outputs the monitor data for each coefficient loop within each timestep. Each timestep is divided by
the number of inner coefficient loops. The values are produced for all variables in each coefficient loop.

With the plotting selected, CFX-Solver Manager outputs the graph of monitor data. The strategy that
CFX-Solver Manager uses for plot data is to plot the loops evenly across the space between iteration
N-1 and N, so that the last coefficient loop is in line with iteration N on the plot. When the first coefficient
loop value becomes available, it is the only value, and therefore it is placed in line with iteration N. As
more data is added, the older coefficient loop values are shifted back, so that they are evenly spaced,
with the last coefficient loop always in line with N.

Example: Assume that four coefficient loops were run for timestep 39. The first coefficient loop value
for a plotted variable appears at position 38.25, the second at 38.5, the third at 38.75, and the fourth
and final value is plotted at 39.
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For details on plotting coefficient loop data, see Global Plot Settings Tab (p. 125).
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Chapter 5: Editing CFX-Solver Input Files
This chapter discusses the details of editing existing CFX-Solver input (or results) files to make minor
changes to a CFD model, without having to use CFX-Pre:

5.1.Workflow Overview

5.2. Command File Editor Overview

5.3. Menus in the Command File Editor

5.4. Command File Editor Rules

5.5. Command File Editor Appearance

5.6. Editing the Command Language (CCL) File

5.7. Command Language File Rules

5.8. RULES and VARIABLES Files

5.1. Workflow Overview

Modifications to CFX-Solver input files and results files can be performed using either the Command
File Editor in CFX-Solver Manager or the cfx5cmds command from the command line, as shown in
Figure 5.1: CFX-Solver Input File Modification Workflows (p. 103).

Figure 5.1: CFX-Solver Input File Modification Workflows
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5.2. Command File Editor Overview

The simplest method of making changes to an existing CFX-Solver input file is to use the Command
File Editor. The Command File Editor provides a tree-structured representation of a CFX-Solver input
file. This enables modification of parameter settings and the addition of new parameters to existing
CFX-Solver input files as required.

The Command File Editor can be invoked in multiple ways and each way provides a different function:

• Tools > Edit CFX-Solver File

See Edit CFX-Solver File Command (p. 135).

• Tools > Edit Run In Progress

See Edit Run In Progress Command (p. 140).

• Tools > Edit Current Results File

See Edit Current Results File Command (p. 141).

5.3. Menus in the Command File Editor

The Command File Editor has three menus:

• File Menu (p. 104)

• Edit Menu (p. 105)

• Help Menu (p. 107)

5.3.1. File Menu

The File menu contains:

• Save Command (p. 104)

• Validate Command (p. 104)

• Exit Command (p. 105)

5.3.1.1. Save Command

Saves the file and returns the CFX Command Language file information to the CFX-Solver input
file.

5.3.1.2. Validate Command

Checks the format of the CFX Command Language file for necessary content and reports any errors.
Validation of units is performed each time a parameter is edited.
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5.3.1.3. Exit Command

Closes the Command File Editor. A prompt is displayed if there are unsaved changes.

5.3.2. Edit Menu

The Edit menu contains:

• Add Parameter Command (p. 105)

• Edit Parameter Command (p. 106)

• Delete Parameter Command (p. 107)

• Add Expert Parameter Section Command (p. 107)

• Find Command (p. 107)

• Find Next Command (p. 107)

5.3.2.1. Add Parameter Command

Some categories (for example, the FLOW > SOLVER CONTROL > CONVERGENCE CONTROL section)
allow additional parameters that are not shown by default.

The Add Parameter option is used to:

• Add a new parameter to a category when the category is selected.

• Add an expert parameter to the CFX Command Language file after the Expert Parameter Section
has been created. For details, see Add Expert Parameter Section Command (p. 107).

If a parameter can be added to a section, a dialog box displays with a drop-down list of available
parameters. Ensure that parameters being added make sense and use correct units as required.

1. Select a parameter that enables additional parameters to be added.

2. Select Edit > Add Parameter.

3. In the drop-down list select a parameter.

4. Under Value, enter specific information about the parameter.

For details, see Command File Editor Rules (p. 108).

5. Click OK.

Note that it is also possible to add a parameter that is not in the drop-down list by typing its name
into the top field and then entering a value. The CFX-Solver will subsequently fail if either the
supplied name or value is inappropriate.

105
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Menus in the Command File Editor



5.3.2.2. Edit Parameter Command

The Edit Parameter option enables changes to an existing expert parameter in the CFX Command
Language file.

When the Command File Editor is first opened, the Root is displayed. It contains three categories:
LIBRARY, EXECUTION CONTROL (seen only when editing version 5.5 or later .res files) and
FLOW.

In CFX-Solver Input files, only two categories are displayed: LIBRARY and FLOW.

Note:

Parameters that can be edited display the value in green. Other parameters cannot be
changed from the Command File Editor.

5.3.2.2.1. Expanding Categories

Additional information about a category can be seen by expanding it.

• Click the plus/minus boxes to expand or reduce the category selection.

Tip:

Right-click to expand the category and all of its subcategories.

5.3.2.2.2. Editing Entries

Important:

Editing the CFX Command Language file changes the CFX-Solver input file, but does
not make changes to the CFX-Pre case file; that is, changes made by the Command
File Editor are used by the CFX-Solver but do not appear when the case file is reopened
in CFX-Pre.

1. Expand the Name of the entry until a Value in green or orange is displayed.

Editable values display in green or in orange.

2. Double-click the value to edit.

The Edit Parameter dialog box is displayed.

3. Edit the value as required.

In some parameters this may require edits to text and in others a selection in a drop-down
list box. For details, see Command File Editor Rules (p. 108).

4. Click OK.
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5. When all modifications have been made, save the file.

Changes made to the CFX Command Language file are written in the CFX-Solver input file.

5.3.2.3. Delete Parameter Command

The Delete Parameter option is used to remove an expert parameter from the CFX Command
Language file.

5.3.2.4. Add Expert Parameter Section Command

The Add Expert Parameter Section provides access to the expert parameters in CFX. An expert
parameter section must be created before adding expert parameters to the CFX Command Language
file.

Before adding any expert parameters to the CFX Command Language file, first add an expert
parameters section to the tree structure displayed in the Command File Editor.

1. Select Edit > Add Expert Parameter Section.

The EXPERT PARAMETERS: section is added to the bottom of the FLOW branch of the tree.

2. Expand FLOW.

3. Select EXPERT PARAMETERS.

4. Add parameters as required.

For details, see Add Parameter Command (p. 105).

Once the value for an expert parameter has been set, it can be edited as needed. For details, see
Edit Parameter Command (p. 106).

5.3.2.5. Find Command

Enables searching of the CFX Command Language file for a keyword or keywords.

5.3.2.6. Find Next Command

Finds the next occurrence of the keyword or keywords.

5.3.3. Help Menu

The Help menu has the following commands:

On CFX Solver File Editor

Opens Command File Editor Overview (p. 104).

On Expert Parameters

Opens CFX-Solver Expert Control Parameters in the CFX-Solver Modeling Guide.
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Contents

Opens a page that lists various help resources associated with this product.

Help on Help

Opens documentation about the help system: Help On Help in the CFX Introduction.

5.4. Command File Editor Rules

If you are unsure about which values are appropriate to enter, select Help > On Expert Parameters
from the main Command File Editor window to view a description and valid values for the parameters.

The following rules apply when using the Command File Editor:

• Everything is case-sensitive. Use care to distinguish upper case letters from lower case letters.

• Parameter names must start with a letter (not a number or symbol). Subsequent characters can be
letters, numbers, spaces or tabs.

• Spaces appearing before or after a name are not considered to be part of the name.

• Multiple spaces and tabs appearing inside a name are treated as a single space.

• For parameters requiring a logical value, enter T or t for true, and F or f for false. For many parameters
requiring an integer value only a few integer values are valid.

These rules should suffice for simple editing operations. To perform more complicated editing operations,
consider editing the command file directly. For details, see Editing the Command Language (CCL)
File (p. 109).

5.5. Command File Editor Appearance

Some of the file information under the Name and Value headings may be truncated when the tree
structure is expanded. The amount of space allocated to the name or the value can be configured.

1. Position the mouse cursor between the Name and Value headings.

That is, place the cursor over the line that separates the two headings. The cursor appears as a
double line with an arrow to the left and the right.

2. Click and drag to expand or contract the width of the column.

For lengthy lines (such as those that contain lists), double-click the line. This opens the line in a
configurable dialog box for viewing and editing.
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5.6. Editing the Command Language (CCL) File

In some circumstances, more significant changes may be required to the CFX-Solver input file than is
possible through the Command File Editor. Ansys CFX allows the use of a text editor to edit the CFX
Command Language file.

Note:

This feature is for expert users only. Extreme care must be taken when editing a CFX Command
Language file. Changes made to the CFX Command Language file are reflected in the CFX-
Solver input file and may have negative effects on the model. It is strongly advised that ori-
ginal files are backed up before edits are made to them.

To generate the CFX Command Language file, use the cfx5cmds command in a Linux terminal or a
Windows command line that is set up correctly to run CFX commands. For details, see Command Line
in the CFX Reference Guide.

Note:

If you use cfx5cmds to update CCL, and/or you use cfx5dfile to update the profile data
or table data stored within the case, then you must, in addition to updating an mdef file,
also perform the same update to any associated .def or .cfg files.

5.7. Command Language File Rules

The following rules apply when using a text editor to change a CFX Command Language file:

• Changing the solution units outside of CFX-Pre is not recommended. For details, see Setting the
Solution Units in the CFX-Pre User's Guide.

• Everything apart from expert parameter names is case-sensitive. Use care to distinguish upper case
letters from lowercase letters. You should use lowercase letters for expert parameter names to match
those shown in the Command File Editor Help's Expert Parameters section.

• The name of any variable must start with a letter (not a number or symbol). Subsequent characters
can be letters, numbers, spaces, or tabs.

• Spaces appearing before or after a name are not considered to be part of the name.

• Multiple spaces and tabs appearing inside a name are treated as a single space.

• Nothing is sensitive to indentation. Indentation is used only to make the appearance of the text
clearer.

• The comment character is the pound, or number sign (#). Anything appearing to the right of this
character is ignored. For instance:

PARAMETER = 3.2   # This text is ignored
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• The line continuation character is the backslash (\). To break a long line of text into two or more
lines, insert a backslash character at the end of the first line. For instance, both of the following de-
clarations are handled the same way:

NAME = default temperature used in the first simulation
NAME = default temperature used \
       in the first simulation

• A line containing CFX Expression Language must be no more than 256 characters long. Other lines
can be of any length.

The RULES and VARIABLES files can be a useful guide when editing a CCL file. For details, see RULES
and VARIABLES Files (p. 111).

Some objects in the CCL file can be defined with a default value and then overridden by local values.
For example, the SOLVER CONTROL section of a CCL file may look like:

SOLVER CONTROL :
   CONVERGENCE CONTROL :
      Maximum Number of Iterations = 100
      Timescale Control = Physical Timescale
      Physical Timescale = 5.E-1 [s]
   END
   EQUATION CLASS : momentum
      CONVERGENCE CONTROL :
         Timescale Control = Physical Timescale
         Physical Timescale = 1.E-1 [s]
      END
   END
   CONVERGENCE CRITERIA :
      Residual Type = RMS
      Residual Target = 1.E-4
   END
   ADVECTION SCHEME :
      Option = Upwind
      END
   DYNAMIC MODEL CONTROL :
      Global Dynamic Model Control = No
   END
END

The first CONVERGENCE CONTROL object defines values that apply to all equation classes. The physical
time scale is then locally overridden for the momentum equation class. Other objects, including the
ADVECTION SCHEME, can be locally overridden in the same way. The order in which objects appear
is not important, so an object can be assigned an override before its default has been set. Only some
parameters may be set to a different local value; for example, it does not make sense to set the Maximum
Number of Iterations locally.
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5.8. RULES and VARIABLES Files

The RULES and VARIABLES files can be useful when editing a CCL file. They provide information on
valid options, variables, and dependencies. Both files are located in <CFXROOT>/etc/ and can be
viewed in any text editor.

Note:

In some cases, the RULES and VARIABLES files contain information about variables, para-
meters, models and options that are not yet fully supported in the CFX-Solver. Use caution
with features that are not documented elsewhere as these may cause the CFX-Solver to fail
or produce invalid results.

5.8.1. VARIABLES File

The VARIABLES file lists all the variables available in the CFX-Solver. Information provided for each
variable appears similar to the following:

VARIABLE: vel
   Option = Definition
   MMS Name  = VEL
   Long Name = Velocity
   Tensor Type = VECTOR
   Quantity = Velocity
   Status = P
   User Level = 1
   Output to Jobfile = No
   Output to Postprocessor = Yes
   Component Short Names = \
      u, \
      v, \
      w
   Component Long Names = \
      Velocity u, \
      Velocity v, \
      Velocity w
   Component MMS Names = \
      VEL-1, \
      VEL-2, \
      VEL-3
   General Availability = ADAPTION, RESULTS, CEL
   Variable Description = Velocity
   Variable Scope = PHASE
END

The following information can be identified:

• The name appearing immediately after VARIABLE: (in this case vel) is the CFX-Solver name or
short name for the variable.

• For scalar quantities (Tensor Type = SCALAR), the name appearing after VARIABLE: is the
name that must be used in any CEL expressions. The MMS Name and Long Name are not valid
names to use for this purpose.

• For vector and tensor quantities (Tensor Type = VECTOR and Tensor Type = SYMTEN2),
the Component Short Names (u, v and w in this case) are names that must be used in any CEL
expressions.
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• The User Level setting controls when the variable is seen. Variables of User Level = 1 will
appear in drop-down variable selection menus in CFD-Post. Variables with User Level = 2 or
User Level = 3 will only appear in the full list of variables.

• The Output to Postprocessor setting controls whether the variable is written to the results
file for use in CFD-Post. A variable must be involved in the simulation before is has the potential
to be written out.

• The General Availability field determines when a variable can be used. Only variables
whose General Availability includes CEL can be used in CEL expressions.

• The names of all VARIABLE, EQUATION DEFINITION and FUNCTION objects are reserved
names. These names should not be used as the name for any CEL expressions, Additional Variables,
user routines, or user functions, and so on.

The end of the VARIABLES file contains a section listing call back definitions. Using call backs that
are not documented, or using them on locations other than those documented, will produce invalid
results. For details, see Quantitative Function List in the CFX Reference Guide.

5.8.2. RULES File

The RULES file contains information about which models and parameters are valid options. This in-
cludes SINGLETON, OBJECT and PARAMETER items.

5.8.2.1. RULES

The first items in the RULES file list the top level SINGLETON objects. All other items are children
of these optional top level objects.

• RULES: This could be used to modify the list of allowed options. This should always be done
locally.

• LIBRARY: Includes libraries for materials, reactions, CEL and user routines. Add new materials
and reactions using a local library.

• FLOW: Contains the current problem definition.

• USER: Where user parameters may be stored for later retrieval through User Fortran.

• COMMAND FILE: Contains the command file version number.

• EXECUTION CONTROL: Contains information about the parallel setup and other settings con-
trolled in the CFX-Solver Manager.

Details about models that are not available can also be found through the user interface. For example,
the SINGLETON: ADVECTION SCHEME item includes the QUICK scheme.

5.8.2.2. SINGLETON

A SINGLETON object is permitted to appear once as the child of a parent object. For this reason
SINGLETON objects do not have names associated with them, for example:
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LIBRARY :
   CEL :
      EXPRESSIONS :

Each of these three items is a SINGLETON object. The LIBRARY SINGLETON may only have one
CEL SINGLETON, and the CEL SINGLETON may only have one EXPRESSIONS SINGLETON.
Parameters and child definitions do not need to be grouped for a SINGLETON into a single location;
this is done automatically by the CFX-Solver. For example, the following is valid:

LIBRARY :
   CEL :
      EXPRESSIONS :
         myexp1 = 1 [ m ]
      END
   END
END
...
LIBRARY :
   CEL :
      EXPRESSIONS :
         myexp2 = 2 [ m ]
      END
   END
END

5.8.2.3. OBJECT

An OBJECT is similar to a SINGLETON except that more than one can appear as the child of a
parent object. For this reason each OBJECT must have a name, for example:

FLOW :
   DOMAIN : domain1
      ...
   END
   DOMAIN : domain2
      ...
   END
END

Two OBJECT items of type DOMAIN have been defined with names domain1 and domain2. These
are children of the FLOW SINGLETON.

5.8.2.4. PARAMETER

A PARAMETER consists of a name, followed by the "=" character, followed by a value. Many para-
meters in the RULES file cannot be set in a CCL file and therefore cannot be altered.

• The Parameter Type tells you the type of values the parameter is allowed to take. It could
be Real, Real List, Integer, Integer List, String or String List. When a list is
valid, items should be comma separated.

• Some parameters contain an Allowed String List. This contains valid strings that can be
used for that parameter.

• Each PARAMETER that you can set has a Dependency List that lists the variables the
PARAMETER can depend upon. XYZ refers to the x, y and z coordinates. XYZT refers to the x, y
and z coordinates and time. The CCL file can be edited based on the dependencies listed here.
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• If a PARAMETER contains the item Dynamic Reread Item = Yes, then it can generally be
modified while a run is in progress. Some SINGLETON objects also contain this item. For details,
see Edit Run In Progress Command (p. 140). Note that you must not change any references to
regions while the CFX-Solver is running with topology simplification active; doing so would cause
the solver to stop. For details on topology simplification, see the description for expert parameter
topology simplification in Physical Model Parameters in the CFX-Solver Modeling Guide.
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Chapter 6: CFX-Solver Manager File Menu
This chapter describes the commands available from the CFX-Solver File menu:

Define Run Command

Running the CFX-Solver involves passing it the geometry, models, boundary conditions, and start-up
information that it needs to calculate a solution to your CFD problem. The Define Run form is where
you specify the information which is passed to the CFX-Solver. Some runs of the CFX-Solver require you
to specify only the name of the CFX-Solver input file; others also require the name of an initial values
file. Extra tabs become available when Show Advanced Controls is selected. For details, see The Define
Run Dialog Box (p. 24).

Monitor Run in Progress Command

Used when CFX-Solver Manager has been closed and a run currently underway in the Solver must be
displayed.

1. Select File > Monitor Run in Progress.

The Select a Run Directory (.dir) dialog box is displayed.

2. Browse to the directory containing the current run.

3. Select the current run.

4. Click OK.

Data up to the current timestep is loaded.

Monitor Finished Run Command

Used to view the residual plots of a finished run.

1. Select File > Monitor Finished Run.

The Monitor Finished Run dialog box is displayed.

2. Under File Type, select the type of files to view.

3. Browse to the directory containing the finished run.

4. Select the run to view.

If required, select a different file.

5. Click OK.
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The data is loaded.

Close Workspace Command

Closes all windows related to the current run. Any other runs that were open are not affected, and the
last open run prior to the current run is displayed. If the Solver was in progress on the current run, it
continues to operate in the background. The run can be re-monitored; see Monitor Run in Progress
Command (p. 115) or Monitor Finished Run Command (p. 115), as appropriate.

Quit Command

To quit CFX-Solver Manager, select File > Quit. Closing CFX-Solver Manager does not stop CFX-Solver
jobs that are currently running. CFX-Solver Manager can be re-opened to take control of these jobs
again simply by opening CFX-Solver Manager and selecting Monitor Run in Progress. For details, see
Monitor Run in Progress Command (p. 115).
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Chapter 7: CFX-Solver Manager Edit Menu
The Edit > Options dialog box enables you to set various general preferences. Settings are retained
per user.

1. Select Edit > Options.

The Options dialog box appears.

2. Set options as required. For descriptions of the available options, see:

• CFX-Solver Manager Options (p. 117)

• Common Options (p. 120)

If desired, you can use the CFX Defaults or the Workbench Defaults buttons at the bottom of
the dialog box to quickly set CFX-Pre, CFX-Solver Manager, and CFD-Post to have the standard
operation of CFX or Workbench respectively. The only settings visible in CFX-Solver Manager that
are affected by these buttons are Common > Viewer Setup > Mouse Mapping.

3. Click OK.

7.1. CFX-Solver Manager Options

When the Options dialog box appears, CFX-Solver Manager options can be set under SolverManager.

Show Original Variable Names

If selected, the variable names will be shown with their original names. By default, this option is not
selected and is generally left at that default setting.

Don’t write Backup file on Edit Run In Progress

By default, a backup file is written. For details, see Edit Run In Progress Command (p. 140).

Export plot data without full headers

If selected, plot data is exported without the full structured header data.

Enable Beta Features

Some Beta features are hidden in the user interface. You can select this option to "unhide" those features.
When selected, such features are identified by "(Beta)" in the user interface. Note that Beta features are
unofficial and not well tested.
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Layout

Save Layout to Results File

By default, this option is selected, enabling the CFX-Solver Manager workspace layout to be automatically
saved into the results file for the run. This means that if you subsequently re-monitor the run, any custom
plots or plot settings that you used for the original run will be preserved.

The automatic save:

• Happens upon closing the workspace for a completed run.

The automatic save does not happen for a run in progress.

• Overwrites any existing layout in the results file.

Note:

• Because the Save Layout to Results File option can automatically overwrite the layout
in the results file, and because this option will not save the layout when closing the
workspace for a run in progress, you should manually save any layout that you want to
preserve.

• The Load First Layout Found From group of settings, described below, determines which
layout is loaded when the CFX-Solver Manager monitors a run.

• Note that, with Save Layout to Results File selected, opening any Ansys CFX results file
in Release 11.0 or later of the CFX-Solver Manager will modify the results file in such a way
that it becomes incompatible with Release 10.0 or earlier of the CFX-Solver Manager. In
general, compatibility cannot be guaranteed whenever an Ansys CFX results file from a
particular release is opened in a CFX-Solver Manager from a later release. The results file
will still be functional for the CFX-Solver from the earlier release, but you will not be able
to monitor such a run using the CFX-Solver Manager from the earlier release. You should,
therefore, disable Save Layout to Results File when switching back and forth between
different releases of the CFX-Solver Manager. You should also disable this option if you
want to retain an unmodified results file.

Load First Layout Found From

This group of settings determines which layout is loaded when the CFX-Solver Manager monitors a run.
You can specify a list of sources of layout data. The first found source takes effect.

The options for each layout source are:

• Results File

This option specifies that layout data should be taken from:

– For a completed run, the results file, or

– For a run in progress, the definition file or initialization file.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.118

CFX-Solver Manager Edit Menu



• Specified Layout File

This option specifies that layout data should be taken from the layout file that is specified under
Specified File. If you do not specify the full path of the layout file, the specified file is taken as being
relative to the working directory of CFX-Solver Manager.

The file that is specified under Specified File must have extension mst, txt, or ccl.

• Relative Layout File

This option enables you to use a custom layout file for any given run simply by placing that layout
file in the directory containing the results file or the run’s working directory.

This option specifies that layout data should be taken from the layout file that has the name (that is,
name without path) that is specified under Relative File.

The directory that CFX-Solver Manager searches for the named layout file is either:

– For a completed run, the directory containing the results file, or

– For a run in progress, the run’s working directory.

The file that is specified under Relative File must have extension mst, txt, or ccl.

• Matched Layout File

This option enables you to use one generic layout file for a set of cases.

This option specifies that layout data should be taken from the layout file that has the name (that is,
name without path) that best matches the start of the name of the results file or working directory.

The directory that CFX-Solver Manager searches for layout files is either:

– For a completed run, the directory containing the results file (.mres for multi-configuration or
operating point runs), or

– For a run in progress, the run’s working directory.

CFX-Solver Manager searches this directory for a layout file with extension mst, with the file name
less .mst matching the start of the name of:

– For a completed run, the results file, or

– For a run in progress, the working directory.

If multiple such layout files are found then the one with the longest name (and therefore the most
matching characters) is selected. For example, a layout file called StaticMixerTurbulent.mst
would be selected in preference to StaticMixer.mst for a results file called "StaticMixerTurbu-
lent_001.res".

For multi-configuration runs, the directory is first searched for layout files that match the name of
the configuration results or working directory. If no such layout files are found then a subsequent
search is made for a layout file that matches the name of the overall results (.mres) or overall
working directory.
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For operating point runs, only layout files that match the name of the overall results (.mres) or
overall working directory are considered.

• Not Used

This option specifies no layout data source, causing the relevant list item to be ignored.

Default Layout Mode

You may specify a default layout mode to specify what mode monitors are presented when starting a
new run. Select from the following:

• Multiple Windows

• Tabbed

Monitor

Multiple options exist that can be monitored as required.

• The visibility for each type of residual can be toggled on or off. Settings take effect the next time a
run is started, or the next time a results file is viewed.

• If visibility is disabled for all residuals in a plot monitor, the monitor will not be created.

Monitor options are available to specify global residual display preferences. Settings chosen on the
form apply for all future solver runs and override default display settings for monitors. Monitors can
still be created using the Workspace menu. For details, see New Monitor Command (p. 130).

7.2. Common Options

Auto Save

Select the time between automatic saves.

To turn off automatic saves, set Auto Save to Never.

Note:

This option affects more than one CFX product.

Temporary directory

To set a temporary directory, click Browse  to find a convenient directory where the autosave
feature will save state files.

7.2.1. Appearance

The appearance of the user interface can be controlled from the Appearance options. The default
user interface style will be set to that of your machine. For example, on Windows, the user interface
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has a Windows look to it. If, for example, a Motif appearance to the user interface is preferred, select
to use this instead of the Windows style.

1. Under GUI Style, select the user interface style to use.

2. For Font and Formatted Font, specify the fonts to use in the application.

Note:

It is important not to set the font size too high (over 24 pt. is not recommended) or
the dialog boxes may become difficult to read. Setting the font size too small may
cause some portions of the text to not be visible on monitors set at low resolutions.
It is also important not to set the font to a family such as Webdings, Wingdings,
Symbols, or similar type faces, or the dialog boxes become illegible.

Note:

Formatted Font affects only the font used in CFX-Solver Manager for the CFX-Solver
Output file display.

7.2.2. Viewer Setup

1. Select Double Buffering to use two color buffers for improved visualization.

Double Buffering is a feature supported by most OpenGL implementations. It provides two
complete color buffers that swap between each other to animate graphics smoothly. If your im-
plementation of OpenGL does not support double buffering, you can clear this check box.

2. Select or clear Unlimited Zoom.

By default, zoom is restricted to prevent graphics problems related to depth sorting. Selecting
Unlimited Zoom allows an unrestricted zoom.

3. Select or clear Use GPU Rendering for Printing.

If your graphics hardware is compatible with GPU rendering, selecting this preference is strongly
recommended.

When selected, this preference causes saved pictures in CFD-Post to use GPU rendering and
saved pictures in CFX-Pre and TurboGrid to (by controlling the default value of a setting in the
Save Picture dialog box) use GPU rendering by default.

When you save a picture with GPU rendering, your graphics hardware renders an image that
closely matches what is shown in the viewer.

If GPU rendering is not set or cannot be used (for example, if compatible GPU hardware is not
found), software rendering is used instead. Software rendering is relatively slow and does not
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always render as shown in the viewer. One benefit of software rendering is that it has no
graphics hardware requirements.

Note:

Batch mode printing in CFX-Pre and TurboGrid does not support GPU rendering.

7.2.2.1. Mouse Mapping

The mouse-mapping options enable you to assign viewer actions to mouse clicks and key-
board/mouse combinations. These options are available when running in stand-alone mode. To
adjust or view the mouse mapping options, select Edit > Options, then Common > Viewer Setup
> Mouse Mapping. For details, see Mouse Button Mapping.

7.2.3. Units

1. Under System, select the unit system to use. Unit systems are sets of quantity types for mass,
length, time, and so on.

The options under System include SI, CGS, English Engineering, British Technical,
US Customary, US Engineering, or Custom. Only Custom enables you to redefine a
quantity type (for example, to use inches for the dimensions in a file that otherwise used SI units).

The most common quantity types appear in the main Options dialog box; to see all quantity
types, click More Units.

2. Select or clear Always convert units to Preferred Units.

If Always convert units to Preferred Units is selected, the units of entered quantities are imme-
diately converted to those set in this dialog box.

For example, if you have set Velocity to [m s^-1] in this dialog box to make that the preferred
velocity unit, and elsewhere you enter 20 [mile hr^-1] for a velocity quantity, the entered
value is immediately converted and displayed as 8.94078 [m s^-1].
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Chapter 8: CFX-Solver Manager Workspace Menu
The Workspace menu controls layout, plots, and text windows that are visible in the viewer. With the
Workspace menu you can:

• Back up, restart, or stop the current run

• Change the properties for the current workspace

• Create and modify monitors for simulations

• Create and modify derived variables

• Switch between multiple windows and tabbed layout (using the Toggle Layout menu option)

• Switch between viewing RMS and Maximum residual values at any time during or after a run.

This chapter describes the commands available from the Workspace menu:

8.1.Workspace Properties Command

8.2. New Monitor Command

8.3. New Derived Variable Command

8.4. Stop Current Run Command

8.5. Restart Current Run Command

8.6. Backup Run Command

8.7. Arrange Workspace Command

8.8.Toggle Layout Type Command

8.9. Load Layout Command

8.10. Save Layout Command

8.11.View RMS Residuals Command

8.12.View MAX Residuals Command

8.13. Reset to Default Workspace Command

8.14. Close Workspace Command

8.1. Workspace Properties Command

When loading a results file or starting a solver run, CFX-Solver Manager checks the type of run in order
to create the correct plots. For example, a volume fraction plot will be created for multiphase simulations.

By default, appropriate monitors are automatically created by CFX-Solver Manager for the particular
type of simulation you are running. However, the type and/or number of plots that appear can be
changed by using Workspace > Workspace Properties.
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The Workspace Properties dialog box has the following tabs:

8.1.1. General Settings Tab

8.1.2. Monitors Tab

8.1.3. Global Plot Settings Tab

8.1.4. Derived Variables Tab

8.1.1. General Settings Tab

The General Settings tab displays the following workspace information, which cannot be edited.

• Out File displays the path and name of the CFX-Solver Output file for the run displayed in CFX-
Solver Manager.

• Directory displays the path and name of the directory for the run displayed in CFX-Solver Manager.

The locations can be set in the Working Directory option when defining the run. For additional in-
formation, see Define Run Command (p. 115) and Run Definition Tab (p. 24). Information on selecting
different runs is available in Workspace Selector (p. 15).

8.1.2. Monitors Tab

Not all of the monitors relevant to a solution are displayed by default; however, you can add them
in the Monitors tab. The following types of monitors are available:

Plot Monitor

Plot monitors show the values of expressions versus timestep.

Residual Monitor

Residual monitors show the values of residuals for equation variables versus timestep.

Text Monitor

Text monitors show the contents of text files that are updated as the run proceeds.

8.1.2.1. Filter Selector

The Filter selector is a drop-down list that shows the monitor types available in CFX-Solver Manager.
Use this selector to control the monitors displayed under the Monitors tab. The All setting displays
the full list of available monitors.

8.1.2.2. Creating Monitors

Monitors can be created within Workspace Properties. However, they can also be created directly
from the Workspace menu by selecting New Monitor. For details, see New Monitor Com-
mand (p. 130).

1. Select Workspace > Workspace Properties.

2. Select Monitors.
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3. Click New .

The New Monitor dialog box is displayed.

4. Under Name, type the name of the new monitor.

5. Under Type, select Plot Monitor, Residual Monitor or Text Monitor.

6. Click OK.

The Monitor Properties dialog box is displayed.

7. Configure the monitor as required. For details, see CFX-Solver Manager Monitor Properties
Dialog Box (p. 147).

8.1.2.3. Modifying Monitors

Follow the procedure below to access Monitor Properties from Workspace Properties.

1. Select Workspace > Workspace Properties.

2. Select Monitors.

3. Select the monitor to modify.

4. Click Edit .

The Monitor Properties dialog box is displayed.

5. Configure the monitor as required. For details, see CFX-Solver Manager Monitor Properties
Dialog Box (p. 147).

8.1.2.4. Deleting Monitors

1. Select Workspace > Workspace Properties.

2. Select Monitors.

3. Select the monitor to delete.

4. Click Delete .

8.1.3. Global Plot Settings Tab

Plotting of coefficient loop/cloop data is turned off by default.
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For transient runs, this selects or clears plotting of cloop data for each inner loop. This is in addition
to plotting data for each outer loop/timestep. For details, see Transient Residual Plotting (p. 100).

Note:

As turning on the cloop setting results in a three to seven times increase in the size of the
monitor data file, it affects the performance of the CFX-Solver Manager.

1. Select Workspace > Workspace Properties > Global Plot Settings.

2. Select or clear Plot Coefficient Loop Data.

3. Under Plot Data By select Time Step or Simulation Time.

Variables are plotted against accumulated Time Step (the default) or against Simulation
Time. The latter is useful when using non-uniform timesteps.

4. (affects Cyclic XY and Polar chart types only)

Specify Cyclic Plot Settings:

a. Under Period Definition select, as applicable, Timesteps,  Time Period, or Time,
then provide a value. These options are the same as for the interval definition for a derived
variable, described in Derived Variable Properties (p. 128).

b. Under Period Offset select None, End of Run, Specified Timestep, or Specified
Time.

This determines whether and how to apply an offset to the period used for plotting purposes.
The options End of Run, Specified Timestep, and Specified Time each define
the end of a period for plotting purposes.

Descriptions of each option follow:

• None: The start of the period calculation is at time step zero (for periods specified by
time step) or at a time of 0 s (for periods specified by time). This is the default.

• End of Run: The end of the run is used as the end of a period. This setting is recom-
mended for completed runs, because it ensures that if you have asked for n cycles, you
get the full n cycles plotted and no partial cycles. However, for runs in progress, this would
mean that the whole plot would be shifted every time a new time step is completed.

• Specified Timestep: The start/end of the period calculation is user specified. This
is available if Period Definition is set to Timesteps or Time Period.

• Specified Time: The start/end of the period calculation is user specified. This is
available if Period Definition is set to Time.

c. If applicable, set Offset Timestep or Offset Time.

d. Set Number of Cycles to the number of cycles to plot. If you specify n cycles, there are n
lines on the plot for each plot variable selected for plotting.
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e. Optionally specify Plot Line Variation to control how the style or color of the plot lines
varies between cycles. When coloring is used, the latest cycle is displayed in the darkest
color. When dashed lines are used, the latest cycle is displayed with a solid line, and the
older cycles are displayed with progressively shorter dashes and dots. Note that there is a
limited number of dashed patterns; if the plot has more than five cycles, the oldest cycles
may not be distinguishable.

For more information on chart types, see Chart Type Settings Tab (p. 148).

8.1.4. Derived Variables Tab

Derived variables are calculated from monitor variables to visualize plot trends. For example, derived
variables can offset an existing plot or calculate statistics for the specified monitor variables on
moving intervals. Derived variables are not written to results files, but their values can be saved by
exporting plot data.

Derived variables may be applied to monitor variables through the Monitor Properties dialog box.
For details, see CFX-Solver Manager Monitor Properties Dialog Box (p. 147).

Note:

CFX-Solver can also create equivalent statistics for certain monitor points. For details on
setting up monitor statistics in CFX-Pre, see [Monitor Name]: Monitor Statistics in the CFX-
Pre User's Guide.

8.1.4.1. Creating Derived Variables

Derived variables can be created in Workspace Properties. However, they can also be created
directly from the Workspace menu by selecting New Derived Variable. For details, see New Derived
Variable Command (p. 130).

Note:

To create derived variables using the Monitor Properties dialog box, follow the procedure
below from Step 2.

1. Select Workspace > Workspace Properties.

2. Select Derived Variables.

3. Click New .

The New Derived Variable dialog box is displayed.

4. Under Name, type the name of the new derived variable.

5. Click OK.

The Derived Variable Properties dialog box is displayed.
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6. Configure the derived variable as required.

8.1.4.2. Modifying Derived Variables

Derived variables can be modified in Workspace Properties

Note:

To modify derived variables using the Monitor Properties dialog box, follow the proced-
ure below from Step 2.

1. Select Workspace > Workspace Properties.

2. Select Derived Variables.

3. Select the derived variable to modify.

4. Click Edit .

The Derived Variable Properties dialog box is displayed.

5. Configure the derived variable as required.

8.1.4.2.1. Derived Variable Properties

All adjustable Derived Variable Properties settings appear in the General Settings tab. The
two types of adjustable settings are Statistics and Offsets

Statistics

• From the Statistics Type drop-down, select a single statistical quantity for the derived
variable. If you select None, no other Statistics settings will be available. For a list of
available statistics and calculation details, see [Monitor Name]: Monitor Statistics in the
CFX-Pre User's Guide.

• Interval Option controls how frequently the values of the selected statistics are updated.
Each update, the values are calculated using the most recent iterations that fit into the in-
terval. Select one of the following:

– Moving Interval

Updates statistical values every iteration.

– Previous Complete Interval

Updates statistical values at the completion of the previous interval. The values remain
fixed until each subsequent interval is complete.

• Interval Definition controls the size of the evaluation interval. Different options are available
to steady-state and transient cases.

The following options are available to steady-state cases:
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– Timesteps

Specifies the interval as a number of solver iterations.

The following settings are available to transient cases:

– Time Periods

Specifies the interval as a number of operational periods. This setting is only available
to transient blade row cases in which both the time step and the number of time steps
per period are constant (including across any restarts).

– Time

Specifies the interval as an amount of simulation time.

– Timesteps

Specifies the interval as a number of time steps. All time steps within an interval are
given equal statistical weight, regardless of time step length.

Note:

The value of the statistic is always displayed at the end of the interval.

Offsets

• Change the X Axis Offset Type to Timesteps to shift the plot line by a specified number
of timesteps. By convention, a positive integer shifts the data to the right.

• Change the Y Axis Offset Type to Specified Offset to add a constant value to all
data points. The constant value is assumed to be in the displayed units for the given data.

8.1.4.3. Deleting Derived Variables

Note:

To delete derived variables using the Monitor Properties dialog box, follow the procedure
below from Step 2.

1. Select Workspace > Workspace Properties.

2. Select Derived Variables.

3. Select the derived variable to delete.

4. Click Delete .

129
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Workspace Properties Command



8.2. New Monitor Command

You can use this command to create a new monitor. However, if other properties associated with a
workspace need to be defined, use the Workspace Properties dialog box instead. Monitors can then
be created as required.

• Workspace Properties Command (p. 123)

• Monitors Tab (p. 124)

8.3. New Derived Variable Command

You can use this command to create a new derived variable. However, if other properties associated
with a workspace need to be defined, use the Workspace Properties dialog box instead. Derived
variables can then be created as required.

• Workspace Properties Command (p. 123)

• Derived Variables Tab (p. 127)

8.4. Stop Current Run Command

To stop the CFX-Solver as soon as possible, use one of the following methods:

• Select Workspace > Stop Current Run.

• Click Stop Current Run .

If running CFX-Solver from the command line, use the command: cfx5stop. For an example of the
cfx5stop command, see Command-Line Samples (p. 171).

When CFX-Solver stops, the run is marked as finished, and a message appears. This message names the
run and specifies it has terminated at your request. Additional information about the run is also listed.
Once manually terminated, a run can be manipulated in the same way that a completed run can.

8.4.1. Stopping Runs Using Mesh Adaption

If a stop current run command is issued for a run that uses mesh adaption, then only the current
CFX-Solver run is terminated; the overall simulation, which includes equation solution and mesh ad-
aption, is not. The CFX-Solver is automatically restarted after executing the next adaption step (if any
remain), and the simulation continues.

8.4.2. Stopping Runs Using Remeshing

If a stop current run command is issued for a run that uses remeshing, then the overall simulation is
terminated.
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8.4.3. Stopping Runs Using External Solver Couplings

If a stop current run command is issued for a run that uses external solver couplings, then the overall
simulation is terminated.

8.4.4. Stopping Multi-Configuration Runs

If a stop run command is issued in a workspace for a specific configuration, then only the current
CFX-Solver run for that configuration will be terminated; the overall simulation is not. All remaining
configurations that are defined for the simulation are subsequently run (unless a stop run command
is also issued for them). If a stop run command is issued in the simulation-level workspace, which is
labeled according to the name of the multi-configuration CFX-Solver Input file (*.mdef), then the
overall simulation is terminated. The CFX-Solver run for the configuration currently being executed
is terminated as soon as possible, and no additional configurations are executed.

8.5. Restart Current Run Command

You can restart a run that is finished or stopped. Restarting a run starts the run with the same settings
as the previous run, including Parallel settings.

There are numerous ways a run can be set up to restart; these are described in Restarting a Run (p. 43).
To perform the restart, either:

• Select Workspace > Restart Current Run.

• Click Restart Current Run .

8.6. Backup Run Command

Backing up a run creates a backup file of the results at the end of the timestep that is currently calcu-
lating. This file contains sufficient information for restarting a run for visualization. If a solution may be
diverging and an intermediate solution must be retained, you should generate backup files.

To back up a run, either:

• Select Workspace > Backup Run.

• Click Backup Run .

The backup file is stored in a subdirectory within the working directory. This subdirectory is given the
same name as the current run.

8.7. Arrange Workspace Command

Arranging the workspace deletes all monitors that are currently showing, regenerates them, and redisplays
them by optimizing the display based on available screen space. This has no impact on the display if
the layout type has been toggled to display multiple overlapping tabs. For details, see Toggle Layout
Type Command (p. 132).
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To arrange the workspace, either:

• Select Workspace > Arrange.

• Click Arrange Workspace .

8.8. Toggle Layout Type Command

Two layout modes exist. One is set up with multiple overlapping tabs used to switch between monitors
and the other displays each monitor in its own window. These may be toggled as required.

To toggle the workspace layout, either:

• Select Workspace > Toggle Layout Types.

• Click Toggle Layout Types .

8.9. Load Layout Command

Layouts can be loaded as required. Before loading a layout, there must be layouts that have been saved.
For details, see Save Layout Command (p. 133).

To load a previously saved layout:

1. Select Workspace > Load Layout or click Load Layout .

The Layout File dialog box is displayed.

2. Select the location containing the file to load.

3. Select the file to load.

4. Click Open.

As the new workspace replaces the existing one CFX-Solver Manager requires confirmation that
the new workspace should overwrite the existing one.

5. Click Yes.

The new layout is loaded.

8.9.1. Defining a Default Plot Monitor

Rather than creating plot monitors manually, one of the existing ones, Turbulent.mst or work-
space-basic.mst, can be duplicated and modified.

You can then select your modified file from Workspace > Load Layout in CFX-Solver Manager.

For example, you could modify a copy of the provided monitor file, Turbulent.mst, to include
the new variables as follows:
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Change these lines in Turbulent.mst

Variable Rule = CATEGORY = RESIDUAL ; SUBCATEGORY = RMS ; \
                EQN_TYPE = list:U-Mom/V-Mom/W-Mom/P-Mass

to

Variable Rule = CATEGORY = RESIDUAL ; SUBCATEGORY = RMS ; \
                EQN_TYPE = list:U-Mom/V-Mom/W-Mom/P-Mass/K-TurbKE/E-Diss.K

Note:

The monitor file Turbulent.mst can be found in the <CFXROOT>/etc/ directory.

The string for which a search is made can be found from the variable lists in the Plot Lines tab of
the Monitors dialog box. For details, see Plot Lines Tab (p. 152).

8.10. Save Layout Command

Once a layout has been configured to display preferred settings views, it can be saved. Once saved,
layouts can be loaded as required. For details, see Load Layout Command (p. 132).

This is useful when carrying out different runs for the same problem. For example, there may be a layout
with preferred settings after changing a boundary condition value. Another layout may be preferred
for viewing a turbulence model. By saving and loading a layout, it is simple to switch between these
views.

The saved layout fully restores settings only for problems with the same domain and boundary names
as the problem that was selected in the when the layout was saved. If the saved layout is loaded when
the current problem has different domain and/or boundary names, variables to plot must be reselected.
For details, see Defining a Default Plot Monitor (p. 132).

1. Configure the current layout to the appearance to save.

That is, display various monitors, position them, set up the layout type and so on.

2. Select Workspace > Save Layout.

The Layout File dialog box is displayed.

3. If required, set the path location to a different directory.

4. Under File name, type the name of the file to save.

5. Click Save.

If the name already exists, a warning dialog box is displayed.

• Overwrite replaces the old file with the new document.

• Re-select returns to the Layout File dialog box.

• Cancel closes the open dialog boxes.
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8.11. View RMS Residuals Command

To display the RMS values of the residuals, select Workspace > View RMS Residuals.

For more information about residuals, see Residual Plotting (p. 99).

8.12. View MAX Residuals Command

To display the MAX values of the residuals, select Workspace > View Max Residuals.

For more information about residuals, see Residual Plotting (p. 99).

8.13. Reset to Default Workspace Command

Resets the default workspace to the state it was in immediately after the run was started, or after a
finished run was loaded. This can be useful when retrieving plots that have been accidentally deleted,
or when reloading the original plots after a change to their definition.

Note:

Resetting the default workspace deletes any custom monitors.

1. Select Workspace > Reset to Default Workspace.

2. Click Yes.

8.14. Close Workspace Command

Closes all windows related to the current run. Any other runs that were open are not affected, and the
last open run prior to the current run is displayed. If the Solver was in progress on the current run, it
continues to operate in the background. The run can be re-monitored; see Monitor Run in Progress
Command (p. 115) or Monitor Finished Run Command (p. 115), as appropriate.
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Chapter 9: CFX-Solver Manager Tools Menu
The Tools menu controls layout, plots and text windows that are visible in the viewer. The current run
can also be backed up, restarted or stopped.

Properties for the current workspace can be changed, and new monitors created for simulations.

This chapter describes:

9.1. Edit CFX-Solver File Command

9.2. Export Command

9.3. Interpolate Command

9.4. Edit Run In Progress Command

9.5. CCL Propagation in Multi-Configuration Simulations

9.6. Edit Current Results File Command

9.7. Monitor Run with CFD-Post

9.8. Post-Process Results Command

9.9.View Environment Command

9.1. Edit CFX-Solver File Command

The command file section of a CFX-Solver input file can be modified. This enables modifications to a
CFX-Solver input file without the need to use CFX-Pre. The most useful application of this is in the
modification of a simulation when re-running the simulation may be too time consuming.

When a CFX-Solver input file is selected for modification, the Command File Editor is launched. For
details, see Editing CFX-Solver Input Files (p. 103).

1. Select Tools > Edit CFX-Solver File.

2. Browse to the directory containing the CFX-Solver input file to edit.

3. Select the CFX-Solver input file.

4. Click Open.

The Command File Editor is launched.

9.2. Export Command

If using tools other than CFD-Post for postprocessing, data must be exported to a results file in a sup-
ported format. The CFX Export utility can also be run from the command line.
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• File Export Utility (p. 185)

• Running cfx5export from the Command Line (p. 201)

There must be a results file to reference before exporting.

1. Select Tools > Export Results.

The Export dialog box is displayed.

2. Under Source > Results File, click Browse  and select a results file for export.

3. Under Source > Domain Selection > Name, select the domain to export.

Where multiple domains exist, select either one domain or all domains to export.

4. Set Timestep, Output Only, Mesh Options and Results Options as required. For details, see
Generic Export Options (p. 186).

5. Under Destination > Output Format select CGNS, MSC.Patran, FIELDVIEW, EnSight or
Custom User Export.

• CGNS (p. 187)

• MSC.Patran (p. 190)

• FIELDVIEW (p. 194)

• EnSight (p. 197)

• Custom User Export (p. 199)

6. If required, under Destination > Export File, click Browse  and set the output path and filename.

7. Under Destination > <output_format> Options, configure options as required.

The options are dependent on the Output Format. For details, see Output Format (p. 186).

8. Click Export.

Once completed, a message is displayed. Click OK to close it.

9.3. Interpolate Command

Ansys CFX enables the values from one results file to be interpolated onto a CFX-Solver input file con-
taining another mesh.

The major benefit of interpolation is the ability to use the solution from a simple model to provide initial
conditions for another, perhaps more complex, model (thereby increasing the likelihood of converging
the complex model simulation) or to continue a run with a different mesh or other settings.
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Interpolation can be used with modified geometry or boundary conditions. Interpolation can also be
used to interpolate the solutions from a model with different mesh topology. For example, the initial
guess for a problem having one domain can be interpolated from one or more results files having a
solution that spans multiple domains. When the shape of the model has changed and the initial values
files do not fully overlap with the new mesh, the CFX-Interpolator extrapolates values for the points in
the new mesh that lie outside the Initial Values File(s), based on the interpolated values on the mapped
nodes. See Using the CFX-Interpolator in the CFX-Solver Modeling Guide for more details on how the
CFX-Interpolator works.

The CFX-Interpolator is most commonly invoked through settings on the Run Definition tab on the
Configuration or Execution Control details view in CFX-Pre, or, the Define Run dialog box of the CFX-
Solver Manager. For details, see Run Definition Tab in the CFX-Pre User's Guide, Run Definition Tab in
the CFX-Pre User's Guide and Run Definition Tab (p. 24), respectively.

However, if you want to manually use the interpolator to write variables into a specific Solver Input File
(not invoked from the Run Definition tab) then you can choose Tools > Interpolate Results from the
CFX-Solver Manager. In this case the specified Mesh File is used as the target file, and will be modified
by the interpolation process. The text output is written into the CFX-Solver Manager's Interpolation
dialog box. You can then run the resulting target file in the CFX-Solver, using the variables written into
the target file by the CFX-Interpolator as the initial conditions for the run.

To manually interpolate the results from a source file to a target file, you can use the Interpolate Results
command as follows:

1. Select Tools > Interpolate Results.

The Interpolation dialog box is displayed.

2. Select the Interpolate method.

3. Set Results File to the name of the source file. You can click Browse  to select the file using a
browser.

4. Set Mesh File to the name of the target file. You can click Browse  to select the target file using
a browser.

You can interpolate onto a CFX-Solver Input file.

5. Optionally, set the precision: under Executable Settings, select Override Default Precision and
choose either Single or Double.

For details, see Double-Precision Executables (p. 178).

6. If required, under Interpolator Memory, adjust the memory configuration. For details, see Config-
uring Memory for the CFX-Solver (p. 38).

7. Click Interpolate.

The output window on the right displays details of the interpolation process.

Once completed, a message is displayed. Click OK to close it.
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You can also run the interpolator from the command line. For details see Using the Command Line to
Interpolate Results (p. 139).

Note:

• To save the results to a text file, right-click in the text output window and select Save As.

• Interpolating results from a source file to a target file that already contains solution data
is not recommended. See Interpolating Onto a Solver Input File with Results Fields in the
CFX-Solver Modeling Guide for details.

• Following the steps above, the interpolation is performed in Initial Guess mode. See Using
the CFX-Interpolator in the CFX-Solver Modeling Guide for details.

To generate a comparison of two files, you can use the Interpolate Results command. The comparison
is stored as new variables with the prefix Difference. These variables can be used in CFD-Post to
determine regions where the solution has changed significantly. A comparison of two files can be
generated as follows:

1. Select Tools > Interpolate Results.

The Interpolation dialog box is displayed.

2. Select the Calculate Differences method.

3. Set Original Results to the name of the original results file. You can click Browse  to select the
file using a browser.

4. Set Modified Results to the name of the modified results file. You can click Browse  to select
the file using a browser.

5. Optionally, set the precision: under Executable Settings, select Override Default Precision and
choose either Single or Double.

For details, see Double-Precision Executables (p. 178).

6. If required, under Interpolator Memory, adjust the memory configuration. For details, see Config-
uring Memory for the CFX-Solver (p. 38).

7. Click Calculate Differences.

The output window on the right displays details of the differencing process.

Once completed, a message is displayed. Click OK to close it.

Note:

CFD-Post now also supports comparison of two results files without the use of the CFX-Inter-
polator. For details, see Case Comparison in the CFD-Post User's Guide.
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9.3.1. Using the Command Line to Interpolate Results

In some instances, the cfx5interp script can be used from the command line to initiate an inter-
polation. This section presents a brief introduction to this script. For more information about this
script, type <CFXROOT>/cfx5interp -help at the command prompt.

To use the cfx5interp script, enter a command line of the form:

cfx5interp -res <results file> -mesh <CFX-Solver input file> [<arguments>]

where:

• <results file> is the name of a results file that contains a solution.

• <CFX-Solver input file> is the name of a CFX-Solver input file that contains a mesh onto
which the solution should be interpolated.

• [<arguments>] is an optional list of additional arguments.

cfx5interp rewrites the CFX-Solver input file with the interpolated form of the solution that was
read from the results file. A command of this form would produce the same results as running invoking
interpolation using Tools > Interpolate Results within the CFX-Solver Manager.

You can use the -difference argument to cause the interpolator to produce difference datasets
for differences in results between two results files. The form of such a statement is:

cfx5interp -difference -from <res file 1> -dest <res file 2> [<arguments>]

where:

• <res file 1> is the name of a results file that contains the original (older) set of fields

• <res file 2> is the name of a results file that contains the newer set of fields

• [<arguments>] is an optional list of additional arguments

cfx5interp calculates the differences between an original set of fields and the newer set, and re-
writes <res file 2> with the differencing information included.

The cfx5interp script can run two versions of the interpolator. The newer version (a solver-based
interpolator) runs by default, and the older one (that was released with Ansys CFX 10.0) can be invoked
by using the -interp-old argument.

When the older interpolator is used, the cfx5interp script is capable of producing a text file of
results for specific locations within the fluid domain. This is particularly useful if there is experimental
data to validate.

To produce a results text file, first create a text file containing the particular vertex coordinates of
interest, in the following format:

x(1) y(1) z(1)
x(2) y(2) z(2)
. . . .
x(n) y(n) z(n)
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Once the vertex file is created, run the old interpolator using a command line of the form:

cfx5interp -vtx <vertex file> -res <results file> -interpolate-old

The old interpolator creates a file with a name of the form: <vertex file>.inn, where nn is
chosen to make a unique filename. This is a text file that contains the coordinates that are specified
in the vertex file, plus the results from the results file interpolated to the vertex locations.

If, in the vertex file, there are coordinates that lie outside of the solution grid, values of 0.0E0 will be
assigned for all variables at those coordinates; that is, results are not extrapolated to a vertex file.

Note:

Some of the values obtained using the cfx5interp script may differ slightly from the
values obtained using Data Export in CFD-Post. These minor discrepancies result from dif-
ferent methods of calculation. Discrepancies are more likely to occur at points that lie very
close to the edge of the mesh elements or in regions of prism and hexahedral elements.
Inconsistencies are likely to be more significant where gradients are large, particularly in
the boundary layer.

9.4. Edit Run In Progress Command

You can edit the CCL definition of a CFX-Solver input file while the solver is running. The changes you
make take effect when saved and the modified CCL is pre-processed for the flow solver. The modified
CCL may take several iterations to be updated depending on system load, hardware and problem size.

These changes apply only to the run in progress, and do not affect the CFX-Solver input file that was
used to begin the run (if one was used). Before the next outer-loop iteration begins, a backup file named
<iteration number>.bak is written to the working directory. The backup file can be used to restart
the run from the point at which the CCL definition was changed, if needed.

Only selected CCL parameters can be dynamically changed. A list of these parameters is in the RULES
file. For details, see RULES File (p. 112).

The Command File Editor can also be used to make changes to the CCL contained in a CFX-Solver input
file. Changes, when saved, affect the edited CFX-Solver input file only, not any run in progress. For details,
see Editing CFX-Solver Input Files (p. 103).

To access the command file editor, select Tools > Edit Run In Progress or click .

Note:

The Edit Run in Progress command is not available for simulations involving transient blade
row modeling.

Note:

You must not change any references to regions while the CFX-Solver is running with topology
simplification active; doing so would cause the solver to stop. For details on topology simpli-
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fication, see the description for expert parameter topology simplification in Physical
Model Parameters in the CFX-Solver Modeling Guide.

9.5. CCL Propagation in Multi-Configuration Simulations

The Edit Run in Progress command is selected for the configuration being run, rather than in the
global (or simulation) level workspace. In addition to applying CCL changes to the running configuration,
some or all of the changes are also automatically propagated to subsequent configuration runs. In
particular:

• Changes made to the LIBRARY section of the CCL (such as material properties, expressions, reactions,
etc…) are propagated to all subsequent configurations, and

• Changes made to the FLOW section of the CCL (such as analysis type, boundary conditions, solver
and output controls, etc…) are propagated to all subsequent runs of the current configuration.

9.6. Edit Current Results File Command

Edit the CFX-Solver Results file in the current workspace (if available). This feature is available only when
there is a finished CFX-Solver Results file in the current workspace. For details, see Editing CFX-Solver
Input Files (p. 103).

To access the command file editor, select Tools > Edit Current Results File or click . The Command
File Editor is launched and the current results file is opened.

9.7. Monitor Run with CFD-Post

Starts CFD-Post with the appropriate connections to enable live monitoring. After you create the appro-
priate post-processing objects (or load a .cst file), you can view the solution as it evolves using the
Monitor menu or associated toolbar. For details, see CFD-Post Monitor Menu in the CFD-Post User's
Guide.

9.8. Post-Process Results Command

Loads the CFD-Post post-processor. For details, see Overview of CFD-Post in the CFD-Post User's Guide.

1. Select Tools > Post-Process Results.

The Start CFD-Post dialog box is displayed.

2. Under Results File, click Browse  and select a results file to load into CFD-Post.

3. If you want to load two results files into CFD-Post together, check Specify Additional Results File,
and select another results file to load.

4. Select Multi-Configuration Load Options in order to control how the results of a multi-configur-
ation run are loaded, or to load just the last case of such a run.
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5. Select or clear Shut down CFX-Solver Manager.

If selected, Ansys CFX-Solver Manager is shut down before CFD-Post is launched.

6. Click OK.

9.9. View Environment Command

Used to display a complete list of environment variables associated with the CFX-Solver Manager and
their settings.

1. Select Tools > View Environment.

The Solver Manager Environment dialog box is displayed.

2. Click Save to export the content to a text file.
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Chapter 10: CFX-Solver Manager Monitors Menu
The Monitors menu sets the display options for plots of your simulation.

Each menu option has a submenu. This is used to specify display options for a given category. Selected
options will display the related plot.

Residuals are combined by default in the CFX-Solver Manager. Residuals for each domain can be displayed
as required by selecting the residuals by domain in the submenu for each residual type.
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Chapter 11: CFX-Solver Manager Help Menu
The Help menu has the following commands:

CFX-Solver Manager

Opens CFX-Solver Manager User's Guide (p. 1).

Contents

Opens a page that lists various help resources associated with this product.

[various help resources]

Each of these commands goes directly to a particular help resource.

Ansys Product Improvement Program

Provides a brief description of, and enables you to control participation in, the Ansys Product Im-
provement Program.

About CFX-Solver Manager

This gives the point releases and software patches that are installed.

Help on Help

Opens documentation about the help system: Help On Help in the CFX Introduction.
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Chapter 12: CFX-Solver Manager Monitor Properties
Dialog Box
The Monitor Properties dialog box can be accessed either by modifying a monitor in Workspace
Properties or by right-clicking the graph area in any CFX-Solver Manager tab. Use Monitor Properties
to:

• Change basic display settings, such as name and visibility

• Change the range or scale of the sequence chart

• Create and modify derived variables

• Select a variable set and configure specific plot line variables

Monitor properties differ depending on the type of monitor. Up to five tabs are available to configure
monitor properties:

12.1. General Settings Tab

12.2. Chart Type Settings Tab

12.3. Range Settings Tab

12.4. Derived Variables Tab

12.5. Plot Lines Tab

12.1. General Settings Tab

1. Under Window Label, type the name to display for the monitor.

2. If working with a text monitor:

a. Under Text File Name, click Browse  and select a file containing the definition for the text
monitor.

This can be any CFX-Solver Output file.

b. Select or clear Disable this Monitor.

If selected, the monitor is disabled.

3. If working with a plot monitor or a residual monitor:

a. Under Background Color, click Color Selector  and set the background color.
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b. Select or clear Display Legend.

If selected, the legend is displayed in the monitor.

c. Under Grid Mode select Both, X, Y, or None.

This determines if grid lines appear along the X or Y axis, on both or not at all.

d. Under Grid Color, click Color Selector  and set the grid color.

4. Select or clear Visibility.

If selected, the monitor is displayed.

12.2. Chart Type Settings Tab

1. Under Chart Type, select from the following options:

• XY (the default) displays the selected monitor data as an ordinary XY plot.

• Cyclic XY is intended for use with transient periodic flows, where is it necessary to ensure
that each period is the same as the previous one to ensure convergence. The monitor data for
successive periods ("cycles") is plotted as a function of period phase, so that the data for successive
periods can easily be visually compared. A period and the number of cycles to plot must be
specified.
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• Polar is similar to Cyclic XY, except that instead of plotting the data against period, the
data is presented in a polar plot with one cycle representing 360°.

Cyclic XY and Polar plots each display solution monitors in a way that facilitates the visual evaluation
of convergence for transient periodic flows. They both overlay monitor data from successive periods,
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making the similarities and differences between periods readily apparent. Periodic convergence
has likely been reached when the plot line for the latest period is closely matched with that for
the previous period.

2. (Cyclic XY and Polar chart types only)

Specify Cyclic Plot Settings:

a. Under Period Definition select Workspace Default or, as applicable, Timesteps, Time
Period, or Time, then, if applicable, provide a value. Workspace Default causes the
plot to use the corresponding setting from the Workspace Properties dialog box, Global
Plot Settings tab. The other options are the same as for the interval definition for a derived
variable, described in Derived Variable Properties (p. 128).

b. Under Period Offset select Workspace Default, None, End of Run, Specified
Timestep, or Specified Time.

This determines whether and how to apply an offset to the period used for plotting purposes.
Workspace Default causes the plot to use the corresponding setting from the Workspace
Properties dialog box, Global Plot Settings tab. The options End of Run, Specified
Timestep, and Specified Time each define the end of a period for plotting purposes.

Descriptions of each option follow:

• None: The start of the period calculation is at time step zero (for periods specified by time
step) or at a time of 0 s (for periods specified by time). This is the default.

• End of Run: The end of the run is used as the end of a period. This setting is recommen-
ded for completed runs, because it ensures that if you have asked for n cycles, you get the
full n cycles plotted and no partial cycles. However, for runs in progress, this would mean
that the whole plot would be shifted every time a new time step is completed.

• Specified Timestep: The start/end of the period calculation is user specified. This is
available if Period Definition is set to Timesteps or Time Period.

• Specified Time: The start/end of the period calculation is user specified. This is available
if Period Definition is set to Time.

c. If applicable, set Offset Timestep.

d. Select or clear Override Workspace Default for Number of Cycles.

If you select it, then specify a number of cycles. If you clear it, then the number of cycles is as
specified in the Workspace Properties dialog box, Global Plot Settings tab.

e. If applicable, set Number of Cycles to the number of cycles to plot. If you specify n cycles,
there are n lines on the plot for each plot variable selected for plotting.

f. Optionally specify Plot Line Variation to control how the style or color of the plot lines varies
between cycles. When coloring is used, the latest cycle is displayed in the darkest color. When
dashed lines are used, the latest cycle is displayed with a solid line, and the older cycles are
displayed with progressively shorter dashes and dots. Note that there is a limited number of
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dashed patterns; if the plot has more than five cycles, the oldest cycles may not be distinguish-
able.

Note:

Workspace Default is the default for all the settings and causes the plot to use the
corresponding setting from the Workspace Properties dialog box, Global Plot Settings
tab. All plots using the Workspace Default setting are updated whenever the rel-
evant Workspace Properties dialog box setting is updated. The Workspace Properties
dialog box, Global Plot Settings tab is described in Global Plot Settings Tab (p. 125).

12.3. Range Settings Tab

1. Under Timestep Range Mode, select from the following options:

• Display All displays values for every iteration. If viewing a restarted run, results from the
previous run are also visible.

• Most Recent displays the current iteration and a number of previous iterations.

• Fixed displays a beginning and end iteration that is always displayed, regardless of the current
iteration number.

• This Run Only displays the range for the current run. If the run is a restart, previous runs
are not included in the range.

• This Run and Previous Timestep displays all timesteps for the current run and the last
timestep from any previous run. By selecting this option, plots will contain all data generated in
the current run and will also display the coefficient loop data for the previous timestep from any
previous run from which the current run was started.

2. Under Variable Axis, select or clear Use Logarithmic Scale.

If selected, Set Manual Scale (Log) is automatically selected.

3. Under Set Manual Scale (Log) or Set Manual Scale (Linear) set the Upper Bound and Lower
Bound values for the variable axis.

Note:

If you accidentally specify a lower bound that is higher than the upper bound, CFX-
Solver Manager will reverse the values internally to determine the range, but the values
you entered will not be changed in the user interface.

4. Complete the timestep configuration based on the Timestep Range Mode selected.

• Most Recent requires a value for Timestep Window Size.
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• Fixed requires values for First Timestep and Last Timestep.

12.3.1. Plotting by a Specific Variable

While the CFX-Solver is running, the default setting is to plot the data as a function of Accumulated
Time Step. However, you may choose to view the data as a function of any available variable.

For example, you may choose to plot an important monitored quantity as a function of residual level.
The existing residual plot provides information on the exact convergence level, while this plotting
feature gives another way to determine how far you need to converge the solution, by combining
residual information with monitored quantities. For example, if you were to plot Mass Averaged
Outlet Total Pressure vs. Mass Residual, you would see how quickly this important
quantity stabilizes as a function of the residual convergence level. You may then set a residual target
for future runs that causes the CFX-Solver to stop when the established residual levels are sufficient
for the "important monitored quantity".

You can change the variable that is plotted on the X axis for any specific plot as follows:

1. Right-click the plot you want to modify (see Convergence History Plots and User Point Plots (p. 15))
and select Monitor Properties from the shortcut menu.

2. On the Range Settings tab, set Plot Data By to Specified Variable and select the variable
you want to use as the X axis variable.

12.4. Derived Variables Tab

You can create and modify derived variables through Monitor Properties by following the same pro-
cedures given for Workspace > Workspace Properties. For details, see Derived Variables Tab (p. 127).

Check the boxes beside derived variables to apply them by default to all monitor variables plotted in
the current monitor. Any new monitor variable added to this plot will then automatically have the derived
variable applied. You can add or remove derived variables from individual plot lines in the Plot Lines
tab.

Note:

Derived variables are common to the workspace. Any modifications to a derived variable
definition will affect all monitors that use it.

12.5. Plot Lines Tab

Variables that are available to plot come from the selected source. Variable Set can be set to:

• CFX Solver: This option will be available for all CFX runs, and enables the specification of all variables
relating to the CFX run.

Display plot lines by selecting them in the tree view. The tree has three types of entries:

1. Categories
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• Expand a category by double-clicking it.

• Right-click a category to select or deselect all plot lines below it.

2. Variables

• Select or deselect individual plot line variables.

• Expand a variable by double-clicking it.

• If a derived variable of interest is not currently displayed, right-click and select Add Derived Plot
Line For Variable > <Derived Variable Name>.

• Right-click a variable to select or deselect all derived plot lines below it.

3. Derived variables

• Select or deselect individual derived plot line variables.

If working with a Residual monitor, you can set Residual Mode to either RMS or MAX. The Residual
Mode setting is the default visibility filter for variables of Residual type.

Note:

If you manually select a variable, it is plotted regardless of the Residual Mode setting.

12.5.1. CFX Plot Line Variables

While not all variable types are available at any given time, the following is a complete list of all
variable types available for monitoring a CFX run. The specific plot line variables available for a given
run are categorized by type.

For details on the output of the solver, see CFX-Solver Files (p. 47).

DescriptionVariable Name

Flutter calculations are important analysis tools in the design
of modern turbines, compressors, and/or fan rotors. The

AERODYNAMIC DAMPING

aerodynamic damping factor is the most important result
for these calculations. These results are later used to predict
failures due to flutter, and to estimate component life cycles.
Note that in order to monitor the aerodynamic damping,
aerodynamic damping monitor objects must be created in
CFX-Pre according to Setting up Monitors to Check Results
in the CFX-Solver Modeling Guide. For further information,
refer to sections Aerodynamic Damping in the CFX-Pre User's
Guide through [Aerodynamic Damping Name]: Integration
Interval in the CFX-Pre User's Guide and Case 3: Blade Flutter
in the CFX-Solver Modeling Guide.

Overall device efficiency can be monitored in CFX-Solver
Manager, and the values are based on mass average field

EFFICIENCY

efficiency at the selected outlet boundary condition.
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DescriptionVariable Name

Additionally, if requested in the solver, it is possible to
monitor "Isentropic Compression", "Polytropic Compression",
"Isentropic Expansion" and "Polytropic Expansion"
efficiencies. For further details, see Isentropic Efficiency and
Total Enthalpy in the CFX-Solver Modeling Guide. Note that
in order to monitor the device efficiency, the Efficiency
Output Check Box must be selected, according to Efficiency
Output Check Box in the CFX-Pre User's Guide.

The flows listed in the CFX-Solver Manager are the absolute
amounts of a variable transported through a boundary

FLOW

condition. For example, the flow for the continuity (P-Mass)
equation is the mass flow of a particular phase through the
boundary condition. The flow for the energy (H-Energy)
equation is the energy flow per unit time through the
boundary condition.

The pressure and viscous moments are related to the
pressure and viscous forces calculated at the wall. For details,

FORCE or MOMENT

see Calculated Wall Forces and Moments (p. 64) and Monitor
Forces: Option in the CFX-Pre User's Guide.

Percent imbalance is the normalized sum of the flows for a
given equation on a particular domain. The absolute flow

IMBALANCE

is normalized by the maximum flow, calculated by looking
at flows on all domains for that particular equation.

Negative accumulation is the transient term contribution
to the balance equation. For details, see the description for
"IMBALANCE" in this table.

NEG ACCUMULATION

If particles exist in your simulation, this category includes
monitor particle forces and moments on walls, particle

PARTICLE

source change rates, total particle mass flow rates at
boundaries or the particle injection region, and particle
penetration variables.

A radiometer is a user-defined point in space that monitors
irradiation heat flux (not incident radiation) at the required

RADIOMETER

location. For details, see Radiometers in the CFX-Solver
Modeling Guide. This variable can be used for specific
monitoring of radiation calculations with ray tracing.

For details, see Residual Plotting (p. 99).RESIDUAL

A rigid body is a solid object that moves through a fluid
without itself deforming. For details, see Monitor Plots

RIGID BODY

related to Rigid Bodies in the CFX-Solver Modeling Guide. An
automatically created rigid body monitor point must be
selected from the Monitors menu in order to view the
measurement of displacement of body on a global
coordinate frame. Note that all of the plot line variables
pertaining to a rigid body are with respect to the global
coordinate frame.
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DescriptionVariable Name

You can monitor source terms either over an entire domain,
or at particular regions of a domain, such as points,

SOURCE

boundaries and subdomains. If you have set up user-defined
source terms, the monitored region can also be user-defined.

Depending on which models are used, some source terms
are automatically computed and monitored over entire
domains by the solver. For example, source terms that
represent the production and dissipation of turbulence are
calculated as part of the turbulent kinetic energy equation.

Under the TIMESTEP branch of the tree on the Plot Lines
tab, the available variables are: Accumulated Timestep,
Current Timestep, and Time.

TIMESTEP

CFX-Solver Manager uses Current Timestep to show
the step the solver is currently on for the active run while
the solver works to achieve convergence in a given
simulation.

CFX-Solver Manager uses Time to show the elapsed physical
time of the simulation in the solution units. For details on
specifying solution units, see Setting the Solution Units in
the CFX-Pre User's Guide.

If monitor points have been created, a USER POINT
category is available. This can be expanded to select the

USER POINT

monitor points to plot. For details, see Monitor Tab in the
CFX-Pre User's Guide.
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Chapter 13: Starting the CFX-Solver from the
Command Line
The CFX-Solver is a separate module of CFX that has no graphical user interface. You can start CFX-
Solver from the command line by executing the following:

cfx5solve [<options>]

where [<options>] denotes the options applicable during a command-line run.

This chapter discusses:

13.1. Command-Line Use

13.2. Command-Line Options and Keywords for cfx5solve

13.3. Command-Line Samples

13.4. Specifying Multi-configuration Execution Control from the Command Line

Note:

You can also use CFX-Solver Manager to start CFX-Solver. The graphical user interface of the
CFX-Solver Manager enables you to set various options, allows easier control of the solution
process, and provides some visual details as the solution emerges. For details, see CFX-Solver
Manager Basics (p. 13).

13.1. Command-Line Use

CFX-Solver Manager and CFX-Solver can be launched from a command line as follows:

• The basic command to start CFX-Solver Manager is cfx5solve.

The more general form of the command is:

cfx5solve [-interactive [-definition <file>]]
[-display <display>] [-help]
[-solver <executable>] [-verbose]

where [ ] denotes a discretionary option, | separates mutually exclusive options, and < > denotes that
substitution of a suitable value is required. All other options are keywords, some of which have a
short form.

• The basic command to start the CFX-Solver using the CFX-Solver input file named <file> is:

cfx5solve -def <file> [-help] [-initial <file>]
[-double | -single]
[-nosave|-save] [-name <name>] [-size <factor>]
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[-solver <executable>] [-partition <number of partitions>]
[-parallel] [-parfile <file>] [-serial] [-verbose]

where [ ] denotes a discretionary option, | separates mutually exclusive options, and < > denotes that
substitution of a suitable value is required. All other options are keywords, some of which have a
short form.

How you invoke a command line depends on your operating system:

• On UNIX, you can run CFX-Solver Manager from a UNIX shell.

• On Windows, start a CFX command line from the Ansys CFX Launcher: Tools > Command Line. Al-
ternatively, you can run CFX-Solver Manager from a Command Prompt. For details, see Command
Line in the CFX Reference Guide.

The cfx5solve command-line options are described in the next section.

13.2. Command-Line Options and Keywords for cfx5solve

The command-line options for cfx5solve are described below. To see command-line help, from a
CFX command line run:

cfx5solve -help | more

Note:

When running the solver from the command line using a CFX-Solver input file or CFX-Solver
results file, any execution control CCL contained in the file takes precedence over the com-
mand-line options.

If an option is specified multiple times within the context of a specific configuration, then
the last specification of the option takes precedence.

UsageAlternative formCommand-Line
Options

Applying process affinity restricts execution
of a solver process to a processing element

-affinity <op
tion>

(for example, a CPU core) so that the
process is not free to migrate between
processing elements. This can improve
performance by increasing the use of
cached data. MPI implementations are
usually able to apply process affinity; this is
typically enabled by default, although the
behavior may vary depending on the
hardware and operating system
configuration.

The CFX-Solver accepts the following values
for <option> to control process affinity:
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UsageAlternative formCommand-Line
Options

implicit: This is the default option.
Affinity settings are not changed by the
solver. Any pre-existing affinity settings (for
example, from an MPI implementation) are
used unchanged. Note that processes are
not necessarily free to migrate to any
processing element because a preexisting
affinity setting may prevent this.

explicit: The solver applies process
affinity to its processes at runtime; any
pre-existing affinity setting is superseded
by the solver’s own affinity setting. A
summary is shown in the CFX-Solver Output
file, giving the topology of each host and
the result of the attempt to apply process
affinity. If there are fewer solver processes
than processing elements (that is, the hosts
are not fully loaded), the solver attempts to
distribute the processes as uniformly as
possible among the processing elements.

Note that Windows HPC systems may report
the host topology as being unavailable; this
is expected. In this case, the job scheduling
system usually sets the process affinity,
hence setting the affinity in the solver is
unnecessary.

In all cases, the solver checks if any other
CFX-Solver processes are running on the
hosts used. If other running processes are
detected, affinity is not applied by the solver
in order to avoid overloading a given
processing element, which can strongly
degrade performance.

Causes the flow solver to write a backup
file every <elapsed time frequency>

-baket <elapsed
time frequency>

-bak-elapsed-
time <elapsed

hours, minutes, seconds, et cetera. Elapsedtime fre
quency> time must be in quotes and have units in

square brackets. For example: -baket "10
[min]" or -baket "5 [hr]".

Starts CFX-Solver in batch mode (that is,
without starting the CFX-Solver Manager
interface).

-batch

Reads Command Language from the named
file, and uses it to provide defaults for the

-bg-ccl <file>

current run. If the file specifies a CFX-Solver
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UsageAlternative formCommand-Line
Options

input file for the run, the command
language contained in that CFX-Solver input
file will take precedence over that supplied.
Also see the -ccl option.

Reads additional Command Language from
the named file. Overrides most CFX

-ccl <file>

Command Language specified in the
CFX-Solver input file. If <file> is the single
character '-', the Command Language is
read from the standard input (usually the
terminal). If any settings are made in the
Command Language file that also occur on
the command line to the left of the -ccl
option, the settings in the file will take
precedence, as stated above. This option
may be repeated to include Command

Language from more than one file.[a]

Starts <executable> instead of the standard
Ansys CFX ccl2flow.

-ccl2flow <ex
ecutable>

Starts <executable> instead of the standard
Ansys CFX cclsetup.

-cclsetup <ex
ecutable>

Sets the working directory as specified.-chdir <direct
ory>

When running in batch mode, this will cause
cfx5solve to verify its options, but exit

-check-only

before starting any processes, and is mostly
for use by CFX-Solver Manager.

Applies subsequent options to the specified
configuration.

-config <con
figuration
name>

Uses initial values and continues the run
from the specified CFX-Solver results file.

-cont-from-file
<file>

-continue-
from-file
<file> The mesh from the CFX-Solver input file is

used unless the -use-mesh-from-iv
option is also specified. Only one
-continue-from-file argument can be
supplied. See Continuing the History in the
CFX-Solver Modeling Guide for more details.

Uses initial values and continues the run
from the most recent results for the named

-cont-from-con
fig <configura
tion name>

-continue-
from-configura
tion <configur
ation name>

configuration. The mesh from the
configuration (.cfg) file is used unless the
-use-mesh-from-iv option is also
specified. Only one
-continue-from-configuration argument can
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UsageAlternative formCommand-Line
Options

be supplied. See Continuing the History in
the CFX-Solver Modeling Guide for more
details.

Uses <file> as the solver input file for a
single configuration simulation. This may

-def <file>-definition
<file>

be a CFX-Solver input file or a CFX-Solver
results file for a restart. The file specified is
used in the same way as the input file on
the Define Run dialog box. For details, see
Define Run Command (p. 115). Also see the
-mdef option.

(UNIX only) Uses the X11 server <dis
play> instead of the X11 server defined
by the DISPLAY environment variable.

-display <dis
play>

Starts the double-precision version of Ansys
CFX Partitioner, Interpolator and Solver. Also
see the -single option.

-double

Starts the CFX-Solver using one of the
example CFX-Solver input files provided

-eg <file>-example
<file>

with the product. The example StaticMix
er is currently available.

Specifies the basename for the CFX-Solver
Output file, CFX-Solver Results file, and the

-fullname
<name>

temporary directory based on <name>
instead of the CFX-Solver input file name.
No numerical suffix (such as _001) is added
to the specified name.

Displays the help information for
command-line options.

-h-help

Uses the initial values in the CFX-Solver
results file <file>. The mesh from this

-ini <file>-initial
<file>

results file is used unless the -interpol
ate-iv option is also specified. This option
has been deprecated and should be
replaced by -initial-file or -contin
ue-from-file as appropriate.

Uses initial values from the most recent
results for the named configuration as a

-ini-conf <con
figuration
name>

-initial-con
figuration
<configuration
name>

basic initial guess for the run. The run
history from this file is discarded. The mesh
from this results file is used unless the
-interpolate-iv option is also
specified. See Continuing the History in the
CFX-Solver Modeling Guide for more details.
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UsageAlternative formCommand-Line
Options

Uses initial values from the specified
CFX-Solver Results file as a basic initial guess

-ini-file
<file>

-initial-file
<file>

for the run. The run history from this file is
discarded. The mesh from the configuration
(.cfg) file or the CFX-Solver input file is
used unless the -use-mesh-from-iv
option is also specified. See Continuing the
History in the CFX-Solver Modeling Guide for
more details.

Starts CFX-Solver Manager in graphic user
interface (GUI) mode. The CFX-Solver

-int

-manager

-interactive

Manager interface enables starting a new
run or managing or monitoring an existing
run.

Interpolates the solution from the initial
values file, if one is supplied (using the

-interp-iv-interpolate-
iv

-initial option), onto the mesh from
the CFX-Solver input file, rather than using
the mesh from the initial values file. This
option has been deprecated and should be
replaced by the -initial-file or
-continue-from-file option, as
appropriate.

When running with the solver-based
interpolator (-interp-iv option), this

-interp-double

option will select the double-precision
version of the interpolator. It will not
override the -interpolator option if
both are used.

Uses the single precision Ansys CFX
Interpolator executable.

-interp-single

Uses the large problem Ansys CFX
Interpolator executable.

-interp-large

When running with the interpolator (-in
terp-iv option), this option will start

-interpolator
<executable>

<executable> instead of the default
interpolator.

Keeps the .job file after an Ansys CFX
Solver run. This file contains a brief

-job

summary of various solution values, and is
most useful for regression purposes.

Keeps job file after an Ansys CFX Partitioner
run. This file contains a brief summary of

-jobp-job-part

various solution values, and is most useful
for regression purposes.
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Default to the large problem version of the
Ansys CFX Partitioner, Interpolator and
Solver.

-large

Specify a license preference file.-lpf <license
preference
file>

Sets the maximum elapsed time (wall clock
time) that CFX-Solver will run. Elapsed time

-maxet <elapsed
time>

-max-elapsed-
time <elapsed
time> must be in quotes and have correct units

in square brackets. For example: -maxet
"10 [min]" or -maxet "5 [hr]".

Uses <file> as the run continuation file
for an operating point case. This must be

-mcont <file>-mcontinuation
<file>

an operating point results file (that is,
.mres). The file specified is used in the
same way as the run continuation file on
the Operating Points tab of the Define
Run dialog box. For details, see Define Run
Command (p. 115) and Operating Points
Tab (p. 25).

Uses <file> as the solver input file. This
may be a multi-configuration or operating

-mdef <file>-mdefinition
<file>

point case definition file, or results file for
a restart (that is, .mdef or .mres,
respectively). The file specified is used in
the same way as the input file on the
Define Run dialog box. For details, see
Define Run Command (p. 115).

When starting Ansys CFX-Solver Manager,
use this option to monitor the run

-monitor
<file>

represented by <file>, which may be a
CFX-Solver Results file or CFX-Solver Output
file.

Treats the CFX-Solver input file as a
multi-configuration input file.

-multiconfig

Specifies the basename for exported files
and the temporary directory based on the

-name <name>

problem name <name> instead of the
CFX-Solver input file name, unless other
names are explicitly defined.

This name cannot be set when using the
CFX-Solver Manager to start the CFX-Solver.

Use this option to preprocess the CFX-Solver
input file only, without running the

-norun

CFX-Solver executable. When used with a
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multi-configuration CFX-Solver input file,
this option produces complete solver input
files for the individual configuration (.cfg)
files. When used with the "-config"
option, only the specified configuration is
preprocessed.

Non-Uniform Memory Access (NUMA) is a
hardware feature that associates regions of

-numa <option>

memory with specific groups of CPU cores.
Although all memory is generally accessible
from any CPU core, the fastest access is to
local memory.

NUMA memory containment can improve
performance by restricting memory access
for a solver process to its local memory.

If a solver process requires more memory
than a single NUMA node can provide,
NUMA containment can cause a failure
because memory outside the local NUMA
node is inaccessible. Parallel runs using
relatively few CPU cores, having memory
requirements close to the system limit, or
widely differing between partitions, may be
susceptible to this problem. NUMA memory
containment is disabled by default and is
not available for the partitioner or
interpolator because these run as serial
processes that often have a high memory
requirement. Failures of this type are likely
to be abrupt; as in the event of an ‘out of
memory’ condition, the operating system
terminates the offending process. Therefore
if NUMA containment has been enabled and
the solver fails without giving any
diagnostics, a repeat run without NUMA
containment should be considered.

<option> can be set to:

none: (default)

auto

Use this option to specify the job summary
format in the CFX-Solver Output file. <op
tion> may be set to:

-output-sum
mary-option
<option>

0: minimal
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1: terse format (default, no information per
partition)

2: compact format (one line per partition)

3: verbose format (the default prior to Ansys
CFX Release 15.0)

Use this option to set the comma-separated
<host-list> in the same form as is used

-par-dist
<host-list>

in the Command Language definition. This
option does not require the -partition
option, as one partition is run on each host
mentioned in the list. To run multiple
partitions on the same host, it may be listed
multiple times, or an asterisk may be used
with the count, as in
"wallaby*3,kangaroo*4" for a
7-partition run.

Host details are taken from the
hostinfo.ccl file, if they are there;
otherwise, if possible, the required
information will be automatically detected.
<host> may be specified as
[<user>@]<host
name>[:<CFX_ROOT>], if the user name
or the Ansys CFX installation root directory
differs from the local host.

When running in parallel, uses the specified
host list. See the -par-dist option for

-par-host-list
<host1>

details of the host list. This option defaults[,<host2>
[,...]] to Intel MPI Local Parallel on UNIX/Linux

platforms and Windows.

When running in parallel, uses only the local
host. This will override the -par-dist or
-par-host-list options.

-par-local

Starts the solver in parallel mode. This
option can be combined with -partition

-par-parallel

for a partitioning run. If the -part option
is not specified, then the -parfile-read
option must be used to specify a valid
partitioning information file.
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Specifies the name of an input partition file
used to set up a partitioning or parallel run.

Note:

Only *.par files that are
generated in Ansys CFX 12.0 (or

-parfile-read
<parfile>

later) are supported. For details,
see CFX Partition File (p. 91).

When used with a parallel run, saves the
partitioning information to a file with the

-parfile-save

same basename as the results file, and the
extension .par.

Specifies the name of a partition file to
which to write the information from a
partitioning run.

-parfile-write
<parfile>

Starts the solver in partitioning mode. This
option should not be used if an existing
partition file is also specified.

-part <number
of partitions>

-partition
<number of
partitions>

Starts <executable> instead of the
standard partitioner.

-partitioner
<executable>

Activates coupled partitioning mode for
multidomain problems. This is not activated
by default.

-part-coupled

Activates independent partitioning mode
for multidomain problems. This is the
default.

-part-independ
ent

Starts the large problem partitioner, which
can partition problems up to 2^31-1

-part-large

elements. This partitioner uses 64-bit integer
and logical variables so it will allocate more
memory than the default partitioning
executable.

Sets the partitioning mode to use when
running the partitioner. Valid options are

-part-mode
<mode>

metis-kway (MeTiS k-way), metis-rec
(MeTiS Recursive Bisection), simple (Simple
Assignment), drcb (Directional Recursive
Coordinate Bisection), orcb (Optimized
Recursive Coordinate Bisection), rcb
(Recursive Coordinate Bisection)
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Finer control over the partitioning method
is available through the Command
Language.

Starts the solver in partitioning mode only.
This is normally equivalent to -part, but

-part-only
<number of
partitions> may be necessary if partitioning a results

file from a previous run.

Uses the single precision Ansys CFX
Partitioner. This is the default, but is

-part-single

provided for overriding any information that
might be stored in the CFX Command
Language dataset in a file from previous
runs. Also see the -double option.

Enables the specification of a job priority to
a solver run; the allowed values are Idle

-pri <level>-priority
<level>

(0), Low (1), Standard (2), and High (3).
The default value is Standard, which
corresponds to a nice increment of 0 on
UNIX platforms or a priority level of Normal
on Windows platforms. Note that on UNIX
platforms, Standard and High job priorities
both yield a nice increment of 0.

In addition to the files in the working
directory, this option also considers results

-respect-suf
fix-history

files referenced by initial values files when
choosing the numerical suffix (such as _001)
added to the run name.

Use this option to avoid deleting any
temporary files after the run. Normally the

-save

standard temporary files created by
CFX-Solver are deleted automatically after
each run.

Use this option to explicitly specify that a
serial run is required. This is useful when

-serial

restarting a run from a results file produced
by a parallel run, where this option forces
a serial run instead.

Starts the single-precision version of the
CFX-Solver, Partitioner, and Interpolator.

-single

This is the default, but is provided for
overriding any information that might be
stored in the CFX Command Language
dataset in a file from a previous run. Also
see the -double option.
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Changes memory estimates used by the
CFX-Solver by a factor of <factor>.

-S <factor>

-s <factor>

-size <factor>

Memory estimates are sometimes inaccurate
and this option must to be used to increase
the memory allocated. For example, using
-size 1.05 increases memory allocated
by 5%. This option provides the same
functionality as set in Solver Memory. For
details, see Solver Tab (p. 35).

Further options for controlling the
CFX-Solver memory allocation are available.
Execute cfx5solve -help for full details.

These flags are for advanced users to
change the memory allocation parameters

-scat <size>

-nr <size>

-size-cat
<size>

-size-nr
<size>

for the solver. Usually, you should use the
-size option instead. <size> is the
desired memory allocation in words, and-ni <size>

-nd <size>-size-ni
<size>

may have K or M appended for kilo or mega.
If the suffix is 'x', then the number is treated
as a multiplier.-nc <size>

-size-nd
<size> -nl <size>

-size-nc
<size>

-size-nl
<size>

Changes the memory estimates used by the
Ansys CFX cclsetup executable by a
factor of <factor>.

-sizeccl
<factor>

-size-cclsetup
<factor>

These options are the same as the -size-*
options above, but provide sizes needed for
the Ansys CFX CCL Setup executable.

-scatccl <size>

-nrccl <size>

-niccl <size>

-size-
cclsetup-cat
<size>

-size-
cclsetup-nr
<size> -ndccl <size>

-ncccl <size>-size-
cclsetup-ni
<size>

-nlccl <size>

-size-
cclsetup-nd
<size>

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.168

Starting the CFX-Solver from the Command Line



UsageAlternative formCommand-Line
Options

-size-
cclsetup-nc
<size>

-size-
cclsetup-nl
<size>

Changes the memory estimates used by the
solver-based interpolator by a factor of
<factor>. Also see the -size option.

-sizeint
<factor>

-size-interp
<factor>

These options are the same as the -size-*
options above, but provide sizes needed for
the Ansys CFX Interpolator.

-scatint <size>

-nrint <size>

-niint <size>

-size-interp-
cat <size>

-size-interp-
nr <size>

-ndint <size>-size-interp-
ni <size>

-ncint <size>

-size-interp-
nd <size> -nlint <size>

-size-interp-
nc <size>

-size-interp-
nl <size>

Changes the initial MMS catalogue size
estimate used by the CFX-Solver by a factor

-smms <factor>-size-mms
<factor>

of <factor>. This option has been
deprecated and should be replaced by
-size-cat.

Changes the initial MMS catalogue size
estimate used by the partitioner by a factor

-smmspar
<factor>

-size-part-mms
<factor>

of <factor>. This option has been
deprecated and should be replaced by
-size-part-cat.

Changes the memory estimates used by the
Ansys CFX Partitioner by a factor of

-sizepart
<factor>

-size-part
<factor>

<factor>. Also see the -size option.
-sizepar
<factor>

-size-par
<factor>

Further options for controlling the
partitioner memory allocation are available.
Execute cfx5solve -help for full details.

These options are the same as the -size-*
options, but provide sizes needed for par
titioner rather than solver.

-scatpar <size>

-nrpar <size>

-nipar <size>

-size-part-cat
<size>
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-size-part-nr
<size>

-ndpar <size>

-ncpar <size>
-size-part-ni
<size> -nlpar <size>

-size-part-nd
<size>

-size-part-nc
<size>

-size-part-nl
<size>

Starts <executable> instead of the
standard Ansys CFX solver on <os>, where

-exec
[<os>=]<execut

-solver
[<os>=]<execut

<os> is the short architecture string for theable>able>,
desired operating system. If <os> is[,<os>=<execut

able>[, ...]]
<os>=<execut
able>[...]] omitted, then the current operating system

is assumed.

For example: the command-line option
-solver "linux-amd64/mysolv
er.exe,linux=linux/mysolv
er.exe" uses the executable
"linux-amd64/mysolver.exe" for the current
operating system and the executable
"linux/mysolver.exe" for the "linux"
operating system. Full paths or paths
relative to the working directory may be
used when specifying solver executables.
In this example, it is worth noting that the
current operating system is presumed to be
"linux-amd64", and that the
"linux-amd64/mysolver.exe" and
"linux/mysolver.exe" will be used for all
solvers running on "linux-amd64" and "linux"
operating systems, respectively.

The string value for <os> can be
determined by running the following
command:

• On Unix-like systems, execute <CFX
ROOT>/bin/cfx5info -os.

• On a Windows system, execute <CFX
ROOT>\bin\cfx5info -os.
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where <CFXROOT> is the path to your
installation of Ansys CFX.

Uses the double precision Ansys CFX Solver.-solver-double

Uses the single precision Ansys CFX Solver.-solver-single

Uses the large problem Ansys CFX Solver.-solver-large

Uses the named start method to start the
solver. This option enables you to use

-start-method
<name>

different parallel methods, as listed in the
CFX-Solver Manager user interface, instead
of the defaults. For parallel runs, you also
need to provide the -part or -par-dist
options.

Uses the mesh from the source initial values
(that is, from a file or configuration) rather

-use-mesh-
from-iv

than from the solver input file. This is only
valid if a single initial-values source is
specified.

Specifying this option may result in
additional output being sent to the standard
output file (normally the screen).

-v-verbose

Changes that affect the way that the mesh is defined, or that affect the way that the
physics CCL relates to the topology of the mesh that is stored in the solver input file, cannot

[a]

be made using the -ccl argument. For example, locators for applying physics cannot be
modified using the -ccl option. Such changes can, however, be made in CFX-Pre. For
details, see Solver Tab (p. 35).

13.3. Command-Line Samples

Here are some examples to help clarify the use of the command line:

Start CFX-Solver

To start CFX-Solver running from the CFX-Solver input file model.def, enter the command:

cfx5solve -def model.def

If the input file is for a multiple configuration (.mdef file), enter the command:

cfx5solve -mdef model.mdef

Start CFX-Solver Manager

To start CFX-Solver Manager, passing it the name of the CFX-Solver input file, enter the command:

cfx5solve -interactive -def model.def

171
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Command-Line Samples



Produce a Partition File

To produce a partition file with the MeTiS partitioning method and seven partitions, but not run CFX-
Solver to solve for the solution, enter the command:

cfx5solve -def model.def -partition 7

This command will produce a file named model_001.par in the local run directory.

Note:

If the file model.par exists in the working directory, then the partition type (MeTiS, Rec
CoordBis or SpecDir) is read from this file, even if you have not specified the file mod-
el.par. Because this could potentially be confusing, you are advised to use the CFX-Solver
Manager to set up a partitioning run, unless you are certain that either there is no file mod-
el.par or that the partitioning method specified in the model.par file is what you require.

Start CFX-Solver in Local Parallel

To run CFX-Solver in parallel, starting from the CFX-Solver input file model.def and running only on
the local machine with two partitions, enter the command:

cfx5solve -def model.def -par-local -partition 2

If you have already created a file model.par (for instance, by using the command cfx5solve -def
model.def -partition 7), then you can run the parallel CFX-Solver by entering the command:

cfx5solve -def model.def -par-local -parfile-read model.par 

To run the CFX-Solver in parallel for the configuration named <config> and in serial for other config-
urations in a multi-configuration simulation, enter the command:

cfx5solve -mdef model.mdef -config "<config>" -par-local -partition 2

Start CFX-Solver in Distributed Parallel

Note:

To ensure that the following example works, define the hosts hosta, hostb and hostc in
the central hostinfo.ccl file. (cfx5solve attempts to automatically detect hosts that
are not listed in hostinfo.ccl, but this is not guaranteed to work.)

To run CFX-Solver in distributed parallel, starting from the CFX-Solver input file model.def, and using
one partition on hosta, two partitions on hostb, and four partitions on hostc, for a total of seven
partitions, enter the command:

cfx5solve -def model.def -par-dist 'hosta,hostb*2,hostc*4'
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Start CFX-Solver in Parallel

To start the CFX-Solver in parallel with four partitions on two hosts, enter the command:

cfx5solve -def file.def -par-dist 'hosta*2,hostb*2'

If you have already created a partitioning file, say model.par (for instance, by using the command
cfx5solve -def model.def -partition 7), then you can execute the distributed parallel
run as follows:

cfx5solve -def model.def -parfile-read model.par -par-dist \
   'hosta,hostb*2,hostc*4'

The number of partitions specified using the -par-dist command-line flag must be the same as that
in the partitioning file, model.par, or the run will fail.

Start CFX-Solver in Parallel with Cray MPI

To start the CFX solver in parallel on a system running the Cray Linux Environment, having reserved
the required processing elements via the built-in batch queuing system:

cfx5solve -def model.def -start-method "Cray MPI Distributed Parallel"

Preprocess Incomplete Configuration Files

Configuration definition (.cfg) files that are created in conjunction with a multi-configuration simu-
lation file (.mdef) are incomplete; they do not contain global information like equation and material
definitions.

To preprocess the configuration files so that they are complete and can be run independently of the
multi-configuration simulation, enter the command:

cfx5solve -mdef model.mdef -norun 

To preprocess the configuration definition file corresponding to the configuration name <config>,
enter the command:

cfx5solve -mdef model.mdef -config "<config>" -norun

Stopping the CFX-Solver from the Command Line

After CFX-Solver is running, stop it by using cfx5stop from the command line.

Suppose a run is called mixer_001 in the current directory. There will be a temporary directory called
mixer_001.dir in the current directory while that run is actually running. To stop the run, enter the
following command line:

cfx5stop -directory mixer_001.dir

173
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Command-Line Samples



13.4. Specifying Multi-configuration Execution Control from the Com-
mand Line

For multi-configuration cases, the -ccl command line option can be applied to specific configurations,
or globally, but the order of precedence differs.

If you use the -ccl command line option to specify Execution Control settings, but after the -config
command line option, then any configuration-specific settings take precedence over any global settings.
This is also true for Execution Control settings specified using CFX-Pre or CFX-Solver Manager.

If you specify Execution Control settings globally using the -ccl command line option, but not after
the -config command line option, those Execution Control settings are applied to each configuration.
Furthermore in this case, any global Execution Control settings specified using CFX-Pre or CFX-Solver
Manager take precedence over any configuration-specific Execution Control settings provided by the
-ccl command line option.
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Chapter 14: CFX-Solver Start Methods
CFX-Solver Start Methods define allowable parameters and command-line arguments used by CFX-
Solver Manager and CFX-Solver scripts to launch the CFX-Solver executable and perform a run. You can
modify the definition of the solver start methods to customize solver start-up for specific parallel or
batch queuing environments.

The standard start methods for a CFX installation are contained in the <CFXROOT>/etc/start-
methods.ccl file. These can be over-ridden by placing a custom version of this file in the same location
as the site or CFX user configuration files.

14.1. Direct Start Methods

Solver start methods that directly run the CFX-Solver executable are known as Direct start methods,
and are commonly used for defining solver execution in serial or parallel on local networks. The definitions
of solver start methods for specific parallel environments can be made following the various available
MPI methods in the start-methods.ccl file.

14.2. Indirect Start Methods

Solver start methods can also be used to launch a user-defined script or program that can perform
system interaction before re-executing a cfx5solve command under a different environment or system.
These are known as indirect start methods, and are commonly used for executing CFX-Solver runs on
remote or batch queuing systems.

Supported indirect start methods include:

• Submit to Windows HPC Queue

• Submit to UGE Queue

• Submit to SLURM Queue

Modification or creation of Indirect Start Methods requires knowledge of a system scripting language
(such as bash or Perl) to customize the solver start-up process for your specific environment.

Note:

For the "Submit to UGE Queue" and "Submit to SLURM Queue" start methods

• Both the submitting host and the cluster head node must be Linux systems.

• The working directory must be provided by a shared file system, accessible by the submit-
ting machine and the cluster head node.
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• It must be possible to run remote shell commands on the head node without a password
prompt. See Setting Up Remote Access on Linux in the Ansys, Inc. Installation Guides.

• The Ansys installation on cluster and client must be the same or have the same path (ac-
cessible by all participating machines) unless explicitly specified otherwise in the
hostinfo.ccl file.

• It is possible to specify the direct start method by using the cfx5solve command line
option -indirect-options. For example:

-indirect-options "start-method=Open MPI Distributed Parallel"

For the "Submit to UGE Queue" start method

• On the UGE head node, the environment must be configured so that (1) UGE commands
can be run non-interactively without a full path and (2) the SGE_ROOT environment variable
is set.

• The $SGE_ROOT/default/common/settings* scripts should provide the necessary
configuration, but how this is implemented depends on the default shell:

– For the csh shell, the requirements can usually be met system-wide by sourcing the file
$SGE_ROOT/default/common/settings.csh from a script in /etc/profile.d.

– For the bash shell, the requirements can usually be met by sourcing the file
$SGE_ROOT/default/common/settings.sh from the user’s .bashrc file.

You can verify that the settings of the SGE_ROOT and PATH are correct from the output
of the following command:

ssh <head node> env

• You can add host definitions manually by editing the hostinfo.ccl file. You can altern-
atively add hosts to the hostinfo.ccl file by using the cfx5parhosts command
with the -add-uge option.

For the "Submit to SLURM Queue" start method

• On the UGE head node, the environment must be configured so that SLURM commands
can be run non-interactively without a full path.

You can verify that the settings of the PATH are correct from the output of the following
command:

ssh <head node> env

• You can add host definitions manually by editing the hostinfo.ccl file. You can altern-
atively add hosts to the hostinfo.ccl file by using the cfx5parhosts command
with the -add-slurm option.
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Chapter 15: CPU and Memory Requirements
This chapter provides information on typical increases in CPU (central processing unit) time and memory
requirements incurred by some simulations and physical models:

15.1.Tetrahedral Mesh

15.2. Executable Selection

15.3.Turbulence

15.4. Energy Models

15.5. CHT Regions

15.6. Multicomponent Flows

15.7. Multiphase Flows

15.8. Additional Variables, Wall Distance Variables, and Boundary Distance Variables

15.9. Combustion Modeling

15.10. Radiation Modeling

15.11. GGI Interfaces

15.12.Transient Runs

15.13. Mesh Deformation

15.14. Bidirectional (Two-Way) Couplings with System Coupling

15.1. Tetrahedral Mesh

The ratio of elements to nodes is approximately 5:1 for a tetrahedral mesh. For example, if 5 million
tetrahedral elements are in a mesh, then there are approximately 1 million nodes. This is in contrast to
a hexahedral mesh where the ratio of elements to nodes approaches 1:1 as the grid becomes large.

Memory required for a tetrahedral mesh is about 0.4 times the memory required for a hex mesh of the
same number of elements. Alternatively a tetrahedral mesh has about 2 times the required memory of
a hexahedral mesh with the same number of nodes.

15.2. Executable Selection

A single executable provides partitioning, interpolation, serial solution and parallel solution capabilities.

The default executables (for various platforms) store floating point numbers as 32-bit words (single
precision) and integer numbers as 32-bit words.

In addition to the default executables, there are double-precision versions of these executables, large
problem versions of these executables, and versions of these executables that have both double-precision
and large problem capabilities.
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The executables used for partitioning, interpolation and solution are independently selectable and depend
on the applicable "precision" setting and "large problem" setting, which can be specified:

• At the cfx5solve command line.

For details, see Command-Line Options and Keywords for cfx5solve (p. 158).

• From CFX-Solver Manager (and the similar execution control and configuration control settings in
CFX-Pre).

For details, see The Define Run Dialog Box (p. 24), Executable Settings (p. 31), Solver Tab (p. 35), In-
terpolator Tab (p. 37).

Double-Precision Executables

Double-precision executables store basic floating point numbers as 64-bit words. These executables
are available to permit more accurate numerical mathematical operations. Double precision accuracy
might be needed if the computational domain involves a huge variation in grid dimension, aspect ratio,
pressure range, and so on.

When double precision is used, the computer memory used for a given problem and grid size is effectively
double that of the default (single precision) executable. Stated another way: the maximum problem
size to run on a given computer for the double precision executable is half that of the default single
precision executable.

Large Problem Executables

Large problem executables store integer numbers as 64-bit words. These executables allow larger mesh
sizes than the default executables.

A large problem executable requires twice the integer memory of a default executable, for a given
problem and grid size. There is no advantage to using a large problem executable unless the problem
size requires it.

Use in Partitioning and Interpolation

The default executable is currently limited to allocate 2^31-1 words of 4-byte integer stack space; this
limits the maximum problem size for partitioning to approximately 80 million elements (structured)
and 200 million elements (unstructured). Similar limits exist for interpolation.

Larger problems are likely to require the use of a large problem executable. In theory, a maximum
problem size of two billion elements can be partitioned with this executable. However, practical consid-
erations, such as available computer resources, will still limit the maximum size.

Use in Solution

The default solver is currently limited to a problem size of approximately 700 million nodes. Larger
problems require the use of a large problem executable. In theory, a maximum problem size of two
billion nodes can be accommodated.

As with partitioning and interpolation, the maximum size of a given parallel partition and the maximum
problem size of serial solutions are limited in the default executables by an allocation limit of 2^31–1
words for any memory stack. This limitation does not apply to large problem executables.
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15.3. Turbulence

The following topics will be discussed:

• Zero Equation Model (p. 179)

• Two-Equation Models (p. 179)

• Reynolds Stress Model (p. 179)

Zero Equation Model

The use of this model incurs a small increase in CPU time and memory requirements compared to
laminar flow.

Two-Equation Models

Two additional scalar equations are solved when using two-equation turbulence models. The SST
model has a slight additional cost over other two-equation models because a wall-scale equation is
also solved.

Consider the case of single-phase, single-component laminar flow in which the U-Mom, V-Mom, W-
Mom, and P-Mass equations are solved. Expect a CPU cost increase on the order of 50% by the addition
of a two-equation turbulence model. Memory requirement increases are small.

Reynolds Stress Model

This model adds six scalar equations for each of the Reynolds Stresses as well as the Eddy Dissipation
equation. It is approximately 2.5 times more expensive than the two-equation turbulence models.

Consider the case of single phase, single component laminar flow in which the U-Mom, V-Mom, W-Mom,
and P-Mass equations are solved. Expect a CPU cost increase on the order of 120% by the addition of
a Reynolds Stress turbulence model. Memory requirement increases are small.

15.4. Energy Models

Both the thermal and total energy models require the solution of an additional scalar equation. The
solution of the energy equation typically requires 1/3 of the CPU required for the U-Mom, V-Mom, W-
Mom, and P-Mass equations. Memory requirement increases are small.

15.5. CHT Regions

Only the energy equation is solved in CHT regions, so compared to the same number of nodes in a
fluid region, the CPU costs are much less (U-Mom, V-Mom, W-Mom and P-Mass are not solved).
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15.6. Multicomponent Flows

Each additional component adds an extra scalar equation. Therefore, as the number of components
increase, CPU time required to solve the Mass Fraction equation increases linearly. Expect each component
to add approximately 25% to the CPU required for the U-Mom, V-Mom, W-Mom and P-Mass equations.

15.7. Multiphase Flows

The following topics will be discussed:

• Homogeneous Model (p. 180)

• Inhomogeneous Model (p. 180)

• N-Phase Flow (p. 180)

Homogeneous Model

For two-phase flow using the homogeneous model, expect memory requirements to increase by a
factor of 1.5 and CPU time to increase by a factor of 1.7 over the same single-phase simulation. Enabling
free surface does not significantly alter CPU or memory requirements.

Inhomogeneous Model

For two-phase flow using the particle or mixture models, expect memory requirements to increase by
a factor of 2.15 and CPU time to increase by a factor of 2.25. Enabling free surface does not significantly
alter CPU or memory requirements.

N-Phase Flow

As the number of fluids increase, expect memory and CPU requirements to increase approximately linearly
for small N. Tetrahedral meshes have more of a linear increase than hexahedral meshes. The table below
gives approximate memory increase factors for up to 5 phases when compared to the same single-
phase simulation on a hexahedral mesh.

Memory Increases# of
Phases (Tet Mesh)(Hex Mesh)

1.8011

3.402.152

5.703.503

8.055.154

10.607.005

Expect the CPU factor to be slightly less than the corresponding memory factors, but the trend is the
same.
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15.8. Additional Variables, Wall Distance Variables, and Boundary Dis-
tance Variables

A single scalar equation is added for each Additional Variable. A single scalar equation is also added
whenever the Wall Distance variables or Boundary Distance variables are referenced in a CFX Expression
Language (CEL) expression, or when these quantities are required for a built-in model (for example,
two equation-turbulence or boundary-distance-based mesh-stiffness models). Note that Wall Distance
values and Boundary Distance values are derived from the solutions of the Wall Scale equations and
Boundary Scale equations, respectively. Detailed information on the wall scale equation is available at
Wall and Boundary Distance Formulation in the CFX-Solver Theory Guide.

Expect a CPU cost increase of approximately 20% for each Additional Variable over the solution of the
U-Mom, V-Mom, W-Mom, and P-Mass equations for a single-phase single-component case. Increases in
memory requirements are small.

15.9. Combustion Modeling

Modeling combustion incurs a slight cost compared to multicomponent flow with the same number
of components. For multi-step reactions each component is solved using the coupled solve. This incurs
additional CPU time that does not increase linearly with the number of components.

15.10. Radiation Modeling

This adds a single scalar equation. Cost increases are similar to those of the energy equation. For details,
see Energy Models (p. 179).

15.11. GGI Interfaces

An intersection algorithm that is performed at the start of a simulation to connect each side of a GGI
connection incurs a one-time cost.

Each GGI connection means approximately 5% more CPU time and memory is required. This number
can vary greatly, as it is a function of the number of nodes involved in a GGI connection, compared to
the number of nodes that are not involved in the GGI connection. There is also a dependence on the
geometric complexity of the GGI connection.

15.12. Transient Runs

Each coefficient loop requires approximately the same CPU time as the equivalent steady-state iteration.

15.13. Mesh Deformation

Mesh deformation using either of the Regions of Motion Specified or Junction Box
Routine options introduces several CPU intensive operations during each outer iteration or time step.
When deformation is performed using Regions of Motion Specified, a Mesh Displacement
equation is assembled and solved at the start of each outer iteration or timestep for steady-state and
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transient simulations, respectively, and the mesh coordinates are updated. When deformation is per-
formed using a Junction Box Routine, you define how mesh coordinates are updated.

After updating the mesh coordinates, other mesh related quantities (such as volumes, areas, mesh
quality measures, mesh velocities, and so on) are updated, and GGIs are re-intersected before advancing
to solve other equations or physical models for the current outer iteration or time step. Mesh volume
flows that are later used to augment mass flow rates applied in advective transport are precalculated
and stored during these updates.

Depending on the complexity of the deformation and physical model (for example, the use of GGIs),
adding the mesh deformation to a simulation will increase CPU usage by approximately 10% to 50%
per outer iteration or time step.

Adding the mesh deformation will increase memory requirements due to the storage of: the noted
mesh volume flows (one per control volume integration point), and multiple sets of mesh coordinates
for transient simulations (one triplet per mesh vertex per time step that must be kept for the selected
transient discretization).

15.14. Bidirectional (Two-Way) Couplings with System Coupling

System Coupling introduces a coupling (or stagger) iteration layer in addition to the time step and
coefficient loop iteration structure used for simulations involving CFX only. As outlined in Bidirectional
(Two-Way) FSI, time steps are executed using a sequence of coupling iterations, which involve one or
more coefficient loop iterations within either the CFX solver or Ansys Mechanical solver.

Additional memory is not required when external solver couplings are used. However, additional CPU
time is required because of the CFX solver coefficient loops performed per coupling iteration. In general,
the CFX solver CPU usage will increase by a factor that is slightly smaller than the number of coupling
iterations required per time step. A summary of expected CPU time increases is tabulated below, accord-
ing to the degree of coupling between the fluid and solid physical problems.

CPU IncreaseDegree of Coupling

2× to 5×Weak

5× to 10×Typical

> 10×Strong
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Chapter 16: The cfx5control Application
The cfx5control application can be used to dynamically control the CFX-Solver. The features available
include:

• Stopping the solver running in the given directory at the end of the current timestep:

<CFXROOT>/bin/cfx5control <directory> -stop

• Instructing the solver running in the named directory to write a backup results file.

<CFXROOT>/bin/cfx5control <directory> -backup

• Editing the Command Language during a run:

<CFXROOT>/bin/cfx5control <directory> -edit-commands [-no-backup]

• Reading Command Language from a file and implementing it on the fly.

<CFXROOT>/bin/cfx5control <directory> -inject-commands <file> [-no-backup]

• Adjusting the priority of a CFX-Solver run by resetting the run priority on Windows or altering the
nice increment on non-Windows platforms. This applies to all solver processes in a parallel run.

<CFXROOT>/bin/cfx5control <directory> -reset-priority <level>

where <level> is one of Idle, Low, Standard or High, as given in the following table:

Windows PriorityUNIX nice inc.CFX Run Priority Level

Low190Idle

BelowNormal71Low

Normal02Standard

AboveNormal03High

If the current priority level is the same as <level>, then there is no change. Administrative (or root)
privileges are usually required to increase the priority from a lower level to a higher level. When the
change of priority is attempted, then the CFX-Solver will write a diagnostic message into the CFX-
Solver Output file of the form:

+--------------------------------------------------------------------+
|            ****** Updating Runtime Priority ******                 |
|                                                                    |
|      <outcome of the attempt to change the run priority>           |
|                                                                    |
+--------------------------------------------------------------------+

• Displaying help for this command:
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<CFXROOT>/bin/cfx5control -help

In these examples:

• <CFXROOT> is the path to your installation of CFX

• <directory> specifies a directory in which the Ansys CFX solver is currently running, such as
StaticMixer_004.dir.

• -no-backup prevents the solver from writing a backup file before reading the new Command
Language file.
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Chapter 17: File Export Utility
The Ansys CFX results file generated by a CFX-Solver run contains the details of the mesh used to perform
the calculation as well as details of the results variables that have been calculated. For details on which
variables an Ansys CFX results file contains, see List of Field Variables.

To postprocess an Ansys CFX results file using software other than CFD-Post, the mesh and variables
can be extracted from the Ansys CFX results file into a format compliant with that third-party software.
Ansys CFX provides predefined translations to a number of different postprocessors and analysis packages,
and CFX-Solver Manager provides an interface to enable easy translation to these formats. A command
line utility, cfx5export, can be used to perform the same operations in batch mode.

The standard file formats that can be generated from Ansys CFX are suitable for direct input into the
following software systems:

• All systems that support CGNS files

• MSC.Patran, from the MacNeal-Schwendler Corporation

• FIELDVIEW, from Intelligent Light

• EnSight, from Computational Engineering International, Inc.

It is also possible to write to other formats by creating a customized export program. See Creating a
Customized Export Program.

When using CFX-Solver Manager, it is possible to export the results of a CFX-Solver run by selecting
Tools > Export (see Export of Results to Various Formats (p. 186)).

Alternatively, it is possible to export the results directly from the command line. For details, see Running
cfx5export from the Command Line (p. 201).

Note:

There is no support for the export of cases that use Transient Blade Row modeling.

This chapter describes:

17.1. Export of Results to Various Formats

17.2. Generic Export Options

17.3. Running cfx5export from the Command Line

17.4. Exporting a Transient Results File

17.5. Exporting Particle Tracking Data

17.6. Using a Customized Export Program

185
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



17.1. Export of Results to Various Formats

To export CFX-Solver result to formats such as CGNS, EnSight, FIELDVIEW, MSC.Patran, or another cus-
tomized format, select Tools > Export Results from the menu bar of CFX-Solver Manager. The following
section details the common options that can be used when exporting results to the standard formats
supported by Ansys CFX.

17.2. Generic Export Options

To configure data for export, the Export dialog box must be displayed: select Tools > Export Results.

There are numerous export options when writing to the supported 3rd-party formats:

• Results File (p. 186)

• Domain Selection: Name (p. 186)

• Timestep Selection: Timestep (p. 186)

• Output Format (p. 186)

• Export File (p. 200)

• Output Only Boundary Geometry and Results (p. 200)

• Mesh Options: Use Initial Mesh for Rotating Domains (p. 200)

• Results Options: Output Level (p. 200)

• Results Options: Include Variables Only Found on Boundaries (p. 201)

• Results Options: Use Corrected Boundary Node Data (p. 201)

17.2.1. Results File

The name of the CFX-Solver results file to be exported.

17.2.2. Domain Selection: Name

The domain or domains in the CFX-Solver results file that are to be exported.

17.2.3. Timestep Selection: Timestep

For transient CFX-Solver results files, the timestep to be exported.

17.2.4. Output Format

Default Value: CGNS

The output format selects which standard file format is used to write the output file. If a nonstandard
format is required, select Custom User Export.
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The sections that follow describe the available output formats.

Note:

For simulations with multiple configurations, *.mres files cannot be exported by the CFX-
Solver Manager.

17.2.4.1. CGNS

The CFD General Notation System (CGNS) is designed to facilitate the exchange of data between
sites and applications, and to help stabilize the archiving of data. The data is stored in a compact,
binary format.

CGNS consists of a collection of conventions for the storage and retrieval of CFD data. The system
consists of two parts:

• A standard format in which the data is recorded.

• Software that reads, writes, and modifies data in that format.

Note:

To configure this option, select Tools > Export. The dialog box uses numerous common
export options. For details, see Generic Export Options (p. 186).

This section contains:

• CGNS Options (p. 187)

• Exported Files (p. 188)

• Contents of CGNS Files Written by Ansys CFX (p. 188)

• Reading Exported Files into a Program Supporting CGNS (p. 190)

17.2.4.1.1. CGNS Options

The following options are available when writing a file in CGNS format:

• All options specified in Generic Export Options (p. 186)

• Geometry Output Only

– Default Value: Cleared.

– If selected, only mesh information and boundary condition information is written to the
destination file; result variables are not written.

• Version and File Format

– 2.4
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The ADF file format will be used in this case.

– 3.0

You can select either the ADF or HDF5 format.

• When Write Transient Data to One File is selected, all transient data (grid and results) are
written to one CGNS file using BaseIterativeData_t and ZoneIterativeData_t
nodes within the file. When this option is not selected, transient results are exported to a
separate file for each timestep.

• Output boundaries as

– Default Value: Nodes

– If Nodes are selected, all boundary conditions are written as collections of nodes; if Faces,
then boundary conditions are written as groups of 2D elements (faces).

• When Use CGNS Variable Names is selected Ansys CFX variable names are mapped to CGNS
variable names. For example Total Pressure becomes PressureStagnation.

• When Write Full CFX Solver Name as Description is selected, CFX-Solver will write a description
of the full CFX Solver Variable Name. This description is an extra data field that is used by CFD-
Post when it exists. This avoids the internal variable names being used when the full CFX
Solver name exceeds 32 characters.

Whenever the name of the variable exceeds 32 characters, the internal name for the variable,
which is shorter but more cryptic, is written instead. When Write Full CFX Solver Name as
Description is selected, CGNS files written by CFX-Solver Manager use a new additional data
tag that is not subject to the 32-character limit, and that holds the Ansys CFX Solver Name for
each variable. CFD-Post reads the new tag in preference to the old tag, if the new tag exists.

17.2.4.1.2. Exported Files

The exported file set consists of either a single file for non-transient results, or multiple files for
transient results. Each contains a complete mesh and flow solution. By default all files are generated
with a .cgns extension. Import into a program that reads CGNS files should be done according
to the importing program’s instructions.

Ansys CFX-Export is capable of writing version 2.4 CGNS files in ADF format or version 3.3 CGNS
files in either ADF or HDF5 format. These CGNS files can be read by third party software that
supports:

• The features that CFX writes,

• CGNS Version 2.0 for version 2.4 CGNS files, or CGNS Version 3.0 for version 3.3 CGNS files,

• ADF for version 2.4 CGNS files, or HDF5 1.10 for version 3.3 CGNS files.

17.2.4.1.3. Contents of CGNS Files Written by Ansys CFX

The file produced contains grid and solution data. It does not contain problem setup (physics)
information.
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The amount of solution data and the type of grid written to the CGNS file is user controllable
either on the command line or via the user interface. What is seen in the CGNS file reflects what
you request. There are files that when written using some options may not be able to be reread
into CFX-Pre. Caution must therefore be used if the original CFX solution files are deleted, as it
may not be possible to recover all information.

Names of variables, zones, and boundary conditions are always CGNS-compliant. The name seen
within the CFX application may have to be changed to achieve this. To ensure that the variable
names are consistent between CFX and CGNS files, an additional data tag is written for all solution
variables, starting in CFX Release 14.0. This tag, named Ansys CFX Solver Name, is exempt
from a 32-character limit on variable names, so that the variable names displayed in CFD-Post
match those in the results file.

The remainder of this sections describes the data records that are written when creating a CGNS
file from Ansys CFX.

17.2.4.1.3.1. Base (Base_t)

A single base is written to each CGNS file.

• Its name is not significant.

• It is always written with a cell_dimension of 3 (that is, 3D).

If a transient file is being written, a simulation type (SimulationType_t) of TimeAccurate
is specified below the base node.

A state (ReferenceState_t) is also written below the base node with a description of where
the file was generated from and what it represents.

17.2.4.1.3.2. Zones (Zone_t)

A single zone is written under each Base_t node for each domain you requested and is always
unstructured in nature.

Coordinates of node data are always written in double precision. Due to the nature of the grid
being unstructured, there is no implicit ordering in how the grid is written.

17.2.4.1.3.3. Elements (Elements_t)

Element sections are written on a one per domain/subdomain basis as well as a one per
boundary condition basis. Due to the nature of CFX data, a single element cannot appear in
more than one element section. Element numbering is unique and consecutive.

You can control whether volume mesh (with surface mesh) or a surface mesh is written to the
file.

17.2.4.1.3.4. Boundary Conditions (BC_t)

Boundary Conditions are written. The location of each boundary condition is specified as set
of 2D elements (faces) or a set of nodes. The former is generally preferred as the latter can
have some restrictions for the program that reads the file.

No properties of the boundary condition are written other than its type.
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17.2.4.1.3.5. Solution Data (FlowSolution_t)

Solution data is written where requested. Names are mapped to be CGNS compliant. No discrete
data is currently written. Where Wall Only data is present, "missing" solution data is written
as 0.0.

17.2.4.1.3.6. Transient Data

Transient data is written to separate CGNS files by writing the Grid and Solution data for each
CFX transient file that is available to the cfx5export process.

17.2.4.1.3.7. Ansys CFX Connectivity using CGNS for Aerodynamic Noise Analysis

Further information on exporting files is contained in Aerodynamic Noise Analysis in the CFX-
Solver Modeling Guide.

17.2.4.1.4. Reading Exported Files into a Program Supporting CGNS

There is a wide range of products that can import CGNS files. Consult user documentation for
the product being used for further information.

Note:

An issue was detected while reading a CGNS file in TecPlot 10 and earlier that prevented
the files written by Ansys CFX being read by TecPlot. If a problem is encountered, try
setting the environment variable CFX5_EXPORT_CGNS_TECPLOT to a value of 1, restart
Ansys CFX, and export the CGNS file again. If the problem persists, contact either Ansys
support or TecPlot support.

17.2.4.2. MSC.Patran

MSC.Patran is a general-purpose CAE simulation tool.

Note:

To configure this option, select Tools > Export. The dialog box uses numerous common
export options. For details, see Generic Export Options (p. 186).

This section contains:

• Available Options (p. 191)

• Exported Files (p. 191)

• Reading Exported Files into MSC.Patran (p. 191)

• Exporting Boundary Conditions to MSC.Patran (p. 192)

• Example Procedure (p. 192)
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17.2.4.2.1. Available Options

The following options are available when writing a file in MSC.Patran format:

• All options specified in Generic Export Options (p. 186)

• Geometry Output Only (Neutral File)

– Default Value: Cleared.

If selected, the mesh from the Ansys CFX results file is written to a Neutral file; solution
variables are not written to the Neutral file. For more details about MSC.Patran Neutral files,
refer to your documentation from MSC.Patran.

17.2.4.2.2. Exported Files

The file set for this export option consists of three files:

File TypeFile Name

PATRAN Neutral File<basename>.out

PATRAN 2.5 Nodal Results File<basename>.nod

PATRAN Results Template File<basename>.results_tmpl

Ansys CFX writes files in ASCII format using a subset of the record types to be found in the full
definition of the PATRAN file formats. The full definition of the PATRAN file formats can be found
in the MSC.Patran documentation.

Faces associated with the CFX boundaries and elements associated with subdomains are transferred
into PATRAN named components. The boundary/subdomain components are named using their
CFX name.

Exported nodes are associated only with the PATRAN default_group, unless -nodes is used when
cfx5export is used from the command line.

17.2.4.2.3. Reading Exported Files into MSC.Patran

You should use the following procedure to import results into MSC.Patran Version 2001r2. However,
this may need to be adapted depending on what MSC.Patran is used for. For more details about
reading MSC.Patran Neutral files, see the MSC.Patran documentation.

Note:

An MSC.Patran warning may appear when importing the Neutral file that reads No
element type could be found for element property set <P_SET.1>. You do not need to
take any action.

1. Prepare the required PATRAN files.

Run cfx5export on the CFX-Solver Results file, either using CFX-Solver Manager or directly
from the command line.
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2. Start PATRAN and create a new database.

Use File > New to create a new database. Click Enable NFS access (on UNIX systems only).
Enter a new database name and click OK.

In New Model Preferences, choose the appropriate Analysis Code option for the analysis.

3. Import the mesh and results.

Use File > Import to access Import. Set Object/Source to Model/Neutral. Enter the
name of the neutral file produced by Ansys CFX and click Apply. Acknowledge the first
message and answer Yes to the second to continue.

Use Import again with Object/Source set to Results/PATRAN2.nod, to read the nodal
results file produced by cfx5export. Template for PATRAN 2.5 Import Results appears.
Type the name of the template file produced by cfx5export and click OK. Enter the nodal
results filename in Import and click Apply.

4. Continue to use MSC.Patran as required.

17.2.4.2.4. Exporting Boundary Conditions to MSC.Patran

CFX can be used to provide data to be used as boundary conditions for other types of analysis
in MSC.Patran.

MSC.Patran enables models to be prepared for several different kinds of analysis. It also has facil-
ities for using imported data to define data fields suitable for interpolating loads and boundary
conditions onto the geometry or the mesh of a new model.

A description of the relevant PATRAN facilities, in particular the Fields function and its applications,
can be found in the MSC.Patran documentation.

17.2.4.2.5. Example Procedure

Here is an outline of some guidelines for one possible procedure for incorporating CFX results
into a PATRAN model. CFX temperature predictions will be used to define a temperature distribu-
tion on a geometry surface of a new model. Details about any of the options can be found in
the MSC.Patran documentation.

Points to note in this example are:

• Files generated by Ansys CFX should be read into a new database first before any PATRAN
model grid. This ensures that the node numbers of the Neutral file correspond to the nodal
result file. The nodes and elements in the new model mesh will be numbered or renumbered
to follow on from those in the CFX data.

• The CFX model should not be included in the new model analysis, but the CFX data must not
be deleted until the boundary values have been interpolated onto the new grid.

The example assumes exported results include the Temperature variable.

1. Prepare PATRAN Neutral and Nodal results files containing boundary data only.
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Export the Ansys CFX results file to MSC.Patran format, either using CFX-Solver Manager or
directly from the command line. Toggle Boundary Data Output Only on if using CFX-Solver
Manager, or use the -boundary option if using cfx5export from the command line.

2. Start PATRAN and create a new database.

Use File > New to create a new database. Click Enable NFS access (on UNIX systems only).
Enter a new database name and click OK.

On New Model Preferences, choose the appropriate Analysis Code option, for example,
PATRAN 2 NF.

3. Import the mesh and results.

Use File > Import. Set Object/Source to Model/Neutral. Enter the name of the Neutral
file produced by Ansys CFX and click Apply. Acknowledge the message to continue.

Use Import again with Object/Format set to Results/PATRAN2.nod, to read the nodal
results file produced by Ansys CFX. Template for PATRAN 2.5 Import Results appears.
Enter the name of the template file produced by Ansys CFX, and click OK. Enter the nodal
results filename and click Apply.

4. Display temperature results as a fringe plot.

Select Group/Post to post just the group containing the boundary condition nodes to use.
Select Results. On Results, select the temperature results, and click Apply.

5. Create a continuous FEM field from the displayed variable.

Select the Fields option. Set Action/Object/Method to Create/Spatial/FEM. Enter a
new name under Field Name. Click the Continuous option. Select the relevant group under
Mesh/Results Group Filter. Click Apply.

6. Add the geometry for the new model.

Post the default_group and make it current using Group/Post. Use the toolbar icons to ensure
the display will be in wireframe mode rather than in hidden line mode. Then either create
a geometry for the new PATRAN model using the Geometry option to open the Geometry
form or import the geometry from a previously prepared database using File > Import with
Object/Source set to Model/ MSC/PATRAN DB.

7. Define a temperature boundary condition on new geometry surfaces.

Select the Load/BCs option. Set Action/Object/Type to Create/Temperature/Nodal.
Enter a name under New Set Name. Click Input Data. Select the field in the Spatial Fields
box and click OK. Under Load/Boundary Conditions, click Select Application Region to
display Select Application Region. Click the Geometry option under Geometry Filter. In
Select Geometric Entities, pick the surfaces to apply the boundary condition to. Click Add
and then OK. In Load/Boundary Conditions, click Apply. A temperature distribution should
now be visible on the relevant geometry surfaces, in the form of values shown at the inter-
sections of the surface display lines.

8. Complete the PATRAN model.
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17.2.4.3. FIELDVIEW

FIELDVIEW is a stand-alone CFD postprocessor supplied by Intelligent Light.

Note:

To configure this option, select Tools > Export. The dialog box uses numerous common
export options. For details, see Generic Export Options (p. 186).

This section contains:

• Available Options (p. 194)

• Exported Files (p. 195)

• Reading Exported Files in FIELDVIEW (p. 195)

17.2.4.3.1. Available Options

The following options are available when writing a file for use in FIELDVIEW Unstructured format:

• All Options specified in Generic Export Options (p. 186).

• FV-UNS File Options: The options in this section detail the formatting of the separate grid
and results files or combined grid and results files that are written in FV-UNS (FIELDVIEW Un-
structured) file format.

• Version:

– Default Value: 3.0

– The value selected details which version of the format should be used when writing the grid
and results to files for use within FIELDVIEW. You should use the most recent version of the
file format supported by your FIELDVIEW installation. Refer to the FIELDVIEW documentation
for this information.

• Split Grid and Results Format:

– Default Value: Selected

– When selected, the grid from the Ansys CFX results file is written to one file and the results
to a second or subsequent files. If not selected, a single combined file is written containing
both the grid and the results.

Note:

→ This option is not available when the version is less than 2.7.

→ If the number of variables that are to be written to the file exceeds 200,
the results will be written to more than one results file. Refer to FIELDVIEW
9 and later to learn how to load multiple files into FIELDVIEW.
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• Format:

– Default Value: Unstructured Binary

– This option enables a choice of whether the FV-UNS are written as in binary or ASCII format.
The ASCII format is human-readable but larger than the binary format. It is therefore recom-
mended by Ansys and FIELDVIEW that binary format files be written in most cases.

• FV-REG Version:

– Default Value: 2.0

– The version specified here details the version of the format used when writing the region
file for use in FIELDVIEW. You should specify the highest version that is supported by the
version of FIELDVIEW you have installed.

17.2.4.3.2. Exported Files

The file set for this export option consists of several files, depending on the format options selec-
ted.

If the output format is selected to be Split Grid and Results Format, more than one file will be
generated with the grid in one file and results in at least one other. Optionally, a region file will
also be generated:

File TypeFile Name

FIELDVIEW Grid File<basename>_grid.fv

FIELDVIEW Results File<basename>_results.fv

FIELDVIEW Region File<basename>_region.fv

If Split Grid and Results Format (see Available Options (p. 194)) is not selected, then at least one
combined grid and results file will be generated:

File TypeFile Name

FIELDVIEW Combined Grid and
Results File

<basename>.fv

FIELDVIEW Region File<basename>_grid.fv.fvreg

Optionally, if particle tracks have been written in the Ansys CFX results file, then these will be
written to one or more FIELDVIEW particle track files:

File TypeFile Name

FIELDVIEW Particle Track File<basename>_n.fv

Ansys CFX writes a subset of record types that are available in the full FIELDVIEW file formats.
The documentation supplied with FIELDVIEW describes all the record types that can be read by
different versions of FIELDVIEW.

17.2.4.3.3. Reading Exported Files in FIELDVIEW

Files can be read into EnSight 5, 6, 7, and 8 as required:
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• FIELDVIEW Versions 10.1 and Later (p. 196)

• FIELDVIEW Versions 9 and 10 (p. 196)

• FIELDVIEW Versions 6, 7, 8 (p. 197)

17.2.4.3.3.1. FIELDVIEW Versions 10.1 and Later

If the exported file is split into more than one file, it is necessary to follow a procedure similar
to the following to read each file in FIELDVIEW:

1. Select File > Data Input > ANSYS-CFX[FV-UNS Export]….

2. On the Ansys-CFX[FV-UNS Export] form, ensure that the INPUT MODE is Replace.

3. If the file written is in Split Grid and Results format:

a. Click Read Grid or Combined Data.

b. Select the grid file from the file popup and click OK.

c. Click Read Results Data.

d. Select the first results file and click OK.

e. If further grid or results files are to be loaded, change the INPUT MODE to Append
on the Ansys-CFX[FV-UNS Export] form and repeat from step "a" until all grid or
results files have been loaded.

4. If the file is a combined file:

a. Click Read Grid or Combined Data.

b. Select the combined file from the file popup and click OK.

17.2.4.3.3.2. FIELDVIEW Versions 9 and 10

If the exported file is split into more than one file, it is necessary to follow a procedure similar
to the following to read each file in FIELDVIEW:

1. Select File > Data Input > Unstructured.

2. On the FV Unstructured form ensure that the INPUT MODE is Replace.

3. If the file written is in Split Grid and Results format:

a. Click Read Grid or Combined Data.

b. Select the grid file from the file popup and click OK.

c. Click Read Results Data.

d. Select the first results file and click OK.
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e. If further grid or results files are to be loaded, change the INPUT MODE to Append
on the FV Unstructured form and repeat from step "a" until all grid or results files
have been loaded.

4. If the file is a combined file:

a. Click Read Grid or Combined Data.

b. Select the combined file from the file popup and click OK.

17.2.4.3.3.3. FIELDVIEW Versions 6, 7, 8

The following procedure enables importing results into FIELDVIEW Version 6, 7 and 8.

Note:

FIELDVIEW reads the version number from within the input file; however, some file
formats that can be generated by Ansys CFX cannot be read by all version of
FIELDVIEW. Refer to FIELDVIEW documentation for exact details of which file formats
can be processed by FIELDVIEW.

1. Select Data Files > Unstructured Data Input from the menu bar. In File Selection, select
the file created using cfx5export and then click OK. In Function Subset Selection, select
All and click OK. Click Exit in Unstructured Data Input.

2. The results can now be analyzed as required.

Note:

The Region file written by Ansys CFX to these versions of FIELDVIEW may have to
be modified to ensure correct axes of rotation and rotational velocities in FIELDVIEW.

If the Ansys CFX file contains multiple rotation axes, it is not possible to write a
single FIELDVIEW file that can be correctly used in FIELDVIEW. In this case, you must
write the file in "Split Grid and Results Format". For more details about reading
FIELDVIEW Unstructured files, see the FIELDVIEW documentation.

17.2.4.4. EnSight

EnSight is a suite of tools for engineering and scientific simulation.

Note:

To configure this option, select Tools > Export. The dialog box uses numerous common
export options. For details, see Generic Export Options (p. 186).

This section contains:

• Available Options (p. 198)
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• Export Files (p. 198)

• Reading Exported Files into EnSight (p. 199)

17.2.4.4.1. Available Options

The following options are available when writing files for use in EnSight:

• All options specified in Generic Export Options (p. 186)

• EnSight Version:

– Default Value: Gold

– The selection specifies the EnSight file format version to which the output will adhere. It is
recommended that Gold be selected wherever possible. Refer to the EnSight documentation
for differences between the different formats.

• Format:

– Default Value: Unstructured Binary

– This option enables you to choose whether the EnSight data files are written as in binary or
ASCII format. The ASCII format is human-readable but larger than the binary format. It is
therefore recommended by Ansys that binary format files are written in most cases.

17.2.4.4.2. Export Files

The file set for this export option consists of the following files:

File TypeFile Name

EnSight Geometry File<basename>.geom

EnSight Results File (version 5 only)<basename>.results

EnSight Variable Files for scalar variable<basename>.s01 (and so on)

EnSight Variable Files for vector variables<basename>.v01 (and so on)

EnSight case files (EnSight 6 and later).<basename>.case

Note:

• Each subdomain and boundary condition is exported as one EnSight part.

• CFX variable aliases have to be modified (by removing spaces and special characters
and by limiting the name length) to create valid EnSight variable names. In some
cases the names that result may not be human recognizable; in all cases the mapping
from the name used in Ansys CFX to that written to the EnSight file is displayed in
the progress window of the Solver Manager.

Ansys CFX uses a subset of record types that are available in the full EnSight file formats. The
documentation supplied with EnSight describes all the record types that can be used.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.198

File Export Utility



17.2.4.4.3. Reading Exported Files into EnSight

Files can be read into EnSight 5, 6, 7, and 8 as required.

• EnSight 8.2 and Later (p. 199)

• EnSight 6, 7, and 8.0 (p. 199)

• EnSight 5 (p. 199)

17.2.4.4.3.1. EnSight 8.2 and Later

The following procedure enables importing results into EnSight 8.2 and later. For more details
about importing, see the EnSight documentation.

1. Select File > Open.

2. Select the Format as Case.

3. Choose the case file that has been exported. All files produced by CFX-Solver Manager are
automatically loaded.

17.2.4.4.3.2. EnSight 6, 7, and 8.0

The following procedure enables importing results into EnSight 6, 7, or 8.0. Results files may
need modification, depending on how they are to be used with EnSight. For more details about
importing, see the EnSight documentation.

1. Select File > Data Reader.

2. Select the Format as Case.

3. Choose the case file that has been exported. All files produced by CFX-Solver Manager are
automatically loaded.

17.2.4.4.3.3. EnSight 5

The following procedure enables importing results into EnSight 5. Results files may need
modification, depending on how they are to be used with EnSight. For more details about im-
porting, see the EnSight documentation.

1. Select File > Data (Reader). In File Selection, click the name of the geometry file created
using cfx5export, and then click (Set) Geometry.

2. Click the name of the EnSight results file. Click (Set) Result and then click Okay.

3. In Data Part Loader, click Load All, and then click Close.

4. The results can now be analyzed as required.

17.2.4.5. Custom User Export

Files can be exported to a custom format from CFX-Solver Manager. To do so, a custom export
program must be created. For information on all the ways of using a custom export program, see
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Using a Customized Export Program (p. 207). For details on creating a custom export program, see
Creating a Customized Export Program.

17.2.5. Export File

This option specifies the destination file to which the grid and results will be written. This filename
may be altered in such a way that multiple files may be written with transient data or if the Output
Format requires multiple files to be written.

17.2.6. Output Only Boundary Geometry and Results

Availability: All Standard Formats (CGNS, MSC.Patran, FIELDVIEW and EnSight). Available only when
Geometry Output Only is not selected.

Default Value: Not selected.

If selected, only the data for nodes on the boundaries is output. This can be used, for example, to
enable results from CFD calculations to provide boundary conditions for other analysis in other
packages.

17.2.7. Mesh Options: Use Initial Mesh for Rotating Domains

Availability: All Standard Formats (CGNS, MSC.Patran, FIELDVIEW and EnSight)

Default Value: Not selected.

By default, the mesh for any rotating domain is rotated into the correct position for the timestep
when exporting, as long as the angular velocity is specified as a single value (that is, not using the
CFX Expression Language). You can choose to always write the mesh as it was positioned at the initial
timestep by selecting the option Use Initial Mesh for Rotating Domains.

If the angular velocity of the rotating domain is specified in terms of an expression, then the mesh
is always exported in its initial position and never rotated, and the Use Initial Mesh for Rotating
Domains option is ignored.

The calculation of the correct rotated position assumes that the initial run was started from a time
value of 0 [s], and that the simulation time is continuous from 0 [s] through every run and restart
(that is, the Initial Time is not reset by using the Value option). If this is not the case, then you should
select Use Initial Mesh for Rotating Domains option to write the mesh as it was positioned at the
initial timestep, to avoid incorrectly rotated meshes.

17.2.8. Results Options: Output Level

Availability: All Standard Formats (CGNS, MSC.Patran, FIELDVIEW and EnSight)

Default Value: 1.

The output level selects a predefined subset of variables to write to the destination results file. Each
variable is given a "user level" by CFX-Solver. For details, see List of Field Variables.

An output level of:
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• 1 writes a small subset of basic variables such as velocity and pressure, which have user level 1.

• 2 writes all variables that are of user levels 1 and 2.

• 3 writes all variables stored in the CFX results file.

17.2.9. Results Options: Include Variables Only Found on Boundaries

Availability: All Standard Formats (CGNS, MSC.Patran, FIELDVIEW and EnSight)

Default Value: Not selected.

If selected, the variables that exist only on boundaries (such as ) are written in addition to those
variables that have values in the interior of the domain(s).

17.2.10. Results Options: Use Corrected Boundary Node Data

Availability: All Standard Formats (CGNS, MSC.Patran, FIELDVIEW and EnSight)

Default Value: Selected

The values of some variables on the boundary nodes (that is, on the edges of the geometry) are not
precisely equal to the specified boundary conditions when CFX-Solver finishes calculations.

For instance, the value of velocity on a node on the wall will not be precisely zero, and the value of
temperature on an inlet may not be precisely the specified inlet temperature. For visualization purposes,
it can be more helpful if the nodes at the boundary contain the specified boundary conditions and
so Use Corrected Data on Boundary Nodes should be selected for these cases.

Corrected boundary node values are obtained by taking the results produced by CFX-Solver (called
"conservative values") and overwriting the results on the boundary nodes with the values specified
by the boundary conditions set up in CFX-Pre. This ensures, for example, that velocity is displayed as
zero on no-slip walls and is equal to the specified inlet velocity on an inlet. Using corrected boundary
node values is equivalent to selecting conservative variables as described in Hybrid and Conservative
Variable Values in the CFX Reference Guide.

17.3. Running cfx5export from the Command Line

In the following code, [ ] denotes an optional argument, and <> and # denote that substitution of
a suitable value is required. All other arguments are keywords, some of which may have a short form.

Note:

-cgns, -ensight, -fieldview, -patran, or -custom should be the first option on
the command line.

• -cgns creates files suitable for an application that supports the CGNS format.

• -ensight creates files suitable for input into the EnSight postprocessor.

• -patran creates files suitable for input into the MSC/PATRAN postprocessor.
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• -fieldview creates files suitable for input into the FIELDVIEW postprocessor.

• -custom should be used if there is a need for custom-defined export formats. For details, see Running
a Customized Export Program using cfx5export from the Command Line (p. 208).

For all standard options (-cgns, -patran, -fieldview, and -ensight), the source Ansys CFX file
<file> is the same file as would be specified under Tools > Export > Results File in CFX-Solver
Manager. The optional file entered as -name <file> is the filename used as the basename for the
files generated as part of the export process (this is equivalent to what is specified under Tools > Export
> Export File).

Note:

There is no support for the export of cases that use Transient Blade Row modeling.

17.3.1. Running cfx5export

To run cfx5export from the command line, type one of the following commands into a UNIX terminal
or a suitable Windows command line and press Return or Enter. For details, see Command Line in
the CFX Reference Guide.

 cfx5export -ansysfsi [-domain <number>] [-help] [-name <file>] \
  [-offset-flow <number>] [-offset-val <number>] \
  [-scale-flow <number>] [-scale-val <number>] \
  [-summary] [-timestep <number>] [-verbose] \
  [-eltype <element type>] [-regions <region1><,region2>...] <file>

or

cfx5export -cgns [-boundary] [-corrected]  [-domain <number>] \
 [-cgns-version <2.4|3.0>] [-HDF5|-ADF] \
 [-geometry] [-help] [-include] [-name <file>] [-summary] \
 [-timestep <number>] [-user <level>] [-norotate] \
 [-boundaries-as-nodes|-boundaries-as-faces] \
 [-one-file-for-transient-cases] [-cgns-names] \
 [-no-cfx-variable-description]
 [-verbose] <file>

or

cfx5export -ensight [-5|-6|-7] [-absolute] [-ascii|-binary] \
 [-corrected] [-domain <number>] [-help] [-include] [-long] \
 [-name <file>] [-summary] [-timestep <number>] [-user <level>] \
 [-verbose] <file>

or

cfx5export -fieldview [-UNS[2.4|2.5|2.6|2.7|3.0]] [-REG[1.0|2.0]] \
 [-absolute] [-ascii] [-corrected] [-domain <number>] [-noparticles] \
 [-include] [-name <file>] [-summary] [-timestep <number>] \ 
 [-user <level>] [-norotate] [-verbose] <file>

or

cfx5export -patran [-absolute] [-boundary] [-corrected] [-domain <number>] \
 [-geometry] [-help] [-include] [-name <file>] [-nodes] [-summary] \
 [-timestep <number>] [-user <level>] [-norotate] [-verbose] <file>
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or

cfx5export [-exec <executable>] -custom [<options>]

Note:

Note that "-cgns-version 3.0" results in a CGNS file of version 3.3.

17.3.2. cfx5export Arguments

A basic description of the cfx5export arguments is given below.

UsageArgument

Alternative Forms

Write an EnSight Version 5 case file instead of an EnSight Version
7 results file.

-5

Write an EnSight version 6 file instead of an EnSight version 7
file.

-6

Write an EnSight version 7 file (default)-7

Write CGNS data as an ADF formatted file.-adf

Export data in the Ansys FSI CDB format.-ansysfsi

Write the output file in ASCII format, rather than unstructured
binary format.

-ascii

-s

Write the output file in unstructured binary format.-binary

Boundary data only. Using this argument corresponds to selecting
the option Boundary Data Output Only when using cfx5export
from CFX-Solver Manager.

-boundary

-b

Write boundary conditions as collections of faces rather than
nodes.

-boundaries-as-
faces

Write boundary conditions as collections of nodes rather than
faces (default).

-boundaries-as-
nodes

Export data in the CGNS format-cgns

Map CFX variable names to CGNS variable names (where
possible).

-cgns-names

Write a CGNS file of version 2.4 or 3.3, respectively. Note that an
argument "version number" of "3.0" results in a CGNS file of
version 3.3.

-cgns-version
<2.4|3.0>

Use corrected boundary node values. This corresponds to
enabling Use Corrected Boundary Node Data when using Tools
> Export from CFX-Solver Manager.

-corrected

-c

Use custom export program defined by the CFX_EXPORT_EXEC
variable. If this option is specified no further argument checking

-custom <options>

is done and all remaining options on the command line are
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UsageArgument

Alternative Forms

passed straight to the export program. For details, see Generic
Export Options (p. 186).

Specifies the domain of interest. If <number> is non-zero,
cfx5export will export just the given domain. If <number> is

-domain <number>

-d <number>
zero, the data is combined and exported as a single domain. The
default value is 0.

Specifies the Ansys element type to use for Ansys FSI CDB file
output.

-eltype

Export data for use with EnSight.-ensight

An alternative way of specifying the custom export executable
dynamically, without having to create a cfx5rc file. Note that this
parameter must appear before the -custom switch.

-exec <executable>

Export data for use with FIELDVIEW.-fieldview

-fv

Geometry data only (no results). Using this option corresponds
to choosing Geometry Output Only (Neutral File) when using
cfx5export from CFX-Solver Manager.

-geometry

-g

Print the information in this table.-help

-h

Write CGNS data as an HDF5 formatted file.-hdf5

Include boundary node only data. If you specify this option, then
variables such as  (which have meaningful values only on the
boundary nodes) will be exported.

-include

-i

Use long variable names.-long

-l

Don’t write a description of the full CFX Solver Variable Name.-no-cfx-variable-
description

Write all transient data to a single CGNS file using BaseIterat
ive_t and ZoneIterative_t nodes.

-one-file-for-tran
sient-cases

Set the basename for the output files to <base> instead of the
name of the input file. If you do not use this option, the exported

-name <base>

-output <base>
files will be written in the same directory as the input file. You

-out <base> need to take care when selecting this name to avoid your CFX
results file being overwritten.

Use nodes when exporting packet 21 data (groups).-nodes

-n

Do not write particle track files.-noparticles

Do not rotate the grid to its true position. For details, see Mesh
Options: Use Initial Mesh for Rotating Domains (p. 200).

-norotate

Offset flows written to Ansys FSI CDB files by <number>.-offset-flow <num
ber>
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UsageArgument

Alternative Forms

-Of <number>

Offset values written to Ansys FSI CDB files by <number>.-offset-val <num
ber>

-Ov <number>

Export data for use with MSC/PATRAN.-patran

Export data for comma-separated list of regions written to Ansys
FSI CDB file.

-regions <re
gion1><,region2>...

Specifies the version used when writing the FIELDVIEW region
file.

-REG <version>

Scale flows written to Ansys FSI CDB files by <number>.-scale-flow <num
ber>

-Sf <number>

Scale values written to Ansys FSI CDB files by <number>.-scale-val <number>

-Sv <number>

Use the FIELDVIEW Split Grid and Results file format when writing
grid and results files.

-split-grid-and-
results

Displays a summary of the domains and timesteps contained in
the CFX-Solver Results file.

-summary

-f

If the <number> is non-zero, data for the given timestep in a
transient run is exported. If <number> is -1, data from all

-timestep <number>

-time <number>
timesteps is exported. If the -timestep switch is not given,
data from the last timestep will be exported.-t <number>

Specifies the file format version when writing FIELDVIEW Grid
and Results files.

-UNS<version>

User level of interest: <level> should be a number 1, 2, or 3,
and this corresponds to selecting Output Level 1, 2, or 3 when
using cfx5export from CFX-Solver Manager.

-user <level>

-u <level>

Specifying this option may result in additional output being sent
to the standard output file (normally the screen).

-verbose

-v

Name of CFX results file from which data is to be exported. The
names of the file(s) created depends on the format being written.

<file>

CGNS files will be written to <file>.cgns

EnSight geometry will be written to <file>.geom, the results
file to <file>.res, and the variables to <file>.s## or
<file>.v## where ## is the variable number and s indicates
a scalar and v a vector unless the -name option is used.

Patran geometry will be written to <file>.out as a Neutral
file, the results template to <file>.res_tmpl, and the nodal
results to <basename>.nod unless the name option is used.
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UsageArgument

Alternative Forms

Fieldview geometry will be written to <file>.fv unless the
-name option is used.

Note: The files will be created in the same directory as the original
files, not necessarily in the current working directory.

17.4. Exporting a Transient Results File

If you have completed a transient run, you have several options for exporting the results. You can elect
to:

• Export the results file, which contains the solution to the final timestep.

• Export one or more of the preliminary timestep solutions.

• Export all of the timesteps.

You can use either CFX-Solver Manager or the cfx5export script to export a transient file.

• Generic Export Options (p. 186)

• Running cfx5export from the Command Line (p. 201)

17.4.1. File Format

If you elect to export the results file, which contains the solution to the final timestep, the format will
be:

filename.ext

where .ext is based on the format being written.

However, if you elect to export a different timestep, then the export file will have the following format:

filename_t#.ext

where # is the value of the timestep exported.

Note:

EnSight transient files will be sequentially numbered, regardless of the timestep value. For
example, if timesteps of 1 s, 5 s, and 7 s are exported, they will have the filenames file
name_t1.ext, filename_t2.ext and filename_t3.ext.
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17.5. Exporting Particle Tracking Data

Export of particle tracking data is currently supported only to FIELDVIEW. Export of particle tracking
data to any other format is not supported in the current release of Ansys CFX.

17.6. Using a Customized Export Program

There are multiple ways in which an export program can be used once it has been compiled.

• Using a Customized Export Program from CFX-Solver Manager (p. 207)

• Using a Customized Export Program from the Command Line (p. 207)

17.6.1. Using a Customized Export Program from CFX-Solver Manager

Open the Export dialog box by selecting Export from the Tools menu of CFX-Solver Manager.

1. Set Output Format to Custom User Export.

2. Supply the path to the compiled program in Export Executable.

3. Enter any associated options required to run the customized program (such as would be entered
at the command line) in Custom Export Setting.

4. The specified custom export program runs with the associated arguments when you click Export.

17.6.2. Using a Customized Export Program from the Command Line

You may run your program directly from the command line started from the Ansys CFX Launcher
(Tools > Command Line). Such a command line will have the environment variables and path set
appropriately.

Important:

It is important to run the command line in the CFX environment. For details, see Command
Line in the CFX Reference Guide.

17.6.2.1. Running a Customized Export Program Directly from the Command
Line

For the purposes of describing what you can do, assume that the executable file is called myexport
and is contained in the directory /home/smith/export/ (UNIX) or c:\smith\export (Win-
dows). You want to specify the results file called file.res in the same directory and make the
basename example.

17.6.2.1.1. UNIX

To run the program directly on a UNIX system, open a command line started from the Ansys CFX
Launcher (Tools > Command Line) and call your program using:
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./myexport file.res example

assuming that the current directory is /home/smith/export/.

17.6.2.1.2. Windows

On a Windows machine, run the program by opening a command line started from the Ansys
CFX Launcher (Tools > Command Line), changing directory to c:\smith\export, and typing:

myexport file.res example

Note:

Just double-clicking on the name of the program in the Windows Explorer, or using
the Execute myexport.exe option in Microsoft Developer Studio does not readily
give you the option to enter command-line arguments.

17.6.2.2. Running a Customized Export Program using cfx5export from the
Command Line

Your executable can be run directly from the command line by using the cfx5export command.
This enables you to issue an export command without specifying the location of the executable
each time; an environment variable remembers the location of the custom export executable.

For the purposes of describing the procedure, assume the executable file is called myexport and
is contained in the directory /home/smith/export/ (UNIX) or c:\smith\export (Windows).
Specify the results file called file.res in the same directory and make the basename example.

To run the program using the cfx5export -custom command, add the following line to the
.cfx5rc file:

CFX_EXPORT_EXEC="<executable_path>"

where <executable_path> is the full path and name of the executable (for example,
/home/smith/export/myexport or c:\smith\export\myexport as appropriate). For
details, see Resources Set in cfx5rc Files in the CFX Introduction.

The cfx5export command can be used with the custom argument for the given example. Type:

cfx5export -custom file.res example

into a UNIX terminal or a suitable Windows command prompt and press Return or Enter. For details,
see Command Line in the CFX Reference Guide.
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